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Clip	Library

User	Interface	Overview

figure	1:	User	Interface	overview

1		Video	Preview

2		Library	Panel

3		Info	Display:	it	provides	the	most	important	information	of	the	selected	clip	and	cannot	be	edited.	It	contains	two
different	view	parameters:	one	for	the	Digital	Image	Technician	and	another	one	with	relevant	information	for	the
Data	Wrangler.

4		Switch	between	View	modes	like	Summary,	Table,	Collection,	Playback.

Table	view	(figure	2	#1):	useful	for	sorting	and	grouping	clips	by	certain	criteria.	It	is	also	a	great	way	to	get
an	overview	of	the	various	metadata	of	a	set	of	clips.	Some	of	the	fields	are	editable	and	you	can	jump	from
field	to	field	by	pressing	the	TAB	key.	Here	you	can	also	load	and	save	custom	view	presets	which	are	the
foundation	of	your	clip	reports
Collection	view	(figure	2	#2):	it	gives	you	a	visual	overview	over	the	clips	in	your	library.

figure	2:	view	modes	in	Silverstack

5		Navigation	through	your	Projects,	Jobs,	Volumes.	Folders	and	Bins	with	bread	crumbs.	This	feature	is	specially
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useful	when	you	hide	your	library	view	and	clip	information	view.

6		Action	wizards	in	Toolbar	are	Offload,	Seal,	Media,	Export,	Import,	Report,	Transcode:

Offload:	Choose	a	source	to	offload	it	in	your	library
Seal:	seal	drives	for	subsequent	workflow	steps.
Media:	Backup	or	Relink	files	from	your	library
Export:	export	metadata	files	to	use	in	editorial	and	post	production.
Import:	import	metadata	and	match	it	to	the	clips	from	different	sources.
Report:	Create	or	print	various	report	types	in	the	Report	Center
Transcode:	create	derivates	from	your	clips	in	a	more	manageable	format.

7		Clip	information	for	supported	advanced	camera	formats.

8		Jobs	panel:	Job	or	Copy	Status,	like	successful	or	failed	copy	jobs,	duration	and	file	destination.	More
information	in	the	article	Managing	Jobs.

9		Toggle	View	Controls	to	hide	or	show	the	Library	panel,	the	Grading	Controls,	Audio	Controls	panel	and
the	Clip	Info	panel	to	have	more	work	space	for	example	on	small	laptop	screens.

10		Work	spaces	such	as	Manage,	QC,	Color	and	Config	to	speed	up	specific	tasks.

11		Grading	Controls.

12		Project	Library	selection	switcher.	It	displays	the	name	of	the	current	project.

13		Toggle	between	Clip	information,	User	Information,	File	Resources,	Clip	Header,	Look	Library	and	Transcoding
configurations.

14		Successful/Failed	jobs	count.

15	Switch	between	the	audio	and	the	grading	panel	in	the	lower	 “Audio&Color”	section.

Collection	View	–	Icon	explanations

figure	3:	Clip	icon

1		Indicates	the	number	of	connected	storage	devices	concerning	this	clip’s	storage	locations.	The	number
colored	in	red	shows	the	number	of	missing	sources.

2		The	clip	name	and	duration.	If	the	clip	has	been	labeled,	this	part	is	colored.

3		Indicates	that	this	clip	is	marked	with	a	flag	and	can	be	searched	and	filtered	for	this	criterion.

4		Description	of	the	ingest	date	and	time.

The	Clip	Library:	Bins,	Folders,	Smart	Folders	and	Volumes
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figure	1:	The	library	panel	part	1

figure	2:	The	Library	panel	part	2

The	basic	building	blocks	of	the	Silverstack	library	are	projects,	bins	and	folders.	Every	project	you	create	in
Silverstack	contains	by	default	different	kinds	of	“Smart	Folders”	and	a	“Volumes”	sub-item.	Based	on	that	you	can
add	an	unlimited	number	of	folders,	bins	and	smart	folders	by	right-clicking	on	any	item	of	the	project	tree.

Project

A	“Project”	groups	all	information	and	data	of	a	single	project.	In	Silverstack	all	clips,	jobs,	volumes	and
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destinations	are	assigned	to	one	project.	It	may	additionally	contain	information	like	the	producer,	name	of	the	DIT
or	a	production	logo,	which	you	can	edit	in	the	Statistics	overview	of	the	selected	project.

The	number	behind	every	element	of	your	project	tree	indicates	the	number	of	versions	it	contains,	whereby
duplicates	are	not	counted.	The	number	behind	your	“Project”	item	indicates	the	number	of	versions	contained	by
it,	with	only	counting	one	version	of	each	referred	clip.

Bin

A	bin	contains	clip	versions,	but	no	other	bins	or	folders.	It	is	the	smallest	container	unit	in	Silverstack.	Bins	are	the
only	element	to	contain	versions	directly,	folders	and	projects	only	group	a	set	of	bins.

There	are	two	different	types	of	Bins:

Video	Bins:			

Audio	Bins:			

Sorting	of	Bins	&	Folders

You	can	organize	the	library	by	dragging	and	dropping	bins	and	folders	in	a	custom	order	or	selecting	a	certain
criteria	to	sort	them	by:
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The	bin	sorting	options	in	detail:

Custom	Order:	Reflects	and	stores	the	custom	order	the	user	created	with	drag	&	drop.
Name	(A-Z):	Sorts	bins	and	folders	by	Name	from	top	to	bottom	from	0	to	Z.
Name	(Z-A):	Sorts	bins	and	folders	by	Name	from	top	to	bottom	from	Z	to	0.
Date	(oldest	–	newest):	Sorts	bins	and	folders	by	creation	date,	oldest	date	first,	newest	date	last.
Date	(newest	–	oldest):	Sorts	bins	and	folders	by	creation	date,	newest	date	first,	oldest	date	last.

Folders	stay	on	top.	Audio	bins	are	automatically	sorted	separately	at	the	bottom	of	video	bins.

Folder

Folders	are	used	to	create	logical	project	structures	like	shooting	days.	A	folder	can	contain	bins	and	other	folders
but	not	clips	directly	since	clips	always	have	to	be	enclosed	by	a	bin.

Folder	structure	can	easily	be	duplicated	by	choosing	“Duplicate	Folder	Structure”	from	the	context	menu:
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Fig.	3:	Duplicating	the	folder	structure	of	a	folder

Smart	Folder

Additionally	there	is	an	element	called	“Smart	Folders”	in	the	Silverstack	library,	which	describes	a	folder	with
integrated	filtering	function.	Using	smart	folders	you	can	find	clips	with	a	certain	attribute	in	the	dedicated	project
very	easily.	The	default	smart	folders	filter	the	library	for	clips	without	backups,	with	a	high	rating,	a	flagging	or	clips
that	are	registered	today.	For	a	closer	look	to	the	smart	folder	section	go	to	the	Working	with	smart	folders	article.

Volumes

By	selecting	“Volumes”,	Silverstack	outlines	all	used	storage	devices	and	their	according	information.	You	can	also
reveal	the	files	in	the	finder	by	clicking	the	reveal	button.	Additional	information	about	your	volumes	can	be	found
in	the	right	sided	panel.	There	you	have	the	possibility	to	make	comments,	eject	the	volume,	get	the	status	of	your
free	disk	space	print	a	volume	report	or	give	your	hard-drive	a	playback	priority.

figure	4:	The	Silverstack	“Volumes”	window

The	Information	Panel

The	Information	Panel	displays	all	the	information	(metadata)	embedded	in	your	clips.	It	consists	mostly	of	editable
and	some	read-only	fields	(not	editable).	You	can	edit	the	fields	marked	with	a	small	«pencil»	icon,	as	well	as	flags,
ratings,	labels	and	cue	points.

By	editing	and	adding	your	own	information	to	the	clips	you	can	simplify	managing	tasks	like	searching	clips,
varying	the	shown	clip	order	or	filter	the	library	for	clips	with	a	certain	attribute,	which	you	can	do	by	using	smart
folders.
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Fig.	1:	The	information	panel

The	Tabs

The	information	panel	is	subdivided	into	six	tabs:	General	Info,	User,	File,	Header,	Look	Library	and	Transcoding.

1	General	tab:	It	encloses	the	clip	information	extracted	from	the	metadata	like	the	timecode,	exposure,
production	info,	camera	and	format	information.	Additionally,	there	are	some	tips	for	a	faster	metadata	editing
available	in	the	article	Tips	&	Tricks:	Quick	metadata	editing.	You	can	also	apply	Image	transformations	like
anamorphic	de-squeezing	and	image	flipping.	You	can	edit	the	fields	marked	with	a	small	«pencil»	icon.

2	User	tab:	It	is	fully	editable.	There	you	can	set	the	camera	letter,	edit	scene	shot	and	take	metadata,	flag,	rate	and
label	the	selected	clip.	Besides,	you	can	add	a	comment	and	cue	points	to	it.
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figure	2:	User	Information	panel

3	File	tab:	The	“File”	tab	provides	you	an	overview	of	all	file	resources	of	the	selected	clip.
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figure	3:	the	File	tab

4	Header	tab:	The	“Header”	tab	contains	read-only	detailed	technical	information	metadata	—in	a	raw	format—
of	the	selected	clip.

5	Look	Library	tab:	Silverstack	enables	you	to	manage	looks	within	Silverstack	in	a	look	library	in	order	to	keep
a	proper	overview	of	all	the	looks	in	your	project.	The	look	library	allows	you	to	store	new	looks,	edit	their	metadata,
apply	looks	to	one	or	multiple	clips,	as	well	as	to	import	looks	from	LiveGrade.	For	more	information,	please	check
the	article	The	Silverstack	Look	Library.

6	Transcoding	tab:	Silverstack	allows	to	manage	transcoding	configurations	and	their	transcoding	settings	in	the
Transcoding	tab.	A	transcoding	preview	of	the	current	image	is	automatically	shown	in	the	player	view	when	the
transcoding	tab	is	opened.	For	more	information	about	the	transcoding	tab	and	transcoding	in	Silverstack	please
read	the	article	Transcoding	in	Silverstack.

Assets	in	Silverstack

Assets	in	Silverstack	can	be	video	clips	(e.g.	an	Alexa	or	RED	media	file),	audio	clips	(WAV),	sidecar	files
accompanying	clips	(for	example	XML	or	RMD	files),	or	any	other	document	such	as	photos	or	even	a	PDF.
However,	not	all	media	files	are	recognized	as	clips	by	Silverstack.	In	that	case	we	are	talking	about	Generic	file
formats.

Advanced	Camera	Support

Silverstack	provides	advanced	support	for	a	wide	range	of	camera	formats,	which	maximizes	the	efficiency	of
relevant	on-set	tasks	such	as	playback,	metadata	management,	color	grading,	quality	control	and	more.

The	supported	Advanced	Camera	Formats	are:

ARRIRAW	(.ari	and	.mxf)	**:
ARRI	Alexa	(.ari)
ARRI	Alexa	Mini	(.mxf)
ARRI	Amira	(.mxf)
ARRI	Alexa	65	(.ari)
ARRI	Alexa	LF	(.ari)

ARRIRAW	CODEX	HDE	(High	Density	Encoding)	(.arx)**
Blackmagic	RAW	(.braw)	**

Blackmagic	URSA	Mini	Pro	&	4.6K
Canon	XF	Movies	**:

Canon	C300	MK	I		&	II
Canon	C500
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Canon	C700
Canon	C200

Canon	XF-HEVC	**
Canon	XF705

Canon	MPEG-4	AVC/H.264	(.mts)**
Canon	C100

Canon	Cinema	RAW	Light	(.crm):
Canon	C200	and	C200B

Canon	Uncompressed	RAW	(.rmf)	[Silverstack	XT	and	Lab	only]:
Canon	C700	and	C700	FF
Canon	C300	Mk	II

CinemaDNG	(.dng):
BMCC
Bolex	D16	**
Ikonoskop
IndieCam

Generic	Image	Sequences:
JPG
TIFF
DPX

H.264	Quicktime	Movies:
Canon	DSLR	**
GoPro	Hero	**
Nikon	DSLR	**

KineRAW	(.krw)	[Silverstack	XT	and	Lab	only]:
Kinefinity	TERRA	4K	/	5K	/	6K
Kinefinity	KineMINI	4K
Kinefinity	KineMAX	6K

Panasonic	DNG	RAW	[Silverstack	XT	and	Lab	only]:
Panasonic	Varicam	LT	(with	Convergent	Design	Odyssey7Q+)
DJI	Inspire	and	Zenmuse	Series

Panasonic	AVC-Intra	**:
Panasonic	Varicam

Panasonic	V-RAW	[Silverstack	XT	and	Lab	only]:
Panasonic	Varicam

Phantom	Cine	Vision	Research	(.cine)	[Silverstack	XT	and	Lab	only]:
Phantom	Flex/Flex4K/Miro/VEO

ProRes	Quicktime	Movies	**	(.mov):
AJA	KiPro
ARRI	Alexa	/	Alexa	Mini	**
ARRI	Amira	**
ARRI	Alexa	LF	**
RED	cameras	**
Panasonic	Varicam	**
Atomos	Ninja	and	Samurai
Codex	Action	Cam
Convergent	Design	Odyssey
DJI	Inspire	and	Zenmuse	Series

REDCODE	**	(.red):
Red	Weapon	Monstro	8K	VV	,		Red	Weapon	Helium	8K	S35	,	Red	Weapon	Dragon	6K
Red	Raven	4.5K
Red	Scarlet-X	,	Scarlet	Dragon	,	Scarlet-W	5K
Red	Epic-X	,	Epic	Dragon	,	Epic-W	8K
Red	One	,	Red	One	MX

SONY	RAW**	[Silverstack	XT	and	Lab	only]:
Sony	F5
Sony	F55
Sony	F65
Sony	Venice

X-OCN	LT**,	X-OCN	ST**,	X-OCN	XT	**	[Silverstack	XT	and	Lab	only]:
Sony	F5	(with	AXS-R7	recorder)
Sony	F55	(with	AXS-R7	recorder)
Sony	Venice	(with	AXS-R7	recorder)

XAVC	**:
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Sony	F5
Sony	F55
Sony	Venice

XAVC-S	**:
Sony	a7S

Furthermore	Silverstack	offers	extensive	support	for	broadcast	wave	(BWF)	audio	wave	files	(.wav).	Learn	more	in
the	article	Audio	Clips	in	Silverstack.

**	with	audio	support

Working	with	Smart	Folders

In	the	Silverstack	library	you	find	an	element	called	“ Smart	Folders”	below	the	camera	rolls	section.		Smart	folders
provide	the	opportunity	to	filter	all	your	clips	for	certain	metadata	information.	Using	smart	folders	you	can	find
clips	with	a	certain	attribute	in	the	dedicated	project	very	easily.

The	default	smart	folders	filter	the	library	for	clips	without	backups,	with	a	high	rating,	a	flagging	or	clips	that	are
registered	today.

Create	a	new	Smart	Folder

You	can	create	Smart	Folders	with	an	individually	set	filter	in	the	 “Add”	wizard	menu	in	the	bottom	left	corner	of
your	Silverstack	window.	By	creating	a	new	Smart	Folder	the	panel	you	can	see	in	figure	2	will	appear.

Name	the	folder	and	set	the	rules	by	which	the	Smart	Folder	will	add	video	clips.	You	do	this	by	applying	filters
which	you	can	add	and	delete	by	the	“+”	and	“-”	buttons	(figure	1	#1).	For	each	filter	you	can	choose	the	kind	of
metadata	information	(figure	1	#2),	a	filter	mode	(figure	1	#3)	and	enter	specified	information	(figure	1	#4)	for
which	the	video	clips	will	be	filtered.	Additionally	you	can	decide	if	any,	all	or	none	(figure	1	#5)	of	this	filtering
criteria	have	to	be	fulfilled	by	a	clip	which	then	will	be	added	to	this	Smart	Folder	.

figure	1:	Panel	for	creating	a	new	smart	folder	in	the	Silverstack	library

Filter	attributes

For	the	below	mentioned	attributes	you	have	to	type	characters	into	the	text	field	(figure	1	#4)	to	get	a	result.	If	you
leave	the	text	field	empty,	no	video	clips	will	be	filtered	out	–	even	if	the	according	attribute	field	of	video	clips	may
be	empty.

Clip	Name
Version
Comment
Scene
Shot
Take

Camera
Reel	Name
File	Type
Codec
Look	Name
Bin	Name

If	you	want	to	filter	clips	for	a	date,	you	can	select:	today,	yesterday,	one	week	ago	or	any	specific	date.

Registration	Date
Shooting	Date
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For	the	below	listed	attributes	you	have	to	enter	a	number	in	the	text	field	(figure	1	#4)	for	getting	a	result.	If	you
leave	the	text	field	empty,	there	will	be	no	video	clips	filtered		–	even	if	the	according	attribute-field	of	some	clips	is
empty.

Number	of	Frames
Pixel	Width
Pixel	Height
Rating
ASA
Number	of	File	Representations
Number	of	Cue	Points
Playable
Missing
Frames	per	Second
F-Stop
Whitepoint
Sensor	Fps
Fps	of	TC
In/	Out
In	Point
Out	Point
Flag:	You	can	choose	between	flagged/	not	flagged
Label:	You	can	choose	any	of	the	provided	labels.
Colorspace:	With	the	colorspace	attribute	you	can	filter	video	clips	which	are	recorded	in	the	Rec.709,	LogC
(with	or	without	Film	Style	Matrix),	Dci	P3,	Cinestyle,	SLog
Volume	Name:	all	the	clips	with	a	copy/backup	in	the	specified	volume	or	volumes	will	be	shown	in	the	smart
folder.

Note:

Besides	creating	a	new	smart	folder	you	can	edit	existing	ones	by	right-clicking	on	the	relevant	smart	folder
and	choosing	“Edit…”	from	the	drop-down	menu.
A	nice	feature	is	furthermore	the	possibility	to	create	a	new	bin	that	contains	the	video	clips	which	are	included
in	the	current	smart	folder.	Therefore	right-click	on	the	relevant	smart	folder	and	choose	“New	Bin	from
Smart	Folder”.

Choosing	Custom	Thumbnail	Images

Silverstack	offers	a	flexible	way	to	experience	a	great	asset	preview	of	your	projects,	bins,	folder	and	camera	rolls.
We	incorporated	a	feature	allowing	you	to	define	your	own	thumbnails	to	get	a	better	oversight	of	your	shots	–
scenes	–	takes	and	gives	you	the	opportunity	to	navigate	faster	inside	your	library	and	locate	clips	with	one	click.

Usual	behavior

By	default,	Silverstack	analyzes	the	length	of	a	clip	and	picks	the	thumbnail	image	from	the	middle	of	the	take.	You
can	customize	the	default	behavior	in	the	preference	menu.	The	thumbnail	position	can	be	set		to	“Begin”,	“Middle”
and	“End”	of	a	clip.	If	you	want	to	recreate	your	thumbnails	you	can	do	so	by	making	an	asset	selection	and	then
click	in	the	“Edit”	menu	“Recreate	Thumbnails”.	All	selected	assets	thumbnails	will	be	recreated.

Figure	1	:	“Preferences	for	default	thumbnails”

While	this	is	suitable	for	most	occasions,	it	might	happen	that	the	preferences	of	the	clip	is	by	coincidence	a	black
frame,	a	meaningless	moment	like	blue	sky	or	a	frame	that	is	not	in	focus	which	won’t	help	you	to	identify	the	right
take	from	the	table	view,	collection	view	or	neither	in	the	reports.

Customize	your	clip	thumbnails

To	customize	your	reports	or	Table/Clip	View	with	a	thumbnail	that	matches	your	criteria	as	a	DIT	simply	mark	the
clip	and	switch	into	the	Playback	View	to	locate	the	right	frame.	From	there	you	can	scrub	to	the	desired	frame	and
set	your	thumbnail	via	the	Main	Menu	entry	in	“Edit”	–	“Set	Thumbnail	Frame”.	You	can	alternatively	use	the
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Shortcut	⌘	+	T	to	set	the	thumbnail.

Figure	2:	“Switch	to	Playback	View”

Figure	3:	“Main	Menu	entry”

Note:	You	can	only	apply	the	”	Set	Thumbnail”	feature	to	Assets	that	have	advanced	playback	support	in
Silverstack.	You	can	find	more	information	about	assets	in	this	article.

Warning:		If	you	recreate	thumbnails	with	the	function	in	the	“Edit”	menu	all	the	previous	thumbnail	images	will
be	erased	and	replaced	with	the	actual	setting	of	the	preference.

The	Copy	and	Verification	Process	in	Silverstack:	Verification	Behavior

Silverstack	6.4	and	later	differentiates	two	basic	types	of	verification	behavior:

Included	in	Copy	Job:
Verification	executed	file	per	file
(One	Job	that	copies	and	verifies	[copying	file	1,	verifying	file	1,	copying	file	2,	verifying	file	2])

Separate	(per	Job):
Copy	all	files	first	in	a	distinct	job	and	verify	them	afterwards	in	another	job
(Copy	Job	[copying	file	1,	copying	file	2],	Verify	Job	[verifying	file	1,	verifying	file	2]).

This	leads	to	several	improvements	for	the	transparency	of	the	copy	and	verification	process	in	Silverstack	that	are
outlined	in	this	article.
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The	Verification	Behavior	in	Detail

Included	in	Copy	Job

The	default	verification	behavior	contains	reduced	options	for	the	user.	It	is	referred	to	as	“Included	in	Copy
Job”	as	the	verification	process	happens	file	per	file.

Fig.1:	Verification	behavior	“Included	in	Copy	Job”

It	always	verifies	all	destinations	and	the	source	(“Verify	All	Destinations,	Include	Source	Verification”),	therefore
reduces	options	and	makes	sure	the	highest	possible	security	is	maintained.

Here	are	the	facts	in	an	overview:

Verification	Behavior:	Included	in	Copy	Job
Verification	Coverage:	All	destinations,	with	source
Available	Checksum	Methods:	xxHash64	(BE),	MD	5,	SHA	1

Separate	(per	Job)

The	advanced	verification	behavior	“Separate	(per	Job)”	allows	to	complete	the	copy	of	all	files	first	and	verify	them
later.	It	is	referred	to	as	“Separate	(per	Job)”	as	it	creates	a	separate	copy	and	verify	job.

Using	the	“Separate	(per	Job)”	verification	behavior,	there	are	multiple	options	to	choose	from	for	the
verification	coverage.	The	verification	coverage	refers	to	the	extent	of	verification	that	is	performed.

Fig.2:	The	offload	wizard	options	for	the	verification	coverage	when	verification	behavior	“Separate	(per	Job)”	is	selected

The	following	options	are	provided	for	the	verification	coverage	(refer	to	fig.	2):

All	destinations,	with	source	(default)
Abstract:	Highest	possible	security.
The	verify	job	verifies	all	copy	destinations	…
	…	and	also	the	copy	source.

All	destinations,	no	source	verification
Abstract:	Still	secure	for	destinations,	but	neglects	the	detection	of	source	problems	possible	with
“Source	Verification”.
The	verify	job	verifies	all	copy	destinations…
but	does	not	verify	the	copy	source.
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No	verification,	file	size	check	only
Abstract:	No	security,	use	with	care!	Only	the	size	of	copied	files	on	destination	is	checked	against	the
original.
No	verify	job	is	created.	File	size	check	is	performed	with	copy	job.
Even	if	it	will	not	be	verified,	Silverstack	creates	a	checksum	during	the	copy	process	that	is	stored	in	the
library.	Checksum	Method	is	fixed	to	xxHash	to	avoid	limiting	copy	speed	e.g.	using	MD	5	as	checksum
method.

Suspend	Verify	Job

The	first	two	selections	for	verification	coverage	have	an	additional	option	to	suspend	the	created	verify	job	(see	also
fig.2).	This	allows	all	other	offload	and	copy	jobs	to	be	executed	before	the	verification.	The	verify	job	suspends
automatically	once	scheduled,	and	has	to	be	resumed	manually	by	the	user.

About	Source	Verification

Learn	more	about	“Source	Verification”	in	the	article	Checksum	Verification	Methods.	“Source	Verification”	or
“verifying	the	source”	refers	to	the	process	of	reading	the	source	once	more	after	the	copy	process	end	as	part	of	the
verification	process.	This	is	done	additionally	to	reading	the	destinations	again	to	verify	their	checksums.	The
intention	to	do	this	is	to	make	sure	that	the	checksum	still	matches	the	one	created	during	the	initial	read	of	the	file
for	the	copy	process	to	detect	e.g.	broken	source	cards.	The	verification	of	the	destination	remains	untouched	by	this
setting.

Cascading	Copy

When	enabling	cascading	copy	the	verification	coverage	as	well	as	the	checksum	methods	can	be	selected	per	run:

19

Silverstack	6	Manual	
Clip	Library

https://kb.pomfort.com/?p=4678


Fig.	3:	Selecting	the	verification	coverage	for	both	runs	with	cascading	copy

More	information	about	cascading	copy	can	be	found	in	the	article	 Cascading	Copy.

Additional	Options

Overwrite	existing	files:	This	option	allows	to	overwrite	already	existing	copies	on	the	destination(s).
Skip	Copy	Step:	The	option	to	skip	the	copy	step	and	only	ingest	material	has	been	removed	in	the	Offload
wizard	to	clearly	separate	the	copy	from	the	ingest	functionality.	To	ingest	material	without	copying	use	the
“Add	to	Library…”	entry	in	the	“File”	menu.
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Fig.	4:	Using	the	“Add	to	Library”	option	for	ingest	only

Job	Scheduling	Control

The	Offload	wizard	allows	to	schedule	jobs	in	the	queue	to	be	executed	next,	after	the	running	job	finishes.	The
default	behavior,	to	add	the	job	to	the	queue,	will	be	restored	after	each	copy	job,	as	this	is	a	hit	and	run	choice
before	starting	the	jobs.

Fig.5:	The	job	scheduling	options

Learn	more	about	reordering	of	jobs	with	drag	&	drop	in	the	article	Reordering	and	Suspension	of	Jobs.

Verification	States	(for	File	Resources,	Clips	and	Bins)

Since	Silverstack	6.4	file	resources	(all	registered	file	copies	and	the	source)	have	a	verification	state	that	is	displayed
in	the	“File”	tab	of	the	right	bar.

The	verification	state	helps	the	user	to	identify	the	current	verification	status	of	the	file	resource	of	a	clip.	This	is
especially	necessary	with	the	possibility	to	copy	files	first	and	verify	them	later	in	a	separate	job:	With	verification
states	it	is	explicitly	identifiable	if	the	resource	has	been	verified.

3	Verification	States

A	file	resource	can	have	3	different	verification	states:

				Verified	(green)

				Defect	(red)

				Not	Verified	(grey)

Here’s	more	details	about	the	3	states	and	what	they	mean:

Verified:	The	hash	of	the	destination	file	matches	the	hash	created	during	the	initial	copy	of	the	file.	For
source	(source	file	resources)	a	green	verified	state	means	that	they	passed	“Source	Verification”	(if	enabled),
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which	means	a	second	read	and	hash	check	of	the	source	and	comparison	to	the	the	initially	created	hash.
Defect:	The	file	resource	has	a	different	hash	than	the	one	created	during	the	initial	copy.	This	can	be
identified	by	any	type	of	verification	Silverstack	performs	(e.g.	as	part	of	a	copy	job	or	with	a	separate	verify
job).
Not	Verified:	The	file	resource	has	not	been	verified.	Silverstack	did	not	attempt	to	do	a	verification	due	to
settings	of	the	user.		This	can	be	the	case	e.g.	for	the	source	file	resource	when	“Source	Verification”	has	been
disabled,	or	for	copy	destinations	when	choosing	to	copy	without	verification	(which	we	do	not	recommend).

You	can	learn	more	about	how	the	Silverstack	copy	process	works	in	the	following	article:

How	does	the	copy	process	in	Silverstack	work?
The	Copy	and	Verification	Process	in	Silverstack

Verification	States	in	the	File	Tab

The	file	resources	in	the	file	tab	show	the	verification	state	per	resource	and	as	a	summary	for	the	clip:
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Fig.	1:	The	file	tab	with	verification	indicators

We	can	see	that	the	clip	has	3	file	resources:

Source:	Verified
Backup	1:	Verified
Backup	2:	Not	Verified

The	summary	about	the	clip	tells	us	that	the	verification	is	incomplete	because	at	least	1	file	resource	is	not	verified.
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We	will	take	a	closer	look	at	this	behavior	in	the	next	section.

Escalation	of	Verification	States

Fig.	2:	Tracing	the	indicators	from	the	bin	to	the	file	resource	in	the	file	tab

To	make	the	user	aware	of	the	verification	state	of	all	clips	resources	already	on	a	bin	level,	the	verification	state	is
escalated	from	the	file	resource	to	the	library	outline:

As	multiple	file	resources	can	belong	to	a	clips,	a	clip	is	inside	a	bin,	and	bins	can	be	grouped	in	folders	that	can	be
ordered	in	the	hierarchy	inside	the	Library	outline	the	following	escalation	is	performed:

File	Resource	verification	state
escalates	to…

Clip	verification	state
escalates	to…

Bin	verification	state
escalates	to…

Folder	verification	state
escalates	to…

Library	verification	state

There’s	a	clear	hierarchy	of	severity	of	states	that	overrule	and	therefore	define	the	state	of	the	level	above:

Defect
overrules…

Not	Verified
overrules…

Verified

Understanding	both	cascades	will	help	you	already	identify	folders	and	bins	containing	problematic	clips.	Using	the
verification	state	column	(see	fig.	2)	you	can	trace	the	problem	down	from	the	bin	to	the	file	resource	that	might	be
defect	or	not	verified.

Folders	only	show	the	verification	state	when	collapsed	to	avoid	confusion	with	containing	states.

Running	Jobs	for	Bins
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Due	to	their	nature,	the	verification	state	icons	on	bin	level	do	not	necessarily	give	meaningful	feedback	while	copy
jobs	are	running	for	the	bin	(as	running	copy	jobs	naturally	lead	to	a	change	of	the	verification	state).	This	is	the	case
because	new	file	resources	are	registered	and	verification	processes	are	on	the	run.

To	address	this	a	“Running	Jobs”	indicator	has	been	introduced.	Installed	in	the	library	on	bin	level,	it	shows	in
form	of	a	little	progress	bar	and	tells	the	user	that	this	bin	currently	has	jobs	running	in	the	background:

Fig.	3:	The	Running	Jobs	indicator	in	the	library	outline

Furthermore,	the	“running	jobs”	indicator	for	bins	also	brings	other	benefits	such	as	e.g.	already	seeing	on	bin	level
if	no	job	is	running	anymore	for	a	bin	and	a	report	can	be	created	with	a	steady	state	of	the	library.

Migration

Please	be	aware	that	library	versions	of	Silverstack	prior	to	the	6.4	update	do	not	include	information	about
verification	states.	Therefore	a	migration	to	6.4	will	place	verification	states	based	on	the	existing	job	information.
You	can	verify	resources	based	on	the	existing	hash	information	afterwards	at	any	time.

Also	PSLAs	(Pomfort	Silverstack	Library	Archives)	exported	with	6.3	and	earlier	do	not	include	information	about
jobs	or	verification	states.	Opened	with	6.4	or	later	all	file	resources	will	receive	an	“unverified”	state.

Unregister	a	Project	from	Silverstack

Unregister	an	old	project

If	you	have	several	old	projects	in	your	library	that	you	want	to	remove	you	can	simply	unregister	them.	All	the
clips/assets	that	are	registered	in	the	library	will	be	removed.

Note:	The	files	that	are	linked	to	the	assets	will	stay	on	the	Backup	Volumes	and	will	not	be	removed!

Steps	to	remove	a	project:

1.	Open	up	Silverstack

2.	Select	the	Project	you	want	to	remove	from	Project	selector	within	the	toolbar.
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Figure	1:	“Select	a	project	from	Toolbar”

3.	Go	to	the	Main	Menu	and	press	“Unregister	Current	Project”

Figure	2:	“Unregister	Project”

Silverstack	will	switch	automatically	to	the	next	project.	If	there	are	no	other	projects	within	your	library,	Silverstack
will	automatically	create	a	new	one.

Library	Metadata	Exchange

figure	1:	metadata	exchange	between	workstations

Silverstack	XT	offers	the	possibility	to	exchange	metadata	between	multiple	workstations.	This	feature	gives	more
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flexibility	in	scenarios	where	different	Silverstack	libraries	are	used	along	the	production	workflow:	on	set	for	fast
and	secure	offloading,	near	set	for	metadata	handling	and	in	post	production	houses.

figure	2:	Silverstack	along	the	production	workflow

Exporting	library	metadata

Whole	libraries,	folders	or	bins	can	be	exported	using	this	feature.	To	start	the	process,	simply	select	the	item	from
the	Library	Panel	and	click	on	Export>to	Silverstack	Library	Archive	(psla)…:

figure	3:	export	menu

The	Library	Export	wizard	will	appear,	letting	you	select	again	which	library	folder	to	export.	In	addition,	you	can
add	a	comment	to	describe	the	metadata	content	of	the	file.
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figure	4:	library	export	wizard

After	selecting	«Export»,	a	destination	selection	dialogue	will	be	shown.	Once	the	file	has	been	saved,	it	should	look
like	this:

figure	5:	Silverstack	library	metadata	file

Importing	library	metadata

In	order	to	import	metadata	from	the	previous	process	into	another	computer,	you	can	just	double	click	the	«Day
1.psla»	file.	Otherwise	you	can	select	Import>Silverstack	Library	Archive	(psla)…:

figure	6:	import	menu

Once	the	file	has	been	selected,	the	Library	Import	wizard	will	appear.	Here	you	can	see	the	name	of	the	foler	that	is
going	to	be	imported,	the	author,	the	export	date	and	the	comment	describing	its	content.	You	are	able	to	choose
between	importing	the	metadata	as	a	new	project	or	into	the	current	project:

28

Silverstack	6	Manual	
Clip	Library



figure	7:	metadata	import	wizard

Please	bear	in	mind	that	an	active	license	is	needed	to	use	this	feature.	You	will	need	to	migrate	the	license	in	case
only	one	license	key	has	been	purchased.

Grading	Controls	in	Silverstack

User	Interface	overview

figure	1:	UI	with	Grading	Controls

The	Grading	Panel	in	Silverstack	consists	of	all	controls	for	manipulating	the	image	filtering.	The	controls	are
grouped	in	nodes	(such	as	3D	LUT	node,	CDL	node	etc.):

Grading	mode	selector:	You	can	switch	between	the	different	grading	modes	available	on	the	drop	down
menu.
Nodes	with	grading	controls:	Here	you	find	all	the	nodes	for	a	certain	grading	mode	such	as	CDL	color
controls,	3D	LUT	loading	node,	saturation	etc.	Each	node	can	be	individually	disabled	by	un-marking	the	blue
check	box.
Clear	buttons:	You	can	clear	either	the	entire	look	or	just	the	color	manipulation	(and	not	LUTs	or	tone
mapping	curves)
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Using	the	«Neutral»	button	you	can	reset	all	settings	(color	and	LUT)	to	a	«neutral»	state.
Using	the	«Reset	Colors»	button	you	can	reset	the	color	settings	to	a	“neutral”	state.

Grading	Modes

Silverstack	supports	different	grading	modes	designed	for	specific	camera	setups	and	workflow	environments.

The	node-based	design	allows	you	to	disable	and	reorder	individual	filter	nodes	to	have	greater	grading	freedom.
You	can	disable	a	certain	node	by	unchecking	the	blue	check	box.	Have	in	mind	that	the	processing	order	is	from
«top	to	bottom»	when	reordering	the	nodes.

Each	grading	mode	allows	different	levels	of	grade	customization,	as	the	compatibility	of	the	grades	down	the
workflow	creates	some	restrictions	on	how	the	color	information	has	to	be	processed.	For	example,	the	camera
compatible	grading	modes	can	have	the	nodes	locked	in	a	certain	position	to	ensure	the	compatibility	of	the	grade
when	being	uploaded	into	the	camera.

figure	2:	The	different	grading	modes	to	choose	from.

The	grading	modes	allowing	the	greatest	level	of	customization	are	the	Advanced	and	Freestyle	modes.

CDL	and	LUT

Figure	3:	The	CDL	and	LUT	grading	mode

The	CDL	and	LUT	grading	mode	offers	ASC-CDL	controls	for	the	use	in	a	wide	range	of	workflows.	For	clips
recorded	in	Log	color	spaces,	Silverstack	allows	to	import	3D	LUTs	or	choose	from	3D	LUT	Presets.

In	order	to	support	workflows	that	apply	CDL	in	log	gamma	as	well	as	in	video	gamma,	the	order	of	LUT	and
CDL	filters	can	be	changed	when	using	the	CDL	Advanced	grading	mode.	The	CDL	and	LUT	mode	can	also	be
used	with	Rec.709	clips	without	adding	a	3D	LUT.

The	color	controls	for	the	CDL	and	LUT	grading	mode	consist	of:

ASC-CDL	controls	node:
RGB	Shadows,	Mid-tones	and	Highlights	color	wheels
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figure	4:	ASC-CDL	color	wheels

Saturation	slider	node

figure	5:	Saturation	node

Import	of	3D	LUT	node:	The	CDL	and	LUT	grading	mode	can	import	3D	LUTs	and	CDL	files	and	can
export	ASC-CDL	files.

3D	LUT	Import	options	with	averaged	curve	displays	for	each	channel

figure	6:	3D	LUT	node

CDL	Advanced

Allows	you	to	add	and	reorder	multiple	nodes	on	advanced	workflows.

Alexa	Looks

This	mode	is	designed	to	create	.xml	ALEXA	Looks	compatible	with	ARRI	ALEXA	cameras.	More	information	in	the
article	Using	the	ALEXA	Looks	grading	mode.

Freestyle

This	grading	mode	has	been	created	to	allow	complete	grading	freedom.	For	this	reason,	there	are	some	limitations
on	the	available	export	formats	for	looks	created	on	this	mode.

ACES	CDL

A	mode	adapted	to	the	ACES	standard.	More	information	in	the	article	Using	the	ACES	grading	mode.

ACES	CDL	Advanced

A	mode	adapted	to	the	ACES	standard.	Allows	you	to	add	and	reorder	multiple	nodes	on	advanced	workflows.

Varicam	Compatible

This	mode	is	designed	to	create	3D	LUTs	and	looks	compatible	with	Panasonic	Varicam	35	cameras.

Amira	Compatible

This	mode	is	designed	to	create	.aml	AMIRA	Looks	compatible	with	ARRI	AMIRA	cameras.

Available	grading	nodes

CDL	Node

The	CDL	node	contains	a	color	wheel	for	Offset,	Power	and	Slope.	It	can	be	used	to	adjust	the	color	on	the	image.

figure	7:	CDL	grading	node

ASC-CDL	files	can	be	directly	loaded	and	saved	to/from	the	CDL	node	(supported	format:	*.cdl).		Click	the	gear
button	on	the	left	side	of	the	CDL	node	and	select	if	you	want	to	load	or	save	a	CDL.
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Please	be	aware	that	the	ASC-CDL	specification	always	includes	a	saturation	value.	When	one	saturation	node	is
present	CDLs	will	be	loaded	and	saved	from/to	the	present	saturation	node.	When	multiple	CDL	and	saturation
nodes	are	present	you	will	be	pointed	choose	the	saturation	node	you	want	to	load	the	saturation	to	(indicators
A,B,C	etc.).

Saturation	Node

Just	drag	the	slider	to	either	side	to	increase	or	decrease	the	saturation	on	your	look.

figure	8:	Saturation	node

3D	LUT	Node

The	3D	LUT	node	is	designed	to	load	your	own	3D	LUTs	by	pressing	the	«Load…»	button.	Alternatively,	you	can
also	use	one	of	the	available	preset	3D	LUTs	to	convert	the	image	to	a	Rec.709	color	space.

figure	9:	3D	LUT	node

1D	LUT	Node

The	1D	LUT	lets	you	load	your	own	1D	LUT	file.	Click	the	 “Load…”	button	and	select	the	1D	LUT	you	want	to	load
to	the	node.

figure	10:	1D	LUT	Node

In	contrast	to	the	curve	node	the	LUT	in	the	1D	LUT	node	can	not	be	edited	afterwards.

Supported	formats	are:

*.txt
channels:	3
range:	0.0	…	1023.0	(float)
header:	“R	G	B	–	HDLINK	GAMMA	TABLE”
entries:	1024
row	example:	“221.37	221.37	221.37”

*.data
channels:	4
range:	0	…	16383	(integer)
entries:	16384
row	example:	15040,15040,15040,15040

*.lut
channels:	3	(4	columns	with	leading	index	(0…65535,	R,	G,	B)
range:	0	…	65535	(integer)
header:	“LUT16”
entries:	65536
row	example:	45490	58366	58366	58366

Curve	Node

figure	11:	Curve	node

The	Curve	node	lets	you	adjust	the	1D	LUT	curve	on	the	image.	If	you	click	on	«Edit»,	the	curve	editor	window	will
pop	up.	It	allows	you	to	precisely	grade	your	footage:
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To	add	a	point	just	click	on	the	curve,	and	in	order	to	modify	it’s	value	just	drag	and	drop.
To	remove	a	point	simply	move	it	out	of	the	curve	editor’s	window.
When	you	move	your	mouse	over	the	curve	editor,	the	graph	shows	you	the	value	of	the	exact	point	where	it	is.

figure	12:	Curve	editor	window

HHS	Node

The	HHS	node	–Hue	to	Hue	and	Saturation–	is	a	new	kind	of	node	that	allows	you	to	map	a	certain	hue	on	the
image	and	replace	it	by	another	color	with	different	hue	and	saturation.	Here	is	an	example	where	the	red	has	been
desaturated,	but	the	other	colors	remain	the	same:

The	HHS	editor	allows	you	to	drag	and	drop	the	hue	circles	to	another	location	on	the	color	space	to	replace	the
original	color	with	another	one.
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figure	13:	HHS	editor

Grading	Panel	Support

Silverstack	supports	the	use	of	hardware	grading	panels	for	the	grading	functionalities.	The	following	panels	are
supported:

Tangent	Element	Tk
Tangent	Wave
Avid	Artist	Color

Connect	the	hardware	panels	to	Silverstack	to	precisely	and	physically	manipulate	your	grades.

Using	the	ACES	CDL	Grading	Mode

figure	1:	ACES	grading	controls

Silverstack	XT	has	the	capability	of	reproducing	ACES	workflows.

Different	versions	of	the	ACES	workflow	are	available	from	the	Preferences	panel:

v	1.0.3	(ACEScc	and	ACEScct)
v	1.0.2
v	1.0.1
v	1.0.0
v	0.7.1
v	0.7.0
v	0.2.0

These	ACES	versions	have	different	IDTs	(Input	Device	Transforms)	and	ODTs	(Output	Device	Transforms).	Please,
make	sure	that	the	ACES	version	used	in	Silverstack	XT	matches	the	one	used	during	the	post	production	process
for	maximum	color	accuracy.

The	grading	nodes	displayed	in	the	ACES	mode	are	divided	in	two	parts:
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ACES	color	transformation	panel

CDL	controls

Additionally,	Silverstack	XT	offers	the	ACES	CDL	Advanced	grading	mode.	This	grading	mode	lets	you	add	multiple
grading	nodes	between	the	IDT	and	ODT	for	advanced	workflows.

Managing	ACES	Versions

In	the	Silverstack	preferences	you	can	manage	the	available	ACES	versions	and	transforms:

Fig.	2:	ACES	preference	panel

The	dropdown	lets	you	select	the	ACES	version	for	new	looks.	Every	new	look	will	be	initialized	with	the	ACES
version	selected	in	the	dropdown	in	the	preferences.

That	means	that	every	look	in	the	library	made	with	an	ACES	grading	mode	has	an	associated	ACES	version	(you
can	find	that	version	in	the	“ACES	Mode”	column	in	the	Silverstack	library).	Saving	looks	with	different	ACES
versions	to	the	library	will	make	it	easy	to	compare	the	look	of	different	ACES	versions	effortlessly.

In	the	section	“Available	ACES	Transforms”	you	can	find	the	available	ACES	versions	and	its	associated
transforms.	The	icon	in	the	status	bar	will	either	signalize	an	available	set	of	transforms	(green	checkmark)	or	a	set
of	transforms	that	can	be	downloaded	from	the	servers	(download	icon	with	downwards	arrow).

Click	the	button	“Check	for	New	Versions”	at	the	bottom	of	the	preferences	window	to	see	if	new	ACES	versions
are	available	to	download	from	the	Pomfort	servers.
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Supported	ACES	IDT	and	ODT	formats

Before	starting	to	create	your	grades,	select	the	correct	IDT	(matching	your	camera	system)	and	the	ODT	(matching
the	output	display	color	space)	from	the	color	transformation	panel.	LiveGrade	Pro	currently	offers	the	following	set
of	IDTs	and	ODTs:

ACEScc	v.	1.0.3
IDT

ARRI
Alexa	Log-C	EI1000	v3
Alexa	Log-C	EI1280	v3
Alexa	Log-C	EI160	v3
Alexa	Log-C	EI1600	v3
Alexa	Log-C	EI200	v3
Alexa	Log-C	EI2000	v3
Alexa	Log-C	EI250	v3
Alexa	Log-C	EI2560	v3
Alexa	Log-C	EI320	v3
Alexa	Log-C	EI3200	v3
Alexa	Log-C	EI400	v3
Alexa	Log-C	EI500	v3
Alexa	Log-C	EI640	v3
Alexa	Log-C	EI800	v3

Academy
ACESproxy
Reverse	Rec.709	(ODT)

Canon
EOS	C100	(A)	D55	v1.0
EOS	C100	(A)	Tungsten	v1.0
EOS	C300	(A)	D55	v1.0
EOS	C300	(A)	Tungsten	v1.0
EOS	C300	mkII	CanonLog2	BT2020(B)	D55	v1.0
EOS	C300	mkII	CanonLog2	BT2020(B)	Tungsten	v1.0
EOS	C300	mkII	CanonLog2	CinemaGamut(A)	D55	v1.0
EOS	C300	mkII	CanonLog2	CinemaGamut(A)	Tungsten	v1.0
EOS	C300	mkII	CanonLog	BT2020(D)	D55	v1.0
EOS	C300	mkII	CanonLog	BT2020(D)	Tungsten	v1.0
EOS	C300	mkII	CanonLog	CinemaGamut(C)	D55	v1.0
EOS	C300	mkII	CanonLog	CinemaGamut(C)	Tungsten	v1.0
EOS	C500	CinemaGamut(A)	D55	v1.1.1
EOS	C500	CinemaGamut(A)	Tungsten	v1.1.1
EOS	C500	DCI-P3	D55	v1.1.1
EOS	C500	DCI-P3	Tungsten	v1.1.1

Panasonic
V35	v070

Sony
F35	S-Log1
S-Log2	Daylight
S-Log2	Tungsten
S-Log3	S-Gamut3
S-Log3	S-Gamut3.Cine

ODT
AMPAS

P3	ST2084	D60	1000nits
P3	ST2084	D60	2000nits
P3	ST2084	D60	4000nits
P3
RGB	Monitor	100nits	(dim)
RGB	Monitor	D60	100nits	(dim)
Rec.2020	100nits	(dim)
Rec.2020	ST2084	1000nits
Rec.709	100nits
Rec.709	D60	100nits

ACEScct	v.	1.0.3
IDT
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ARRI
Alexa	Log-C	EI1000	v3
Alexa	Log-C	EI1280	v3
Alexa	Log-C	EI160	v3
Alexa	Log-C	EI1600	v3
Alexa	Log-C	EI200	v3
Alexa	Log-C	EI2000	v3
Alexa	Log-C	EI250	v3
Alexa	Log-C	EI2560	v3
Alexa	Log-C	EI320	v3
Alexa	Log-C	EI3200	v3
Alexa	Log-C	EI400	v3
Alexa	Log-C	EI500	v3
Alexa	Log-C	EI640	v3
Alexa	Log-C	EI800	v3

Academy
ACESproxy
Reverse	Rec.709	(ODT)

Canon
EOS	C100	(A)	D55	v1.0
EOS	C100	(A)	Tungsten	v1.0
EOS	C300	(A)	D55	v1.0
EOS	C300	(A)	Tungsten	v1.0
EOS	C300	mkII	CanonLog2	BT2020(B)	D55	v1.0
EOS	C300	mkII	CanonLog2	BT2020(B)	Tungsten	v1.0
EOS	C300	mkII	CanonLog2	CinemaGamut(A)	D55	v1.0
EOS	C300	mkII	CanonLog2	CinemaGamut(A)	Tungsten	v1.0
EOS	C300	mkII	CanonLog	BT2020(D)	D55	v1.0
EOS	C300	mkII	CanonLog	BT2020(D)	Tungsten	v1.0
EOS	C300	mkII	CanonLog	CinemaGamut(C)	D55	v1.0
EOS	C300	mkII	CanonLog	CinemaGamut(C)	Tungsten	v1.0
EOS	C500	CinemaGamut(A)	D55	v1.1.1
EOS	C500	CinemaGamut(A)	Tungsten	v1.1.1
EOS	C500	DCI-P3	D55	v1.1.1
EOS	C500	DCI-P3	Tungsten	v1.1.1

Panasonic
V35	v070

Sony
F35	S-Log1
S-Log2	Daylight
S-Log2	Tungsten
S-Log3	S-Gamut3
S-Log3	S-Gamut3.Cine

ODT
AMPAS

P3	ST2084	D60	1000nits
P3	ST2084	D60	2000nits
P3	ST2084	D60	4000nits
P3
RGB	Monitor	100nits	(dim)
RGB	Monitor	D60	100nits	(dim)
Rec.2020	100nits	(dim)
Rec.2020	ST2084	1000nits
Rec.709	100nits
Rec.709	D60	100nits

ACEScc	v.	1.0.2
IDT

AMPAS
ACESproxy	v1.0.1/1.0.2
Reverse	Rec.709	(ODT)	v1.0.1/1.0.2

ARRI
Alexa	Log-C	EI1000	v3
Alexa	Log-C	EI1280	v3
Alexa	Log-C	EI160	v3
Alexa	Log-C	EI1600	v3
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Alexa	Log-C	EI200	v3
Alexa	Log-C	EI2000	v3
Alexa	Log-C	EI250	v3
Alexa	Log-C	EI2560	v3
Alexa	Log-C	EI320	v3
Alexa	Log-C	EI3200	v3
Alexa	Log-C	EI400	v3
Alexa	Log-C	EI500	v3
Alexa	Log-C	EI640	v3
Alexa	Log-C	EI800	v3

Canon
EOS	C100	(A)	D55	v1.0
EOS	C100	(A)	Tungsten	v1.0
EOS	C300	(A)	D55	v1.0
EOS	C300	(A)	Tungsten	v1.0
EOS	C300	mkII	CanonLog2	BT2020(B)	D55	v1.0
EOS	C300	mkII	CanonLog2	BT2020(B)	Tungsten	v1.0
EOS	C300	mkII	CanonLog2	CinemaGamut(A)	D55	v1.0
EOS	C300	mkII	CanonLog2	CinemaGamut(A)	Tungsten	v1.0
EOS	C300	mkII	CanonLog	BT2020(D)	D55	v1.0
EOS	C300	mkII	CanonLog	BT2020(D)	Tungsten	v1.0
EOS	C300	mkII	CanonLog	CinemaGamut(C)	D55	v1.0
EOS	C300	mkII	CanonLog	CinemaGamut(C)	Tungsten	v1.0
EOS	C500	CinemaGamut(A)	D55	v1.1.1
EOS	C500	CinemaGamut(A)	Tungsten	v1.1.1
EOS	C500	DCI-P3	D55	v1.1.1
EOS	C500	DCI-P3	Tungsten	v1.1.1

Panasonic
V35	v070

Sony
F35	Slog1
F55/F65	Slog2	Daylight
F55/F65	Slog2	Tungsten

ODT
AMPAS

P3	ST2084	D60	1000nits	v1.0.1/1.0.2
P3	ST2084	D60	2000nits	v1.0.1/1.0.2
P3	ST2084	D60	4000nits	v1.0.1/1.0.2
P3	v1.0.1/1.0.2
Rec.2020	100nits	(dim)	v1.0.1/1.0.2
Rec.2020	ST2084	1000nits	v1.0.1/1.0.2
Rec.709	100nits	v1.0.1/1.0.2
Rec.709	D60	100nits	v1.0.1/1.0.2

ACEScc	v.	1.0.1
IDT

AMPAS
ACESproxy	v1.0.1
Reverse	Rec.709	(ODT)	v1.0.1

ARRI
Alexa	Log-C	EI800	v3

Canon
EOS	C100	(A)	D55	v1.0
EOS	C100	(A)	Tungsten	v1.0
EOS	C300	(A)	D55	v1.0
EOS	C300	(A)	Tungsten	v1.0
EOS	C300	mkII	CanonLog2	BT2020(B)	D55	v1.0
EOS	C300	mkII	CanonLog2	BT2020(B)	Tungsten	v1.0
EOS	C300	mkII	CanonLog2	CinemaGamut(A)	D55	v1.0
EOS	C300	mkII	CanonLog2	CinemaGamut(A)	Tungsten	v1.0
EOS	C300	mkII	CanonLog	BT2020(D)	D55	v1.0
EOS	C300	mkII	CanonLog	BT2020(D)	Tungsten	v1.0
EOS	C300	mkII	CanonLog	CinemaGamut(C)	D55	v1.0
EOS	C300	mkII	CanonLog	CinemaGamut(C)	Tungsten	v1.0
EOS	C500	CinemaGamut(A)	D55	v1.1.1
EOS	C500	CinemaGamut(A)	Tungsten	v1.1.1
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EOS	C500	DCI-P3	D55	v1.1.1
EOS	C500	DCI-P3	Tungsten	v1.1.1

Panasonic
V35	v070

Sony
F35	Slog1
F55/F65	Slog2	Daylight
F55/F65	Slog2	Tungsten

ODT
AMPAS

P3	v1.0.1
Rec.2020	100nits	(dim)	v1.0.1
Rec.709	100nits	v1.0.1

ACESlog	v.	1.0.0
IDT

AMPAS
ACESproxy	(ACESlog	v1.0.0)
Reverse	Rec.709	(ODT)	(ACESlog	v1.0.0)

Alexa
v3	EI800	(ACESlog	v1.0.0)

Canon
EOS	C300	mkII	CanonLog2	BT2020(B)	D55	v1.0
EOS	C300	mkII	CanonLog2	BT2020(B)	Tungsten	v1.0
EOS	C300	mkII	CanonLog2	CinemaGamut(A)	D55	v1.0
EOS	C300	mkII	CanonLog2	CinemaGamut(A)	Tungsten	v1.0
EOS	C300	mkII	CanonLog	BT2020(D)	D55	v1.0
EOS	C300	mkII	CanonLog	BT2020(D)	Tungsten	v1.0
EOS	C300	mkII	CanonLog	CinemaGamut(C)	D55	v1.0
EOS	C300	mkII	CanonLog	CinemaGamut(C)	Tungsten	v1.0
EOS	CinemaGamut(A)	D55	v1.1	(ACESlog	v1.0.0)
EOS	CinemaGamut(A)	Tungsten	v1.1	(ACESlog	v1.0.0)
EOS	DCI-P3	D55	v1.1	(ACESlog	v1.0.0)
EOS	DCI-P3	Tungsten	v1.1	(ACESlog	v1.0.0)

Panasonic
V35	v070	(ACESlog	v1.0.0)

Sony
Slog1	(F35)	(ACESlog	v1.0.0)
Slog2	(F55/F65)	Daylight	(ACESlog	v1.0.0)
Slog2	(F55/F65)	Tungsten	(ACESlog	v1.0.0)

ODT
AMPAS
P3	(ACESlog	v1.0.0)
Rec.2020	100nits	dim	(ACESlog	v1.0.0)
Rec.709	100nits	(ACESlog	v1.0.0)

ACESlog	v.	0.7.1
IDT

Alexa
v3	EI800	(ACESlog	v0.7.1)

Canon
EOS	CinemaGamut(A)	D55	v1.1	(ACESlog	v0.7.1)
EOS	CinemaGamut(A)	Tungsten	v1.1	(ACESlog	v0.7.1)
EOS	DCI-P3	D55	v1.1	(ACESlog	v0.7.1)
EOS	DCI-P3	Tungsten	v1.1	(ACESlog	v0.7.1)

Panasonic
V35	v070	(ACESlog	v0.7.1)

Sony
Slog1	(F35)	(ACESlog	v0.7.1)
Slog2	(F55/F65)	Daylight	(ACESlog	v0.7.1)
Slog2	(F55/F65)	Tungsten	(ACESlog	v0.7.1)

ODT
AMPAS

P3	(ACESlog	v0.7.1)
Rec.709	100nits	(ACESlog	v0.7.1)

ACESlog	v.	0.7.0
IDT

39

Silverstack	6	Manual	
Clip	Library



Alexa
(ACESlog	v0.7.0)
Canon
EOS	CinemaGamut(A)	D55	v1.1	(ACESlog	v0.7.0)
EOS	CinemaGamut(A)	Tungsten	v1.1	(ACESlog	v0.7.0)
EOS	DCI-P3+(A)	D55	v1.1	(ACESlog	v0.7.0)
EOS	DCI-P3+(A)	Tungsten	v1.1	(ACESlog	v0.7.0)
Panasonic
VariCam	35	(ACESlog	v0.7.0)
Sony
F35	(ACESlog	v0.7.0)
F55	Daylight	(ACESlog	v0.7.0)
F55	Tungsten	(ACESlog	v0.7.0)

ODT
AMPAS
P3	(ACESlog	v0.7.0)
Rec.709	(ACESlog	v0.7.0)

ACESlog	v.	0.2.0
IDT

Alexa
(ACESlog	v0.2.0)

Sony
(ACESlog	v0.2.0)

ODT
AMPAS

P3	(ACESlog	v0.2.0)
Rec.709	(ACESlog	v0.2.0)

The	CDL	controls	behave	the	same	way	as	in	the	CDL	Grade	mode	and	can	also	be	exported	as	usual	from	a	saved
grade.	ACES	grades	can	also	be	exported	as	3D	LUTs,	including	the	CDL	values,	IDT	and	ODT.

The	Silverstack	Look	Library

Silverstack	enables	you	to	manage	looks	within	Silverstack	in	a	look	library	in	order	to	keep	a	proper	overview	of	all
the	looks	in	your	project.	The	look	library	allows	to	store	new	looks,	edit	their	metadata,	apply	looks	to	one	or
multiple	clips,	as	well	as	to	import	looks	from	LiveGrade.

The	Look	Tab

The	look	tab	in	the	right	bar	of	Silverstack	is	marked	with	a	specific	icon:

Click	the	icon	to	reach	the	look	tab.	The	tab	itself	consists	of	three	sections:

Look	Library
Looks
Look	Details
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Figure	1:	The	Silverstack	look	tab	containing	the	Look	Library.

In	detail	those	sections	enable	you	to:

Look	Library

Create	new	folders	by	clicking	the	“+”	button	on	the	top	right
Create	sub	folders	by	holding	“alt”	plus	clicking	the	“+”	button
Edit	the	structure	by	dragging	folders	out	of	or	into	each	other
Rename	folders	by	selecting	and	single	clicking	them	or	hitting	enter

Figure	2:	Organize	folders	containing	looks

Looks

Create	a	new	look	by	clicking	the	“+”	button	on	the	top	right
Update	a	look	by	selecting	one	and	clicking	the	update	button	next	to	the	“+”	button
Preview	a	look	by	selecting	it	and	clicking	plus	holding	the	loupe	icon
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Apply	a	look	to	the	current	clip	in	the	player	by	double-clicking	the	intended	look
Apply	looks	to	multiple	clips	by	selecting	the	desired	clips	and	double	clicking	the	intended	look
Move	one	or	multiple	Looks	to	other	folders	by	dragging	and	dropping	it	to	a	different	Looks	folder	in	the

Look	Library*

Figure	3:	The	looks	section	with	highlighted	add,	update	and	preview	look	buttons

The	context	menu	for	looks	can	be	reached	by	right	clicking	a	look.	It	enables	you	to:

Figure	4:	The	context	menu	can	be	reached	with	a	right	click	on	a	look

Apply	a	look	to	the	selected	clips	(one	or	multiple	clips)
Apply	a	look	only	to	the	current	clip	shown	in	the	player	(even	if	multiple	clips	are	selected)
Update	the	look	with	the	current	grade
Set	a	new	thumbnail	from	the	current	clip	but	leaving	the	look	identical
Delete	one	or	multiple	looks.

To	learn	how	to	use	the	Silverstack	grading	controls	please	refer	to	the	article	 Grading	Controls	in	Silverstack.

Look	Details

When	importing	looks	from	LiveGrade,	the	information	fields	in	the	Look	Details	receive	the	values	from	the	look
edited	in	LiveGrade.	In	the	Look	Details	it	is	possible	to:

Edit	the	look	name
Edit	metadata	of	the	look	including	Date,	Camera,	Episode,	Shot,Take	and	Reel	Name
Display	Start	and	End	Timecode
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Figure	5:	The	Look	Details	section

Importing	and	Exporting	Looks

You	can	import	a	look	from	LiveGrade	by	selecting	“File>Import>Pomfort	Looks	(pfl)…”	from	the	main	menu.
You	can	learn	about	the	process	of	transferring	looks	from	LiveGrade	to	Silverstack	in	the	article	Transferring	Looks
from	Livegrade	to	Silverstack.

Read	about	exporting	looks	from	Silverstack	in	the	article	Exporting	Looks	from	Silverstack.

Look	Functions	in	the	Main	Menu

You	can	find	most	of	the	functions	concerning	the	Look	Library	in	the	Main	Menu.	Go	to	“ Main	Menu>Look”	and
choose	from	the	following	actions:

Figure	6:	The	“Look”	section	of	the	Main	Menu

Create	a	new	look
Update	a	selected	look
Set	the	thumbnail	from	the	current	clip
Duplicate	Look
Create	a	new	look	folder
Apply	a	look	to	all	selected	clips
Apply	a	look	only	to	the	current	clip
Switch	to	the	previous	look	node	(useful	for	working	with	grading	panels	in	more	advanced	grading	modes)
Switch	to	the	next	look	node	(useful	for	working	with	grading	panels	in	more	advanced	grading	modes)
Refreshing	hardware	panels

Please	refer	to	the	shortcuts	at	the	end	of	the	entries	for	faster	access	of	the	functions.

*	Please	be	aware	that	you	have	to	click	and	hold	the	selected	look(s)	to	see	the	transparent	thumbnails	pop	out	to	enable	the	drag	&	drop

function.	Trying	to	move	a	look	while	immediately	pulling	it	will	leave	you	with	the	multi	select	function	of	the	collection	view.

43

Silverstack	6	Manual	
Clip	Library



Look	Matching

While	using	Silverstack	together	with	LiveGrade	on	set	to	manage	clip	data	and	looks	hand	in	hand,	you
surely	want	to	combine	the	created	information	afterwards.		Silverstack	offers	a	solution	to	avoid	assigning	looks	to
clips	manually.	You	can	connect	them	based	on	the	metadata	you	already	created	while	generating	them.

How	to	Match	your	LiveGrade	Pro	Looks	to	Silverstack	Clips

It	is	possible	to	automatically	match	a	package	of	looks	created	with	LiveGrade	Pro	to	the	according	clips	in
Silverstack.		A	Look	Archive	(.pfla)	containing	several	different	looks	can	be	exported	from	LiveGrade	Pro.	This	Look
Archive	can	be	imported	into	Silverstack	to	then	match	the	looks	to	the	according	clips	based	on	different	metadata.

The	steps	to	match	looks	from	LiveGrade	Pro	to	clips	in	Silverstack	are:

1.	 Export	a	Look	Archive	from	LiveGrade	Pro
2.	 Import	the	Look	Archive	into	Silverstack
3.	 Operate	the	matching	Wizard	to	match	by	the	desired	criteria:

Match	by	Timecode
Match	by	Creation	Time	of	Look
Match	by	Episode,	Scene,	Shot,	Take
Choose	if	to	match	with	Camera	as	well

1.	Export	a	Look	Archive	from	LiveGrade	Pro

A	Look	Archive	can	contain	one	or	multiple	looks	along	with	all	the	further	metadata	acquired	in	LiveGrade	Pro.

To	export	a	Look	Archive	put	all	the	desired	looks	into	one	folder	in	the	LiveGrade	Look	Library.	Perform	a	right
click	on	that	folder	and	choose	“Export	Look	Archive”	from	the	context	menu:

Figure	1:	Exporting	a	Look	Archive	from	LiveGrade	Pro

Save	the	resulting	.pfla	(Pomfort	Look	Archive)	file	to	the	desired	destination.

2.	Import	a	Look	Archive	into	Silverstack

Make	sure	you	ingested	all	the	clips	that	will	get	a	look	into	one	bin	in	Silverstack.	Learn	about	offloading	media
from	the	article	Parallel	Offloading.
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Figure	2:	Bin	with	clips	that	should	receive	matching	looks

Make	sure	to	have	the	according	bin	selected	prior	to	starting	the	import.

To	import	a	Look	Archive	into	Silverstack	go	to	the	Main	Menu.	Choose	“File	>	Import	>	Match	with	Pomfort
Look	Archive”:

Figure	3:	Importing	a	Look	Archive	for	Matching

3.	The	Look	Matching	Wizard

After	that	a	wizard	window	will	open	that	first	advises	you	to	select	a	Look	Archive	for	the	matching:
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Figure	4:	Select	the	desired	Look	Archive

Navigate	to	the	.pfla	file	you	saved	from	LiveGrade	Pro,	select	it	and	click	“Open”.

You	will	now	be	presented	with	the	matching	wizard	window:
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Figure	5:	The	look	matching	wizard

You	can	choose	between	three	different	matching	criteria:

•	Match	by	Timecode

This	criterion	will	match	the	looks	by	timecode.	The	look	will	match	to	a	clip	if	its	TC	In	is	before	or	within	the	range
of	the	TC	of	the	clip.	Additionally	the	looks	will	be	applied	to	all	clips	that	follow	until	the	next	look	with	a
subsequent	TC	In.	If	a	new	look	has	a	TC	In	that	is	inside	of	the	TC	range	of	a	clip	(so	the	look	before	ends	within
the	clip)	the	matching	wizard	will	suggest	two	looks	but	preselects	the	latter	by	default.

•	Match	by	Creation	Time	of	Look

This	criterion	will	match	the	looks	by	their	creation	time.	The	look	will	match	to	a	clip	if	its	creation	date	is	before
the	time	range	of	the	clip.	It	will	match	to	all	following	clips	until	a	new	creation	date	of	a	look	is	found	that	is	placed
inside	the	time	range	of	a	clip.	Additionally	you	can	shift	the	timezone	if	the	camera	setup	was	wrong	at	the	time	of
recording:
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Figure	6:	Adapt	the	timezone	offset	if	needed.

•	Match	by	Episode,	Scene,	Shot,	Take

This	criterion	will	match	the	looks	by	the	episode,	scene,	shot	and	take	metadata	values.	The	look	will	match	to	a
clip	if	the	metadata	for	episode,	scene,	shot	or	take	is	equal.

Additionally	to	the	three	different	matching	criteria,	for	each	of	them	you	can:

•	Match	with	Camera

Additionally	to	the	selection	of	your	criterion	among	the	three	criteria	you	can	choose	if	the	looks	should	be	matched
to	the	clips	by	the	camera	metadata	value.

Example:

If	you	have	Camera	A	and	B	and	match	looks	by	timecode	the	looks	may	apply	to	both	of	the	cameras	if	they	have
the	same	TC.	If	you	then	enable	the	checkbox	“Match	with	camera”	the	camera	value	will	be	considered	on	top	of	the
TC	and	will	then	match	the	correct	looks	to	the	camera	specific	clips.

To	learn	how	to	simply	transfer	looks	from	LiveGrade	to	Silverstack	please	refer	to	this	article	Transferring	Looks
from	LiveGrade	Pro	to	Silverstack.

Audio	Clips	in	Silverstack

Silverstack	offers	advanced	support	for	separately	recorded	audio	files	in	the	Broadcast	Wave	format	(BWF,	.wav).

Ingest	of	Audio	Clips
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Fig	1:	Ingest	and	copy	Broadcast	Wave	audio	files

To	ingest	audio	files	into	Silverstack	click	the	“Offload”	button	in	the	upper	left	corner	of	the	UI	and	choose	the
card	or	folder	with	the	audio	files	to	be	offloaded.	Audio	files	can	be	backed	up	within	the	audio	wizard	just	as	any
other	file	type.	Learn	more	about	it	in	the	article	Parallel	Offloading.

After	starting	the	offload	process	Silverstack	will	register	the	audio	clips	in	the	library:
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Fig.	2:	Audio	clips	in	the	Silverstack	library

Silverstack	will	automatically	detect	.wav	files	that	belong	to	the	same	clip	and	merges	them	together	to	an	audio
clip	containing	several	audio	tracks.

By	opening	the	audio	panel	with	the	“Audio&Color”	button	in	the	toolbar	all	the	audio	tracks	including	waveform
will	be	visible	for	the	selected	audio	clip.

You	can	play	audio	clips	back	by	clicking	the	play	button.

The	audio	panel	offers	the	following	controls:

Master	Volume:	Controls	the	output	signal	level	of	the	mix.
Audio	meters:	Represent	the	audio	signal	level	during	playback.	There	is	a	stereo	Master	meter	and
additional	Channel	meters	—	one	for	each	audio	track.	The	scale	on	top	of	the	meters	indicates	the	audio	level
in	dB	(dBFS).	Peaking	is	represented	by	a	bar	in	the	according	color	of	the	peaking	level	that	remains	at	the
maximum	position.	You	can	reset	the	peak	bar	by	clicking	on	the	audio	meters.
Channel	mixers:	The	sliders	control	the	signal	level	for	each	track.	You	can	mute	specific	«Left»	and
«Right»	tracks	by	disabling	the	check	boxes	on	the	right	of	the	channel	mixers.
Mute	button:	Mutes	the	according	audio	channel	or	the	complete	audio	clip	section
Solo	button:	Solos	the	according	audio	channel,	as	long	as	the	button	is	pressed
Pan	control:	Sets	the	panorama	to	left,	middle	or	right

The	audio	tracks	panel	can	be	opened	from	the	small	play	button	on	the	left	side	of	the	track	name.	It	enables	the
playback	of	a	single	audio	channel*:
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Fig.	3:	The	audio	tracks	panel	with	single	audio	track	playback

Audio	Clips	Metadata

Audio	clips	in	Silverstack	own	a	special	set	of	metadata	that	is	shown	in	the	General	Info	tab	of	the	right	bar.	The
following	metadata	will	be	pulled	from	the	audio	file	metadata:

Scene	–	Shot	–	Take
Wild	Track
Recorder	Model
Recorder	Device	ID
Samples	since	Midnight
FPS	of	TC
TC	Start
TC	End
Tape
Recording	Date
Audio	Track	Names

Adding	Audio	Clips	as	External	Audio	to	Video	Clips

Once	ingested	audio	clips	can	be	added	to	video	clips	as	external	audio	either	manually	(Silverstack	XT)	or
automatically	(Silverstack	Lab):

Manual	Audio	Sync:	How	to	Manually	Sync	Audio	in	Silverstack	XT	and	Silverstack	Lab
Automatic	Audio	Sync:	How	to	Automatically	Sync	Audio	Based	on	Timecode	in	Silverstack	Lab

*only	available	in	Silverstack	XT	and	Silverstack	Lab

How	to	Manually	Sync	Audio	in	Silverstack	XT	and	Silverstack	Lab

Silverstack	XT	and	Silverstack	Lab	offer	functionality	to	manually	sync	audio	clips	to	video	clips.

Basic	Principles:	Audio	Sync	with	Slate	Markers
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The	process	of	manually	syncing	audio	in	Silverstack	is	divided	into	two	basic	steps:	matching	the	according	audio
clip	to	a	video	clip,	and	subsequently	syncing	the	audio	and	video	clip	at	the	right	position.

The	basic	idea	of	the	sync	at	the	right	position	bases	on	the	functionality	of	 setting	slate	markers	in	the	video	and
audio	clip.	By	setting	slate	markers	the	user	defines	a	sync	position	in	both	audio	and	video	to	be	used	to
link	the	audio	and	video	clips.	Silverstack	will	automatically	align	the	video	clip	and	the	according	audio	clip	at
the	specified	positions.

The	article	will	describe	in	detail	how	to	set	the	slate	markers	in	the	UI	of	Silverstack	to	attain	a	sync	at	the	intended
position	as	well	as	how	to	move	the	sync	position	if	needed.

The	counterpart	of	the	manual	sync	is	the	automatic	sync	based	on	timecode	that	is	available	in	Silverstack	Lab.	You
can	learn	more	about	automatic	audio	sync	in	Silverstack	Lab	in	the	article	“How	to	Automatically	Sync	Audio	Based
on	Timecode	in	Silverstack	Lab“.

Manual	Audio	Sync:	Step-by-Step

Overview

1.	 Have	all	needed	assets	available	in	the	Silverstack	Library	(audio	and	video	clips	have	to	be	available	for
playback).

2.	 Open	the	video	clip	you	want	to	manually	sync	audio	in	the	Silverstack	player	and	go	to	the	frame	you	want	to
set	the	video	slate	marker	(e.g.	the	frame	where	the	slate	visually	closes).

3.	 Open	the	“Audio&Color”	panel	in	the	lower	center	of	the	UI	and	switch	to	the	audio	tab	(or	hit	the	“QC”	UI
Layout	button	in	the	toolbar).

4.	 Add	the	fitting	audio	clip	to	the	current	video	clip	by	clicking	the	“+”	button	in	the	upper	right	corner	of	the
audio	panel

5.	 Browse	to	the	position	of	the	audio	clip	you	want	to	set	the	audio	slate	marker	and	hit	the	“Slate	a+v:	Video	+
Audio”	button	to	set	the	slate	in	the	video	and	the	audio	at	the	current	position	of	the	playheads.

6.	 Click	“Add	Clip”	to	add	the	audio	clip	as	external	audio	to	the	video	clip	and	sync	at	the	position	of	the	slate
markers.

Please	note:	You	can	also	set	audio	and	video	slate	markers	independently	and	in	any	order.

In	Detail

1.	Register	All	Needed	Assets	in	the	Silverstack	Library

Make	sure	to	have	the	video	clips	and	their	according	audio	clips	registered	in	the	Silverstack	Library.	Learn	about
audio	clips	in	Silverstack	in	the	article	Audio	Clips	in	Silverstack.

2.	Open	the	Video	Clip	You	Want	to	Manually	Sync	Audio	With
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Fig.1:	The	video	clip	at	the	slate	position.

Move	the	video	clip	to	the	frame	the	slate	goes	down.	If	no	slate	is	present	you	can	choose	any	other	significant
position	you	want	to	sync	to.

In	this	example	the	slate	will	be	set	in	the	next	steps	together	with	the	audio	slate.	It	is	also	possible	to	already	set
the	video	slate	at	this	point.	Read	more	about	“Relocating	Slate	Markers”	in	the	according	section	below.

3.	Open	The	“Audio&Color”	Panel	in	the	Lower	Center	of	the	UI

The	audio	panel	can	be	opened	by	clicking	the	“ Audio&Color”	button	on	the	right	side	of	the	toolbar.	Make	sure	to
show	the	audio	panel	(see	Fig.1).

The	right	configuration	for	adding	manual	audio	clips	can	also	be	achieved	by	clicking	the	 “QC”	UI	layout	button	in
the	toolbar	(you	can	learn	more	about	UI	layouts	in	the	article	“UI	Layouts:	Quick	Configurations	for	the	Silverstack
User	Interface“).

4.	Hit	The	“+”	Button	in	the	Upper	Right	Corner	of	the	Audio	Panel	to	Add	an	Audio	Clip

The	“+”	button	in	the	upper	right	corner	of	the	audio	panel	opens	a	popover	that	lets	you	select	an	audio	clip	that
should	be	added	to	the	video	clip:
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Fig.	2:	Choose	an	audio	clip	to	be	added

Fig.	3:	The	“Add	Audio	Clip”	popover	in	detail

Select	the	intended	audio	clip	from	the	“Audio	Clip”	dropdown.

Move	the	playhead	of	the	audio	clips	to	the	position	you	want	to	set	the	audio	slate	to.	Click	the	button	

	to	set	both,	the	audio	and	the	video	slate	at	the	position	of	the	according	playhead.
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The	button	 		will	set	a	slate	only	in	the	audio	clip.

Please	note	that	a	video	clip	that	has	an	external	audio	clip	assigned	to	it	will	in	any	case	contain	a	slate	marker.	If
the	slate	marker	is	not	specified	it	will	be	set	to	the	first	frame	of	the	video	clip	and	will	accordingly	be	used	as	the
sync	position.

6.Click	“Add	Clip”	to	add	the	audio	clip	as	external	audio

Now	click	“Add	Clip”.	The	specified	audio	clip	will	now	be	added	to	the	video	clip	and	all	tracks	will	now	be
available	in	the	audio	panel.	The	video	and	audio	clip	sync	at	their	slate	positions.

Fig.	4:	External	audio	in	the	audio	panel

Relocating	Slate	Markers

Audio

You	can	relocate	the	audio	slate	marker	for	an	external	audio	clip	by	opening	the	audio	tracks	playback	panel.	That

can	be	done	by	clicking	the	play	button	 	that	can	be	found	on	the	left	of	the	track	name	labels	in	the	audio	panel:
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Fig	5:	The	audio	tracks	panel	to	listen	to	a	single	audio	track

Move	the	detail	indicator	(red	box)	to	a	new	position	and	click	the	button	 	to	set	the	audio	slate	to
the	position	indicated	by	the	playhead	in	the	detail	view	at	the	bottom	right	of	the	popover.

Video

You	can	relocate	the	video	slate	marker	within	the	cue	points	section	of	the	User	Info	tab	of	the	right	bar:

Fig.5:	The	video	slate	marker	is	a	special	cue	point	in	the	cue	points	section

Move	the	playhead	of	the	video	clip	to	a	new	position	and	click	the	“set	video	slate”	button	 	in	the	cue	points
section	of	the	User	Info	tab.	Alternatively	you	can	use	the	shortcut	Ctrl	+	Cmd	+	Enter	to	set	the	video	slate
marker	at	the	current	position	of	the	playhead.
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Please	note	that	the	video	slate	marker	is	a	special	kind	of	cue	point.	You	can	remove	the	video	slate	marker	like
removing	a	cue	point.	In	case	of	external	audio	existing	you	will	not	be	able	to	remove	it	as	a	video	clip	will	with
external	audio	will	always	have	a	slate	marker.	Learn	more	about	cue	points	from	the	article	Metadata	Handling:
View,	Organize,	Add	and	Filter	Clips.

Removing	External	Audio	Clips

External	audio	clips	can	be	removed	by	clicking	on	the	gear	menu	in	the	header	bar	of	the	external	audio	clip:

Fig.	6:	Remove	an	audio	clip	from	from	inside	the	gear	menu

Remove:	Removes	the	audio	clip	attached	to	the	video	clip.
Reveal:	Reveals	the	audio	clip	in	its	audio	bin
Mid/Side:	Select	the	channels	that	should	be	used	for	mid/side	stereophony

Audible	Frame	Stepping

When	stepping	through	a	video	clip	with	audio	frame	by	frame	with	the	arrow	keys	you	will	be	able	to	hear	audio
for	every	frame.
To	deactivate	audible	frame	stepping	go	to	the	“Playback”	menu	in	the	Main	Menu	and	deselect	“Audible
Frame	Stepping”

Transcoding	in	Silverstack	and	Silverstack	XT

Overview

The	transcoding	functionalities	of	Silverstack	have	been	updated	with	Silverstack	6.	The	update	contains	a	faster
transcoding	engine,	an	updated	user	interface,	more	transcoding	options	and	a	lot	more	(details	below).

Silverstack	separates	the	configuration	of	the	transcoding	settings	from	the	actual	starting	of	a	transcoding	job:

The	section	“Transcoding	Configurations”	will	explain	how	to	adjust	the	settings	for	your	transcoding
job.
The	section	“Starting	a	Transcoding	Job”		will	explain	how	to	execute	a	transcoding	job.

Transcoding	Configurations	*

Silverstack	XT	offers	multiple	custom	transcoding	configurations	while	Silverstack	offers	one	custom	transcoding
configuration.

The	transcoding	settings	can	be	found	in	the	transcoding	tab	of	the	right	bar.	Click	the	transcoding	icon	 	to	access
the	transcoding	tab:
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Fig.	1:	Configure	the	transcoding	settings	in	the	transcoding	tab	of	the	right	bar

The	upper	part	of	the	transcoding	tab	shows	the	custom	transcoding	configurations.	The	lower	part	shows	the
detailed	settings	for	the	selected	configuration.	The	settings	will	be	applied	and	stored	to	the	configurations
immediately.

Locking	Transcoding	Configurations

Fig.2:	Locking	transcoding	configurations
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Transcoding	configurations	can	be	locked	to	avoid	changes	to	them	by	clicking	the	lock	icon	on	the	right	side	of	the
“Settings”	header	bar.	Locked	configurations	will	be	shown	with	a	white	lock	icon	in	the	table*.

Transcoding	Settings

Audio	&	Video

Video

Codec:	Select	the	output	codec	depending	on	your	requirements.	There	are	different	options	available	(also
shown	in	Fig.	3):

H.264	(Quicktime	Container)
H.265	/	HEVC	(Quicktime	Container,	available	starting	from	macOS	10.13)
ProRes	4444
ProRes	422
ProRes	422	(HQ)
ProRes	422	(Proxy)

Fig.	3:	Available	transcoding	options

Container:	Select	the	container	for	the	file.	The	following	options	are	available:
Quicktime	(.mov):	Available	for	all	codecs		(ProRes,	H.264,	HEVC)
MP4	(.MP4):	Available	for	H.264	and	HEVC	codecs.

Size	(for	H.264	and	ProRes):	This	drop	down	menu	allows	you	to	select	the	final	resolution	of	the
transcoded	clips:

Fig.	4:	Available	frame	sizes

H.264	Bitrate	Options:	
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Fig.	4b:	The	H.264	bitrate	calculator

The	H.264	manual	bitrate	options	allow	you	to	enter	a	specific	bitrate	in	the	textfield	or	provide	help	for	a
choice	of	quality	in	the	“H.264	bitrate	calculator”	(see	fig.	4b).

The	bitrate	calculator	lets	you	choose	the	intended	quality	from	“poor”	through	“good”	to	“best” 	and	calculates
the	resulting	bitrate	based	on	the	selected	resolution	and	the	intended	frame	rate.

Duration	(Limit	to	In/Out	points):	By	enabling	this	option	Silverstack	only	transcodes	the	part	of	the	clip
between	the	in	and	out	points	set	in	the	library.

Audio

Tick	the	checkbox	to	include	audio	in	your	transcoded	clips.

Format:
Linear	PCM
ACC	–	Good	Quality	**
ACC	–	High	Quality	**

Channel	Layout:
Stereo	Mixdown:	The	custom	audio	mix	created	in	the	audio	panel

Source

Choose	different	decoding	options	for	the	source	formats:

ARRIRAW:
1/2	resolution
Full	resolution

SONY	RAW
1/4	resolution
1/2	resolution
Full	resolution
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REDCODE	RAW
1/8	resolution
1/4	resolution
1/2	resolution
Full	resolution

Canon	RAW
Quality:

Full	Resolution
1/2	Resolution
1/4	Resolution

Debayer	Mode:
High	Speed
High	Quality

AVC-Intra	/	XAVC
1/2	resolution
Full	resolution

ProRes
1/4	resolution
1/2	resolution
Full	resolution

Panasonic	V-RAW
Soft	(GPU)
Default	(GPU)
AHD	(CPU)

Phantom	Cine
Soft	(GPU)
Default	(GPU)
AHD	(CPU)

Cinema	DNG
Soft	(GPU)
Default	(GPU)
AHD	(CPU)

Blackmagic	RAW
1/8	resolution
1/4	resolution
1/2	resolution
Full	resolution

Compositing

Resizing:
	Fitting	Strategy:

The	zoom	to	fit	(Adding	black	bars/Without	black	bars)	option	will	adjust	the	horizontal
resolution	of	the	clip	to	fit	in	the	selected	final	size.
Zoom	to	fill	will	affect	the	vertical	resolution	of	the	footage	to	the	final	size,	cropping	the	sides.
1	to	1	will	zoom	the	footage	to	100%	in	the	center	of	the	image	to	adjust	to	the	final	selected	size,
cropping	everything	else.
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Fig.	5:	resizing	example	results

Grading:	
Look	Source:	Choose	how	to	manage	the	color	data	for	the	clip:

As	set	in	Library:	enable	this	setting	to	include	the	looks	applied	to	the	clip	in	the	Library.	For
more	information	on	how	to	apply	looks,	please	check	the	article	The	Silverstack	Look	Library.
None:	Disables	the	color	processing	and	transcodes	the	clips	unmodified	(as	recorded).
From	file:	Reads	the	clip	metadata	and	applies	the	color	processing	described	in	the	embedded
looks.	In	case	there	is	no	look	embedded,	Silverstack	applies	the	default	Log	to	Rec.709	conversion
for	the	specific	format.

Overlays

Burn	Ins:	Choose	from	two	different	options	to	burn	into	the	transcoded	clip:

Fig.	6:	Burn	in	options

Burn	in	Parameters:	The	following	parameters	can	be	adjusted	for	the	burn	ins:
Margins:	A	horizontal	and	vertical	margin	to	position	the	burn	ins	in	the	frame.
Font:	Sets	the	font	style	for	the	burn	ins.
Font	Size:	Sets	the	font	size	in	pt.
Transparency:	Sets	the	transparency	level	for	the	burn	ins.
Text	Color:	Sets	the	text	color	to	“White”	or	“Black”
Background:	Sets	the	background	to	a	“Box”	shape,	adds	an	“Outline”	to	the	text	or	with	“None”
adds	no	background.

Image	Overlay:	Choose	an	image	overlay	(.png,	.jpg,	.tiff)	to	be	burned	into	the	transcoded	clips.

	Image	Overlay	Parameters:
Size:	Sets	the	size	of	the	image	(0	-100	%)
Position	X:	Sets	the	position	in	horizontal	direction
Position	Y:	Sets	the	position	in	vertical	direction
Transparency:	Sets	the	transparence	(0	–	100	%)

The	Transcoding	Preview

When	the	transcoding	tab	in	the	right	bar	is	showing	Silverstack	automatically	switches	to	a	transcoding	preview	to
be	shown	in	the	playback	view:
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Fig.	7:	The	transcoding	preview

The	transcoding	preview	displays	a	preview	of	the	transcoding	configurations	applied	to	the	currently	selected	clip.

Starting	a	Transcoding	Job

The	«Transcode»	button

In	order	to	start	transcoding	the	clips,	first	select	a	folder	or	bin	in	the	Library	panel.	Then	click	on	Transcode	to
open	the	wizard.	There	you	will	be	able	to	select	the	clips	you	want	to	transcode.	Click	on	continue	to	select	the
destination	and	transcode	settings.
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Fig.	8:	clip	selection	wizard

Now	you	are	able	to	select	where	the	transcoded	clips	will	be	stored.	You	can	add	and	remove	destinations	by	using
the	«+»	and	«-»	buttons.	Alternatively,	it’s	also	possible	to	modify	each	destination	path	and	path	wildcards.	You
can	select	from	the	configurations	previously	configured	in	the	transcoding	configurations	tab:

Fig.	9:	The	transcoding	destination	step

Click	the	current	configuration	to	open	the	list	of	all	available	transcoding	configurations:
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Fig.	10:	The	transcoding	configurations	dropdown

When	the	checkbox	“Add	to	Library”	is	checked	the	transcoded	clips	will	automatically	be	ingested	into	the
Silverstack	Library	after	the	transcoding	job	is	done.	Transcoding	statistics	will	be	available	for	the	clips	in	the
statistics	view.

Click	“Start	Render	Job”	to	start	the	render	job.	It	can	then	be	traced	in	the	jobs	panel.

Path	Wildcards	for	Transcode	Destinations

Path	Wildcards	can	be	used	to	customize	the	transcoding	path	with	available	metadata.	Click	the	 “Path	wildcard”
icon	in	the	status	bar	(see	fig.	13)	to	access	the	path	wildcards	settings	for	the	selected	destination:
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Fig.	11:	The	path	wildcard	window

It	is	also	possible	to	rename	the	transcoded	clips	by	leaving	out	the	“/”	and	optionally	also	adding	a	file
extension.	Here’s	an	example:

Fig.	12:	Path	wildcards	for	transcoding	destinations

Hint:	It	is	also	possible	to	copy	and	paste	path	wildcards	like	plain	text.

Multi	Destination	Transcoding*

Silverstack	XT	is	able	to	transcode	to	multiple	destination	formats	at	a	time.	In	certain	cases	(see	below),	the
transcoding	of	the	configurations	has	to	be	run	sequentially.	The	transcoding	wizard	will	give	you	a	hint	if	the
transcoding	will	be	run	in	parallel	or	sequentially:

Fig.	13	:	The	info	message	about	parallel	or	sequential	transcoding

In	case	of	sequential	transcoding	you	can	open	theWildcards	for	Transcodes	panel	to	get	details	about	the
transcoding	order.

The	following	settings	can	influence	the	parallel	execution	of	the	transcoding	job:

In/Out	Points
Debayer	settings
Decoding	resolution

Make	sure	to	set	the	above	settings	to	the	same	value	when	transcoding	to	two	different	configurations	to	avoid
sequential	transcoding.

Management	of	Transcoding	and	Offload	Jobs

Silverstack	Lab	is	generally	able	to	transcode	and	copy	at	the	same	time.	Transcoding	jobs	as	well	as	copy	jobs	run
in	the	background	while	the	app	is	still	fully	accessible.

Optionally	you	can	choose	to	pause	transcoding	jobs	when	offloading	and	while	playing	back	clips.	To	do	so	go	to
the	“Copy&Jobs”	tab	in	the	Preferences	and	select	the	according	checkbox	 “Automatically	Interrupt
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Transcoding	Jobs	during	Playback	and	Offload”:

Fig.	14:	The	“Copy&Jobs”	tab	in	the	preferences

Transcoding	Functionalities	Overview	for	Silverstack	and	Silverstack	XT

The	transcoding	functionalities	of	Silverstack	have	been	updated	with	version	6.	Silverstack	and	Silverstack	XT
come	with	a	different	set	of	functionalities	concerning	Transcoding.

Silverstack	
Single	destination	transcoding
One	custom	transcoding	preset
Timecode	and	Clip	Name	burn	in	options
Watermarking
Transcoding	resolution	up	to	full	HD	(1920	x	1080)
Stereo	mixdown	audio	channel	layout	for	transcoded	clip

Silverstack	XT
Multi	destination	transcoding
Many	custom	transcoding	preset
Timecode	and	Clip	Name	burn	in	options
Watermarking
Transcoding	resolutions	higher	than	Full	HD	(1920	x	1080)
Stereo	mixdown	audio	channel	layout	for	transcoded	clip
Transcoding	statistics

*	Silverstack	XT	only

**Only	available	for	ProRes	and	H.264
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UI	Layouts:	Quick	Configurations	for	the	Silverstack	User	Interface

Silverstack	comes	with	3	to	4	options	*	to	automatically	configure	the	user	interface	in	a	steadily	defined	way.	Like
this	you	will	be	able	to	switch	to	a	certain	UI	configuration	that	is	convenient	for	a	particular	task	with	one	click.

Accessing	the	UI	Layouts

The	UI	Layouts	include	the	following	configurations:

Manage
QC	(Quality	Control)
Color
Config	(Transcoding	Configurations)	*

The	UI	Layouts	can	be	configured	from	the	shortcut	buttons	on	the	right	side	of	the	Silverstack	toolbar:

Fig.	1:	The	UI	Layout	shortcut	buttons	in	the	toolbar

Alternatively	the	UI	Layouts	can	be	accessed	from	the	“Window”	menu:

Fig.	2:	The	UI	Layout	shortcuts	in	the	“Window”	menu

	UI	Layouts	with	One	Display

Manage:	Configures	the	UI	in	a	convenient	way	for	all	kinds	of	management	tasks.
Left	bar:	Shown	(Library)
Center:	Collection	View
Right	bar:	General	Info
Audio	&	Color	panel:	Hidden
Mini	Player:	Open

Fig.	3:	UI	Layout:	Manage
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QC	(Quality	Control):	Configures	the	UI	in	a	convenient	way	for	all	kinds	of	quality	control	tasks.
Left	bar:	Hidden
Center:	Player
Right	bar:	User	Info	tab
Audio	&	Color	Panel:	Audio

Fig.	4:	UI	Layout:	QC

Color:	Configures	the	UI	in	a	convenient	way	for	color	grading.
Left	bar:	Hidden
Center:	Player
Right	bar:	Look	Library
Audio	&	Color	Panel:	Color

Fig.	5:	UI	Layout:	Color
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Config	(Transcoding	Configurations)*:	Configures	the	UI	in	a	convenient	way	for	adjusting	transcoding
configurations.

Left	bar:	Hidden
Center:	Transcoding	Preview
Right	bar:	Transcoding	configurations
Audio	&	Color	Panel:	Hidden

Fig.	6:	UI	Layout:	Config

UI	Layouts	with	Two	Displays

The	UI	Layouts	establish	different	configurations	of	the	user	interface	when	the	second	display	is	activated.

Please	refer	to	the	article	Second	Display:	Two	Screen	Working	Environment	for	more	information	about	using	a
second	display	for	the	Silverstack	UI.

*UI	Layout	“Config”	(Transcoding	Configurations)	only	available	in	Silverstack	Lab.

Second	Display:	Two	Screen	Working	Environment	in	Silverstack

Silverstack	XT	and	Silverstack	Lab	offer	the	possibility	to	extend	the	Silverstack	user	interface	to	two	screens.

Accessing	the	Second	Display

When	a	second	display	is	attached	to	your	machine	the	“Second	Display”	button	in	the	toolbar	shows	up:

Fig.	1:	The	“Second	Display”	button	in	the	toolbar

By	clicking	the	button	you	can	toggle	the	user	interface	to	be	shown	on	the	second	screen	on	and	off.

Alternatively	the	UI	on	the	second	display	can	be	enabled	from	the	“Window”	menu.	Set	a	checkmark	to	the	entry
“Second	Display”	to	activate	it.

Second	Display	User	Interface	Options

The	second	display	opens	automatically	on	the	screen	that	does	not	hold	the	Silverstack	main	window.
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There	are	3	content	options	for	the	second	display:

List	View	of	clips

Fig.	2:	The	List	View	on	the	Second	Display

Collection	View	of	clips

Fig.	3:	The	Collection	View	on	the	Second	Display

Player	View
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Fig.	4:	The	Player	View	on	the	Second	Display

Silverstack	automatically	adapts	the	interface	to	avoid	a	simultaneous	display	of	the	same	element	(List	View,
Collection	View,	Player	View)	in	both	the	main	window	and	the	second	screen.	When	an	element	is	accessed	that	is
already	shown	in	the	other	display	it	is	automatically	flipped	with	the	previously	shown	element	on	the	first	screen.

Transfer	of	Project	Settings

Silverstack	allows	to	export	and	import	project	settings	to	transfer	them	to	new	projects	or	different	machines.	This
can	e.g.	help	to	move	project	settings	from	established	projects	to	new	projects	to	avoid	setting	up	from	scratch.
Other	use	cases	involve	the	transfer	of	transcoding	configurations	from	Silverstack	XT	or	Lab	to	new	projects	or
other	machines.

Which	Settings	Can	Be	Transferred	?

The	settings	transfer	involves	certain	project	based	settings	as	well	as	global	settings.	Find	the	settings	that	can	be
transferred	below.

Project	settings:

Folder	Structure
Smart	Folders
Transcoding	Configurations
Copy	Job	Templates

Global	settings:

Table	View	Presets
Format	Options

Export	and	Import	of	Project	Settings

To	export	or	import	project	settings	go	to	the	Silverstack	Main	Menu	and	select	 “File	>	Project	Settings	>
Export…	/	Import…”:
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Fig.	1:	Export	and	Import	of	Project	Settings

You	can	choose	the	content	to	be	exported	after	clicking	on	 “Export…”:

Fig.	2:	Export	project	settings	options

Here	are	the	details	about	the	different	export	options:

Project	settings:

Folder	Structure:	Transfer	the	folder	structure	of	your	Silverstack	library	to	a	new	project.	All	top	level
folders	can	be	selected	for	the	export.
Smart	Folders:	Transfer	your	custom	smart	folders	to	a	new	project.
Transcoding	Configurations:	Transfer	your	custom	transcoding	configurations	to	a	new	project*
Copy	Job	Templates:	Transfer	your	custom	copy	job	templates	saved	in	the	offload	wizard	to	a	new	project.

Global	settings:

Table	View	Presets:	Transfer	your	table	view	presets	(of	the	main	table	of	clips	and	metadata)	to	a	new
project.
Format	Options:	Transfer	the	settings	of	the	“Format	Options”	in	the	Silverstack	preferences	to	a	new
project.
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Fig.	3:	Example	of	the	project	settings	export	wizard	including	folders	and	transcoding	configurations

Click	“Export”	to	save	the	.psconfig	(project	settings	configurations)	file	containing	the	project	settings
information	to	the	selected	destination.

The	export	and	import	settings	windows	are	symmetrical	hence	you	can	choose	which	content	to	write	to	the
.psconfig	file	as	well	as	which	content	to	import	from	a	.psconfig	file.

Fig.	4:	Example	of	the	project	settings	import	window

Setting	a	Default	Template	for	New	Projects

Additionally	to	the	export	and	import	of	project	settings	you	can	define	a	.psconfig	file	that	should	be	used	as	a
template	to	create	new	projects.
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First	export	a	project	settings	file	as	described	above	and	include	all	the	settings	the	default	template	for	new
projects	should	contain.

Then	go	to	the	Silverstack	preferences	by	choosing	“Silverstack/Silverstack	Lab	>	Preferences…”	in	the	Main
Menu.

In	the	“General”	tab	of	the	preferences	you	can	click	“Choose…”		to	select	the	default	.psconfig	file	for	new
projects:

Fig.	5:	Choose	the	.psconfig	file	the	default	project	settings	for	new	projects	should	be	loaded	from.

When	you	now	create	a	new	project	in	the	toolbar	or	from	the	 “File”	menu	(“File	>	New	Project…”)	all	contents
of	the	selected	.psconfig	file	will	be	loaded	as	default	for	the	new	project.

Additionally	to	the	manual	process	of	loading	the	default	.psconfig	file	in	the	preferences	you	can	copy	a	.psconfig
file	named	“defaults.psconfig”	to	the	library	folder	to	be	taken	as	the	default	template:

For	Silverstack	6:	~/Library/Application	Support/Pomfort/Silverstack6

For	Silverstack	Lab	6:	~/Library/Application	Support/Pomfort/SilverstackLab6

Attention:	Please	be	aware	that	the	.psconfig	file	in	this	location	will	overrule	the	UI	settings.

The	.psconfig	files	are	generally	compatible	throughout	the	different	Silverstack	versions	Silverstack,	Silverstack	XT
and	Silverstack	Lab.	Please	be	aware	though,	when	importing	transcoding	configurations	from	Silverstack	Lab	into
Silverstack	XT	that	restrictions	due	to	incompatible	features	such	as	e.g.	DNx	transcoding	only	available	in
Silverstack	Lab	might	apply.
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*Only	available	for	Silverstack	XT	and	Silverstack	Lab	as	the	basic	version	of	Silverstack	does	not	support	custom
transcoding	configurations.

Crop	Clips

Silverstack	allows	to	crop	clips	to	a	custom	aspect	ratio.	Cropping	is	non-destructive	as	long	a	crop	setting	is	not
used	for	transcoding.

Cropping	can	be	set	via	the	“Crop”	popover	in	the	General	Info	tab	on	the	right	side	of	the	main	window.	Learn	more
about	the	right	sidebar	in	the	article	The	Information	Panel.

Crop	Clips	to	a	Custom	Aspect	Ratio

Go	to	the	“General	Info”	Tab	and	scroll	down	to	the	“Processing”	section	where	you	can	find	the	“Crop”	entry.

Fig.	1:	Crop	in	the	Processing	section

Click	the	little	grey	button	with	the	pencil	to	open	the	popover:

Fig.	2:	The	Crop	popover	in	the	General	Info

Crop	Options

There	are	3	tabs	and	therefore	2	crop	options	available:

Selecting	“None”	and	clicking	“Apply”	will	make	sure	to	remove	all	crop	settings	from	the	selected	clip.
Crop	to	an	Aspect	Ratio
Crop	to	a	Custom	Resolution

Crop	to	an	Aspect	Ratio

76

Silverstack	6	Manual	
Clip	Library

https://kb.pomfort.com/?p=1764
https://kb.pomfort.com/wp-content/uploads/2018/01/Screen-Shot-2018-01-16-at-17.17.32.png
https://kb.pomfort.com/wp-content/uploads/2018/12/Screen-Shot-2018-12-10-at-13.33.05.png


Fig.3

Select	the	second	tab	“Aspect	Ratio”	and	enter	a	custom	aspect	ratio	into	the	combo	box	or	select	one	from	the	list	of
presets.

Crop	to	a	Custom	Resolution

Fig.4

Select	the	third	tab	“Custom	Resolution”.

The	following	controls	are	available:

1.	 Size:	You	can	enter	a	custom	pixel	resolution	to	crop	to.	The	specified	pixel	resolution	will	be	cropped	out	by
default	from	the	center	of	the	image.

2.	 Aspect	Lock:	You	can	lock	the	resolution	to	a	certain	ratio	when	changing	horizontal	or	vertical	size.
3.	 Recents:	The	gear	menu	shows	recently	used	sizes	for	a	quick	selection
4.	 Offset:	Specify	a	horizontal	and	vertical	offset	from	the	center	cropped	size
5.	 Quick	Offset	Buttons	&	Re-Center:	The	quick	offset	arrow	keys	enable	a	one-click	shift	of	the	cropped

area	to	the	respective	image	margins.	If	an	offset	is	entered	the	“0”	button	appears	and	helps	to	remove	the
offset	to	re-center	the	cropped	area.

6.	 px/%	Switch:	You	can	switch	between	specifying	an	custom	crop	resolution	in	pixels	or	percentage	values.

Click	“Apply”	to	crop	the	current	image	to	the	specified	crop.

Source	and	Resulting	Resolution

The	“Source	Resolution”	and	“Resulting	Resolution”	give	you	information	about	the	original	and	the
resulting	image	resolution:

“Source	Resolution”:	Native	resolution	of	the	clip.	Also	displayed	in	the	General	Info	in	the	right	tab	under
“Format	->	Resolution”
“Resulting	Resolution”:	The	cropped	and/or	desqueezed	resolution.

The	factors	relevant	for	the	calculation	of	the	Resulting	Resolution	are	displayed	below	(e.g.	“Desqueeze
(2.0)	and	Crop”).
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The	resulting	percentage	of	the	original	image	is	displayed	in	brackets.	The	resulting	aspect	ratio	follows.

Please	be	aware	that	the	decoding	resolutions	of	the	player	do	not	affect	the	calculations	of	resolutions	in	the	“Crop”
popover.

Highlighting	of	Cropped	Area	in	the	Playback	View

While	setting	the	crop	in	the	popover	the	area	that	will	be	cropped	is	highlighted	in	the	playback	view	and	updates
live	while	changing	crop	settings.

Fig	5:	The	crop	area	shows	in	the	image

Apply	Crop	to	Multiple	Clips

To	apply	a	crop	to	two	or	more	clips	select	multiple	clips	from	the	table	view	and	open	the	“Crop”	popover:

Fig.	6:	Multi	edit	for	crop

The	number	of	altered	clips	is	displayed	in	the	popover	(see	“Will	edit	4	Clips”	in	Fig.	6)	.	Click	“Apply”	to	apply	the
set	crop	factor	to	all	selected	clips.

Tags:	crop,	multi	edit,	multiedit,	aspect	ratio,	custom	resolution

Extracting	LTC	from	Internal	Audio	in	Silverstack	and	Silverstack	Lab

Linear	(or	Longitudinal)	timecode	(LTC)	is	an	encoding	of	SMPTE	timecode	data	in	an	audio	signal.

The	process	of	feeding	LTC	into	the	audio	channel	of	a	camera	from	external	sources	(such	as	timecode	devices),	is
often	used	for	cameras	that	either	cannot	handle	external	TC	sync	and/or	do	not	provide	proper	timecode	to	the
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recorded	clips.	It	offers	the	possibility	to	include	such	cameras	in	a	workflow	that	requires	synchronous	timecode.

The	timecode	data	existing	in	internal	audio	tracks	of	video	clips	can	be	extracted	in	Silverstack	and	Silverstack	Lab
to	be	applied	to	the	metadata	of	the	video	clip.	This	enables	subsequent	processes	that	leverage	timecode,	such	as
e.g.	providing	detailed	clip	metadata	for	editing,	transcoding	clips	with	embedded	timecode	metadata,	creating
detailed	clip	reports	or	automatic	audio	sync	based	on	timecode.

How	to	Extract	LTC	and	Apply	it	to	Clips

To	extract	LTC	in	Silverstack	first	make	sure	to	ingest	all	clips	with	LTC	into	the	Silverstack	library.

Choose	the	bin	or	folder	containing	the	LTC	clips	and	from	the	“Media”	button	menu	in	the	toolbar	choose
“Extract	LTC”:

Fig.	1:	Extract	LTC	in	the	“Media”	menu

A	wizard	window	opens	that	immediately	extracts	LTC	for	all	selected	clips:

Fig.2:	The	LTC	wizard	finished	the	extraction	of	LTC	for	all	selected	clips

The	following	information	is	visible	to	the	user	in	the	wizard:

Selected	clip	and	audio	information
Original	Clip	TC
Extraction	status	with	channel	information
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Extracted	LTC	and	fps	of	LTC	info

Silverstack	attempts	to	read	the	LTC	at	the	beginning	of	a	clip.	If	no	LTC	is	found	the	application	iterates	into	the
clip’s	timespan	in	several	steps	searching	for	an	LTC	in	the	whole	clip.	This	also	indicates	that	an	LTC	only	has	to
exist	for	the	beginning	of	a	clip	to	be	read	out	properly.

By	checking	the	“Mute	LTC	Channels”	checkbox	you	can	make	sure	that	after	applying	the	LTC	timecode	to	the
clips	the	channels	with	LTC	will	become	muted	in	Silverstack.

Click	“Apply	TC”	to	replace	the	Clip	TC	with	the	extracted	LTC.

Please	be	aware	that	the	process	of	applying	the	extracted	LTC	to	the	clip	is	not	reversible	and	cannot	be	undone.
Once	you	have	taken	over	the	extracted	LTC	to	the	clip	you	cannot	go	back	to	the	original	TC	from	the	clip.

After	taking	over	the	extracted	LTC	to	the	clips	each	clips	will	have	the	regular	 “TC	Start”	and	“TC	End”	in	the
General	Info	metadata	on	the	right	and	in	the	table	view:

Fig.	3:	The	extracted	LTC	now	is	handled	as	the	regular	Clip	TC	in	the	Silverstack	library

Now	the	timecode	can	be	used	for	all	subsequent	task	that	involve	the	need	of	timecode	for	clips	like	e.g.	
transcoding	or	automatic	audio	sync	based	on	timecode.
.	Learn	more	about	it	in	the	article	How	to	Automatically	Sync	Audio	based	on	Timecode	in	Silverstack	Lab.

Error	Cases	and	Troubleshooting	when	Extracting	LTC

When	extracting	LTC	from	video	clips	there	are	different	possible	error	cases	that	are	displayed	in	the	LTC
extraction	wizard:

Fig.	4:	The	LTC	extraction	wizard	with	error	messages

The	“Extraction	Status”	column	gives	you	insights	about	the	following	error	cases:

“No	LTC	track	found”:		No	LTC	track	was	found	for	the	clip.	Check	the	clips	audio	in	the	audio	tab	of	the
“Audio&Color”	panel.
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“Type	mismatch”:	The	fps	of	the	LTC	do	not	fit	the	LTC	of	the	clip	and	the	clip	TC	can	therefore	not	be
calculated	correctly.	This	could	especially	become	a	problem	with	certain	DSLR	camera	types	that	display
24fps	as	user	selection	in	the	menu	but	record	in	23.976fps.	Make	sure	clip	TC	and	LTC	match	for	a	proper
extraction.
“Clip	offline”:	Clip	is	offline.	Bring	clips	online	to	extract	LTC.
“Extraction	error”:	An	unknown	extraction	error	occurred.
“Clip	has	no	audio”:	The	clip	has	no	audio.		Check	the	clips	audio	in	the	audio	tab	of	the	 “Audio&Color”
panel.

Please	be	aware	that	LTC	in	the	audio	track	does	usually	not	survive	compressed	codecs	such	as	e.g.	MP3.

As	the	drop	flag	only	affects	the	way	of	counting	timecode	and	not	its	actual	speed	it	is	possible	to	apply	drop-frame
LTC	on	non-drop	clips	and	vice	versa.

As	the	bounds	of	an	image	frame	are	not	necessarily	the	bounds	of	an	LTC-audio	frame,	an	error	of	up	to	a	half
frame	can	accumulate	when	synchronizing	audio	to	LTC.

Dynamic	Metadata

Silverstack	XT	and	Silverstack	Lab	come	with	a	“Dynamic	Metadata”	panel	that	allows	to	extract	dynamic
metadata	for	supported	clip	formats.		Dynamic	metadata	refers	to	certain	metadata	information	that	changes	over
the	time	span	of	a	clip	(e.g.	like	TC	which	can	also	be	considered	dynamic).	It	is	stored	differently	in	diverse	formats
and	therefore	needs	a	special	process	to	be	accessed.

Fig.	1:	The	dynamic	metadata	panel	in	the	upper	left	corner	of	the	Silverstack	UI

Supported	Clip	Formats

The	following	clip	formats	are	currently	supported	for	the	extraction	of	dynamic	metadata	in	Silverstack	XT	and
Lab:

ARRIRAW	(.ari	sequences	and	in	.mxf	container)
ARRI	Prores
REDRAW
SONY	XAVC
SONY	X-OCN
SONY	RAW

Available	Dynamic	Metadata

The	main	part	of	dynamic	metadata	is	dynamic	lens	metadata:

Focal	Length
Aperture	(T-Stop)
Focus	Distance

For	ARRI	ProRes	and	ARRIRAW	clips	Silverstack	XT	and	Lab	also	support:

Camera	Tilt
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Camera	Roll

How	to	Extract	Dynamic	Metadata

Select	the	third	icon	displaying	a	horse	in	the	left	sidebar	above	the	library	(see	fig.	1)

To	extract	dynamic	metadata	for	the	selected	clip	press	the	“Extract	Dynamic	Metadata”	button	in	the	middle	of	the
dynamic	metadata	panel.

You	can	start	the	extraction	of	dynamic	metadata	for	multiple	clips	by	selecting	an	entry	from	the	gear	menu	in	the
toolbar:

Fig.	2:	Extract	dynamic	metadata	for	multiple	clips

The	extraction	process	for	all	clips	can	be	monitored	in	the	popover	that	reveals	the	current	extraction	state	for	every
started	clip:

Fig.3:	Extracting	dynamic	metadata	from	multiple	clips

After	a	successful	extraction	the	dynamic	metadata	panel	reveals	the	extracted	dynamic	lens	and	camera	metadata:
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Fig.	4:	The	dynamic	metadata	panel	with	successfully	extracted	metadata

The	metadata	can	now	be	inspected	during	playback	or	while	scrubbing	through	a	clip.

For	completeness	concerning	lens	metadata	three	additional	static	fields	have	been	added	to	the	lower	section	of	the
panel:

Lens
Filter
ND	Filter

They	mirror	data	from	the	library	and	can	also	be	edited	in	the	General	Info	of	the	right	sidebar.

Using	Extracted	Dynamic	Metadata	for	Reports

For	clips	that	support	the	extraction	of	dynamic	metadata	Silverstack	extracts	the	dynamic	metadata	of	the	first
frame	already	on	ingest.	That	also	allows	Silverstack	users	to	benefit	from	the	dynamic	metadata	functionality	and
receive	lens	and	other	dynamic	metadata	for	the	first	frame.

The	additional	lens	fields	can	be	exported	to	clips	reports	to	enhance	their	information.

Silverstack	XT	and	Silverstack	Lab	provide	an	extended	functionality	to	leverage	the	dynamic	metadata	for	generic
clips	reporting.

In	the	“Projects”	preferences	it	is	possible	to	make	sure	that	the	static	representation	of	the	extracted	dynamic
metadata,	that	is	used	for	the	General	info	and	table	view	library,	follows	the	thumbnail	frame:

Fig.	5:	Using	the	extracted	dynamic	metadata	of	the	thumbnail	frame	for	reports

Like	this	you	can	make	sure	that	the	metadata	that	is	referenced	in	the	reports	goes	along	with	the	shown	thumbnail.

The	focus	distance	unit	can	also	be	changed	at	the	same	position	and	allows	to	choose	the	display	of	the	focal	length
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in	the	dynamic	metadata	panel	and	the	General	Info	to	be	imperial	(inches/feet)	or	metric	(millimeters/meters).

Dynamic	Metadata	Burn	Ins

Silverstack	Lab	supports	the	functionality	of	adding	burn	ins	of	dynamic	lens	data	when	transcoding	clips.

A	“Dynamic	Lens	Info”	string	that	contains	focal	length,	aperture	and	focus	distance	can	be	selected	from	the
burn	in	options	to	be	transcoded	to	the	clips.

Editing	Keyboard	Shortcuts	in	Silverstack

There	are	a	variety	of	keyboard	shortcuts	available	for	commands	in	the	main	menu	of	Silverstack.	Shortcuts	can
help	greatly	in	boosting	your	productivity.

Many	shortcuts	are	already	predefined.	You	can	also	set	shortcuts	 for	selected	commands	 that	you	perform	quite
often	and	that	do	not	hold	default	shortcuts	in	order	to	memorize	the	interaction	with	Silverstack	more	easily.

To	inspect	the	exact	list	of	available	keyboard	shortcuts	go	to 	Silverstack	 >	Keyboard	 Shortcuts…	.	This	will
open	the	Keyboard	Shortcuts	Editor	(figure	1).

Figure	1:	The	Keyboard	Shortcut	Editor

Listing	and	Searching	Keyboard	Shortcuts

The	keyboard	shortcut	editor	shows	a	table	with	a	list	of	all	actions	in	the	main	menu	and	their	currently	set
keyboard	shortcut.	You	can	search	the	list	by	typing	into	the	search	bar	on	top	of	the	table.

Edit	Keyboard	Shortcuts

To	edit	a	keyboard	shortcut:

1.	Select	“Map	Keys”	to	allow	changes	on	the	key	mapping	list.

2.	Choose	the	row	with	the	command.

3.	To	set	or	modify	a	shortcut	press	the	key	or	keys	to	use	as	the	new	keyboard	shortcut.	You	can	use	modifiers,
numbers,	letters	and	characters	individually	or	in	combination.
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4.	To		remove	the	associated	shortcut	permanently	press	⌫	(delete	/	backspace)	button.

5.	Close	the	Edit	Keyboard	Shortcuts	window	when	you	are	done.

If	you	choose	a	shortcut	already	assigned	to	a	command,	a	warning	dialog	box	will	be	displayed	that	shows	which
command	already	used	the	chosen	shortcut.

Figure	2:	Alert	showing	used	keyboard	shortcut

Select	 “Cancel”	 and	 choose	 another	 key	 for	 your	 current	 command,	 or	 select	 “Reassign”	 which	 removes	 the
shortcut	from	the		old	command	and	sets	it	for	the	selected	command	(figure	2).

Restoring	Default	Keyboard	Shortcuts

You	can	reset	all	keyboard	shortcuts	to	latest	version	default	by	clicking	“Restore	Defaults…”.

Note	:	Both	of	these	steps	executes	an	automatic	restart.
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Offload	&	Backup

Parallel	Offloading

Offloading	is	the	process	of	adding	clips	from	a	camera,	field	recorder	or	storage	device	to	the	Silverstack	library	and
copy	them	onto	one	or	several	backup	disks.	In	order	to	make	it	possible	you	can	follow	this	directions:

Prepare	for	offloading

First	of	all	you	have	to	assign	clips	to	a	project.	You	can	select	a	project	or	a	folder	from	the	library	tree	in	the	left
panel	before	starting.	This	way	you	will	be	able	to	set	your	offload	destination	in	Silverstack’s	library.

A	new	bin	containing	the	offloaded	clips	will	be	created	inside	this	project.	It	will	have	the	same	name	as	the	source
volume	from	which	the	clips	have	been	offloaded.	If	the	current	selection	in	the	library	tree	is	a	bin,	a	new	bin	will	be
created	as	a	sibling	of	the	selected	one.

Starting	to	offload

figure	1:	offload	source	selection

After	mounting	the	camera	storage	that	you	want	to	offload,	you	have	several	options	to	achieve	that:

Click	on	the	“Offload”	icon	in	Silverstack’s	toolbar	and	select	the	volume	you	want	to	offload	from.

Choose	Library	>	“Offload”	from	the	Silverstack	menu.

Right	click	on	a	folder	in	the	library	tree	(left	panel)	and	choose	“Offload”	from	the	drop	down	menu.

Drag	the	folder	or	card	from	the	finder	to	Silverstack’s	icon	in	the	Dock	window.

Using	the	options	2	and	3	a	directory	browser	will	open	and	you’ll	need	to	select	the	volume	or	folder	you	want	to
offload	from.

Offload	Wizard

The	“Offload”	wizard	(figure	2)	will	try	to	detect	the	used	camera	automatically.	After	scanning	the	chosen	offload
device,	all	found	files	will	be	shown	in	a	table.	If,	in	an	exception,	Silverstack	should	not	choose	the	right	camera
format,	you	can	simply	change	that	by	clicking	on	the	camera	selection	button	(figure	2	#1).	The	import	options	for
the	multiple	camera	types	can	be	found	and	edited	in	the	application	preferences.

86

Silverstack	6	Manual	
Offload	&	Backup



figure	2:	selecting	clips	to	offload

By	default	Silverstack	will	offload	all	the	clips	and	sidecar	documents	contained	in	the	device	you	have	chosen.	To
edit	the	import	options,	click	on	the	«Edit»	button.	If	you	want	to	offload	only	a	subset	of	clips,	you	will	have	to
check	the	“Allow	partial	offload”	option	(figure	2	#2).	Clips	can	be	marked	and	unmarked	either	by	using	the	check-
boxes	or	the	mark	and	unmark	buttons	(figure	2	#3)	above	the	search	field.	Therefore	either	select	all	clips	you	want
to	import	and	then	click	on	“Mark	Only	Selected”	or	select	those	clips	of	all	already	marked	that	shall	not	be
imported	and	click	on	“Unmark	Selected”.

As	you	can	see	in	figure	3	there	is	a	bunch	of	keyboard	shortcuts	for	marking	(#1)	and	unmarking	(#2)	clips	to
facilitate	this	task.

figure	3:	marking	clips	to	offload

Silverstack	is	prospecting	for	duplicates	–	clips	already	existing	in	the	library	–	and	prevents	them	by	default	from
being	offloaded.	If	you	want	to	include	those	nonetheless,	mark	the	checkbox	“Allow	import	of	duplicates”	(figure	2
#4).

Sometimes	Silverstack	will	skip	some	hidden	files	and	empty	folders	as	in	figure	4.	If	you	click	“Learn	More”,	a
window	will	pop	up	showing	which	files	are	ignored.

87

Silverstack	6	Manual	
Offload	&	Backup



figure	4:	skipped	files	warning

You	are	able	modify	this	behavior	in	Silverstack’s	Ingest	preferences	menu.	In	addition	to	the	preferences	the
following	files	are	always	ignored:

–	Mac	OS	X	resource	fork	files	(starting	with	._)

–	MD	5	and	SHA	1	files	that	have	been	created	by	Silverstack

When	you	are	done	with	your	offload	source	choice,	you	can	proceed	to	select	the	copy	destinations.

Choosing	your	copy	destination

figure	5:	choosing	your	destination	and	copy	options

In	this	section	you	are	able	to	choose	the	HDDs	where	Silverstack	will	backup	the	clips	from	your	library.	To	edit	the
import	options,	click	on	the	«Edit»	button.	The	number	of	disks	that	can	be	copied	simultaneously	is	only	limited	by
your	hardware.	The	destination	is	defined	by	the	drive	itself	(figure	5	#1)	as	well	as	a	folder	on	that	drive.	Click	the
small	“	+	”	button	in	the	lower	left	of	the	table	(#2)	to	add	new	drives	or	folders.	Click	the	“	–	”	button	next	to	it	to
remove	the	selected	folder	or	drive.

To	optimize	the	way	your	files	are	stored	and	saved	on	the	destination	device,	there	is	the	possibility	of	using	 path
wildcards	(#3).	With	path	wildcards	Silverstack	allows	you	to	automatically	create	a	custom	folder	structure	for	your
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backups	based	on	the	offloaded	clips’	metadata.

If	you	just	want	to	create	references	to	video	clips	in	Silverstack’s	library	without	copying	those	clips	to	another
storage	device,	you	should	mark	the	“Skip”	checkbox	(#4).

More	copy	options	are	available	under	the	“More	options”	button	(#5):

Checksum	method:	select	the	method	used	for	verification	after	files	have	been	copied.	You	can	choose
between	multiple	checksum	methods	like	XXHash,	MD5,	SHA1	or	choose	to	do	only	file	size	verification	(faster
but	not	recommended).	You	can	learn	more	about	the	checksum	methods	in	Checksum	verification	methods.
Document	wildcard	handling:	modifies	Silverstack’s	behavior	with	non-clip	files	while	using	wildcards.	More
info	in	the	Use	of	Wildcards	article.
Overwrite	existing	files:	you	can	tell	Silverstack	to	overwrite	clips	if	they	already	exist	in	the	chosen	folder.
Source	Verification	on/off:	the	option	is	on	by	default,	meaning	that	during	the	verification	process	source	and
destination	are	read.	When	off,	only	the	destination	is	read,	giving	less	security	but	speeding	up	the	overall
copy	process.

After	determining	your	copy	destinations	click	on	“Backup	clips”	to	register	the	clips	in	the	library	and	start	the	copy
job.	All	the	information	about	the	offload	process	can	be	supervised	in	the	Jobs	panel	and	-with	less	detailed
information-	in	Silverstack’s	lower	bar.

Additionally,	Silverstack	offers	the	possibility	of	saving	offload	wizard	templates.	These	templates	can	be	chosen
through	the	drop	down	menu	shown	in	figure	5	#6.	For	more	information	about	the	offloading	templates,	please
check	the	article	Offload	wizard	templates.

Revert	to	the	legacy	Offload	Wizard

It’s	possible	to	use	the	classic	multi-step	offload	wizard	from	previous	Silverstack	version	by	modifying	the	settings
on	the	Preferences	menu.	On	the	«General»	tab	you	can	select	the	check	box	«Use	old	multi-step	Offload	Wizard»:

figure	6:	General	Preferences	menu

Cascading	Copy
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figure	1:	cascading	copy	setup

The	Cascading	Copy	offloading	mode	is	designed	to	free	up	camera	media	storage	as	fast	as	possible.	This	can
become	convenient	in	working	environments	with	small	amounts	of	camera	storage	devices	or	in	situations	with
only	one	docking	station	and	multiple	camera	storage	devices	have	to	be	offloaded.

Silverstack	makes	it	possible	by	offloading	the	camera	media	first	to	a	very	fast	destination	and	then	to	the	slower
backup	disks	from	the	first	fast	destination	with	a	single	job.	Once	the	first	step	of	the	process	is	finished,	the	camera
media	can	be	unmounted	and	is	ready	to	be	used	again	while	the	second	copy	step	is	being	performed.

Offload	Wizard

The	Offload	wizard	(figure	2)	will	try	to	detect	the	used	camera	automatically.	To	edit	the	import	options,	click	on
the	«Edit»	button.	After	scanning	the	chosen	offload	device,	all	found	files	will	be	shown	in	a	table.	If,	in	an
exception,	Silverstack	should	not	choose	the	right	camera	format,	you	can	simply	change	that	by	clicking	on	the
camera	selection	button	(figure	2	#1).	The	import	options	for	the	multiple	camera	types	can	be	found	and	edited	in
the	application	preferences.
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figure	2:	selecting	clips	to	offload

By	default	Silverstack	will	offload	all	the	clips	and	sidecar	documents	contained	in	the	device	you	have	chosen.	If	you
want	to	offload	only	a	subset	of	clips,	you	will	have	to	check	the	“Allow	partial	offload”	option	(figure	2	#2).	Clips
can	be	marked	and	unmarked	either	by	using	the	check-boxes	or	the	mark	and	unmark	buttons	(figure	2	#3)	above
the	search	field.	Therefore	either	select	all	clips	you	want	to	import	and	then	click	on	“Mark	Only	Selected”	or	select
those	clips	of	all	already	marked	that	shall	not	be	imported	and	click	on	“Unmark	Selected”.

Silverstack	is	prospecting	for	duplicates	–	clips	already	existing	in	the	library	–	and	prevents	them	by	default	from
being	offloaded.	If	you	want	to	include	those	nonetheless,	mark	the	checkbox	“Allow	import	of	duplicates”	(figure	2
#4).

Sometimes	Silverstack	will	skip	some	hidden	files	and	empty	folders	as	in	figure	3.	If	you	click	“Learn	More”,	a
window	will	pop	up	showing	which	files	are	ignored.

figure	3:	skipped	files	warning

You	are	able	modify	this	behavior	in	Silverstack’s	Ingest	preferences	menu.	In	addition	to	the	preferences	the
following	files	are	always	ignored:

Mac	OS	X	resource	fork	files	(starting	with	._)
MD	5	and	SHA	1	files	that	have	been	created	by	Silverstack

When	you	are	done	with	your	offload	source	choice,	you	can	proceed	to	select.
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Choosing	your	copy	destinations

figure	3:	cascading	copy	options

In	this	section	you	are	able	to	choose	the	destinations	where	Silverstack	will	backup	the	clips	from	your	library.	The
number	of	disks	that	can	be	copied	simultaneously	is	only	limited	by	your	hardware.	The	destination	is	defined	by
the	drive	itself	(figure	4	#1)	as	well	as	a	folder	on	that	drive.	Click	the	small	“	+	”	button	in	the	lower	left	of	the	table
(#2)	to	add	new	drives	or	folders.	Click	the	“	–	”	button	next	to	it	to	remove	the	selected	folder	or	drive.	Once	all	the
drives	have	been	added,	you	can	select	the	order	in	which	Silverstack	will	copy	the	clips	(#5).	If	«1st	Run»	is
selected,	the	files	will	be	copied	to	that	first	drive.	If	«2nd	Run»	is	selected,	the	files	will	be	copied	from	the	1st	Run
disc	to	the	2nd	Run	discs	while	the	original	camera	media	can	be	unmounted	and	reused.

To	optimize	the	way	your	files	are	stored	and	saved	on	the	destination	device,	there	is	the	possibility	of	using
wildcards	(#3).	With	path	wildcards	Silverstack	allows	you	to	automatically	create	a	custom	folder	structure	for	your
backups	based	on	the	offloaded	clips’	metadata.

More	copy	options	are	available	under	the	“More	options”	button:

Checksum	generation	method:	the	default	checksum	generation	method	is	the	recently	developed	MHL
protocol	(more	info	in	MHL	checksum	verification	article).	A	verification	method	is	available	for	each
Cascading	Run	(figure	3	#4).	For	1st	Run	destinations	we	recommend	using	xxHash	(fast	for	high	performance
hardware)	and	MD5	for	2nd	Run	slower	transfer	drives	for	post	production	compatibility.
Document	wildcard	handling:	modifies	Silverstack’s	behavior	with	non-clip	files	while	using	wildcards.	More
info	in	the	Use	of	Wildcards	article.
Overwrite	existing	files:	you	can	tell	Silverstack	to	overwrite	clips	if	they	already	exist	in	the	chosen	folder.
Source	Verification	on/off:	the	option	is	on	by	default,	meaning	that	during	the	verification	process	source	and
destination	are	read.	When	off,	only	the	destination	is	read,	giving	less	security	but	speeding	up	the	overall
copy	process.

After	determining	your	copy	destinations	click	on	“Backup	Files”	to	register	the	clips	in	the	library	and	start	the	copy
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job.	All	the	information	about	the	offload	process	can	be	supervised	in	the	Jobs	panel	and	-with	less	detailed
information-	in	Silverstack’s	lower	bar.

Offload	wizard	templates

The	offload	wizard	templates	are	designed	to	speed	up	the	offloading	process	by	simplifying	the	steps	needed	to
select	different	copy	destinations	and	settings.	With	the	offload	templates	you	can	save	a	series	of	presets	that	can
be	recalled	for	every	offload.	The	templates	can	contain	multiple	copy	destinations	along	with	different	settings	for
each	destination,	like	the	hashing	method	or	path	wildcards.

figure	1:	offloading	wizard	templates

Creating	a	template

In	order	to	start	the	creation	of	a	template,	just	start	an	offloading	job	as	usual.	Once	the	offload	wizard	appears,	you
can	select	the	copy	destination	and	adjust	the	settings	for	the	checksum	method	and	path	wildcards	(when	needed).
After	you	have	finished	setting	up	the	offload,	you	can	click	on	the	«gear»	button	on	the	top	right	corner	and	select
«Save	as	new	Template…».	At	this	point	a	dialogue	opens	to	name	the	template:

figure	2:	template	naming
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Finally,	click	on	«create»	and	the	template	will	be	saved.

Updating	a	template

If	there’s	the	need	to	modify	an	existing	template,	you	can	do	so	by	selecting	the	new	settings,	and	then	you	can	click
on	the	«gear»	button	on	the	top	right	corner	and	select	«Update	current	Template».	The	modifications	will	be	saved
to	the	template	at	this	point.	Once	a	template	has	been	edited,	it	is	marked	with	an	asterisk	like	«Template*».

Selecting	templates

Once	you	have	a	set	of	offloading	templates	created,	you	can	switch	between	them	by	clicking	on	the	template	name:

figure	3:	template	selection

Backup	Clips

If	you	want	to	backup	assets	that	already	exist	in	your	Silverstack	library	to	another	location	lets	say	on	an
additional	3rd	or	4th	backup	drive,	you	can	do	that	by	using	the	“Backup”	wizard.	Therefore	mark	all	the	clips	you
would	like	to	backup.

figure	1:	Backup	function	selection
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Figure	2:	Silverstack	“Copy”-wizard:	Choosing	the	clips

In	the	“Backup”	wizard	window	(figure	2)	all	clips	are	listed	by	the	currently	selected	level	of	your	project	tree.	You
can	choose	from	the	list	all	desired	assets	that	shall	be	copied	to	your	new	destination.	The	whole	folder	structure	of
those	clips	will	be	copied	and	newly	built	in	the	destination	folder.

You	can	choose	from	which	volume	the	files	should	be	copied	(figure	2	#1),	as	sometimes	it	may	increase	the	copy
speed	depending	on	your	hardware.
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Figure	3:	Silverstack	“Copy”-wizard:	Choosing	the	destination

Afterwards	you	have	to	determine	the	copy	destination	(figure	3)	by	choosing	the	drive	and	folder	(figure	3	#1).

To	optimize	the	way	your	files	are	stored	and	saved	on	the	destination	device,	there	is	the	possibility	of	using	 path
wildcards	(figure	3	#2).	Wildcards	allow	you	to	let	Silverstack	create	a	custom	folder	structure	based	on	clip	or	user
metadata.

Silverstack	also	offers	you	a	great	functionality	called	“Checksum	generation	method”	that	can	be	found	at	the
bottom	of	the	wizard	window,	which	verifies	the	copies	you	are	about	to	make.	That	guarantees	a	consistent	quality
of	your	clips.	This	function	as	well	as	the	other	copy	options	(figure	3	#3)	are	explained	in	the	article	“Offload
process“.

Reordering	and	Suspension	of	Jobs

Scheduled	copy	and	transcoding	jobs	can	be	reordered	and	suspended	since	Silverstack	version	6.2.

Overview

In	detail	this	means:

Copy	and	transcoding	jobs	are	visualized	in	separately	colored	queues
Waiting	jobs	can	be	reordered	with	a	drag	and	drop	operation
Running	jobs	can	be	suspended	to	stop	them	after	the	next	subtask	is	completed
Waiting	jobs	can	be	suspended	to	take	them	out	of	the	queue	order	of	operation

This	functionality	gives	you	full	flexibility	to	maintain	an	optimized	task	order	at	any	point.

Job	Queues

There	are	three	job	queues	that	are	visualized	in	the	“Queue”	column	with	different	colors:

Primary	copy	queue	(magenta)
Secondary	copy	queue		(green)
Transcoding	queue	(blue)
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The	“Queue”	column	indicates	the	order	of	the	completion	of	jobs.	Jobs	in	a	queue	will	be	completed	from	top	to
bottom.	Running	jobs	are	always	on	top.

Fig.	1:	Running	and	waiting	copy	jobs	in	primary	(magenta)	and	secondary	(green)	copy	queue,	with	the	queue	column	indicating	the	order	of	completion

Active	jobs	have	different	statuses	that	are	also	indicated	by	according	icons	in	the	“Queue”	column:

Active	jobs	(upper	table	view):
Running
Waiting
Will	Suspend
Suspended

Primary	Copy	Queue

Copy	jobs	are	generally	scheduled	into	the	main	primary	copy	queue	where	they	will	be	executed	from	top	to
bottom.	You	can	set	the	number	of	parallel	jobs	for	the	primary	copy	queue	in	the	preferences.	Please	see	the	article
Multiple	Simultaneous	Copy	Jobs	in	Silverstack	for	more	information	about	the	general	copy	preferences.

Secondary	Copy	Queue

The	secondary	copy	queue	holds	“Second	Run”	jobs	from	Cascading	copy	jobs.	Learn	more	about	Cascading	copy
jobs	in	the	article	Cascading	Copy.	Enabling	a	separate	queue	for	“Second	Run”	copy	jobs	will	automatically
schedule	them	into	the	secondary	copy	queue.	Learn	more	about	the	independent	execution	of	“Second	Run”	copy
jobs	in	the	article	Cascading	Copy	Preferences.

Transcoding	Queue

The	transcoding	queue	holds	all	transcoding	jobs	and	will	also	be	executed	from	top	to	bottom.	Please	see	the
articles	Transcoding	in	Silverstack	and	Silverstack	XT	or	Transcoding	in	Silverstack	Lab	for	more	information	about
transcoding.

Fig.	2:	The	blue	transcoding	queue

Terminated	Jobs
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The	active	jobs	are	shown	in	the	table	in	the	upper	half	of	the	jobs	view	while	the	lower	half	shows	the	terminated
jobs:

Fig.	3:	The	upper	table	view	with	active	jobs	and	the	lower	table	view	showing	terminated	jobs

Terminated	jobs	are	not	anymore	a	part	of	a	copy	queue.	They	will	be	automatically	moved	to	the	second	table	view
in	the	lower	half	of	the	jobs	window.

Terminated	jobs	have	different	statuses	in	the	“State”	column:

Terminated	jobs	(lower	table	view):
Finished	Successful
Finished	with	Error
Aborted	(by	system)
Cancelled	(by	user)

Reordering	of	Jobs

Waiting	jobs	in	a	job	queue	can	be	reordered	with	drag	and	drop.	Select	a	waiting	job	and	pull	it	over	or	under	any
other	waiting	jobs	in	the	same	queue:

Fig.	4:	Reordering	a	copy	job	inside	the	queue	by	dragging	it	to	the	intended	queue	position
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Please	be	aware	that:

Jobs	cannot	be	moved	between	queues
Suspended	jobs	cannot	be	reordered	above	waiting	jobs.	They	stay	at	the	bottom	of	the	queue	and	will	not	be
executed	until	they	are	resumed.
Waiting	jobs	cannot	be	reordered	above	running	jobs.	Suspend	running	jobs	for	the	next	job	in	the	queue	to
start.

Suspension	of	Jobs

Suspending	a	job	will	stop	the	job	after	the	next	task	(often	being	the	next	file)	is	finished.		This	enables	the
prioritization	of	an	incoming	job	and	avoids	loss	of	copy	or	transcoding	progress.

To	suspend	a	running	job	select	it	and	click	the	 “Suspend”	button	in	the	right	tab:

Fig.	5:	The	suspend	and	resume	buttons	in	the	right	bar	of	the	jobs	window

To	resume	the	job	again	click	the	“Resume”	button.

When	suspending	a	job	the	following	state	transfers	will	be	made:

Running	->	Will	Suspend	->	Suspended
Waiting	->	Suspended

When	resuming	a	job	it	will	again	be	queued	with	its	former	priority.

Suspended	jobs	are	still	visualized	at	the	bottom	of	the	queue	but	will	not	be	executed.

Cancelling	Jobs

Cancelling	a	job	will	immediately	stop	the	job	and	move	it	to	the	terminated	jobs	at	the	lower	half	of	the	jobs
window.	The	copy	progress	of	the	current	task/file	will	be	lost,	the	copy	progress	of	completed	tasks/files	is
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preserved.	Cancelled	jobs	can	be	re-queued	and	will	continue	the	copy	process	after	the	last	successful	task/file.

Use	of	path	wildcards

Silverstack	offers	you	a	very	flexible	folder	renaming	feature,	which	allows	you	to	create	a	custom	folder	structure	on
your	offload	and	backup	destinations.

For	every	copy	destination	you	can	define	individual	folder	structure	options.	If	you	start	a	copy	process	to	different
destinations,	you	can	have	different	folder	structures	on	every	destination.	Or	you	just	can	create	a	clone	of	your
source	material.

There	are	a	variety	of	software	tools	in	the	postproduction	process	which	require	a	specific	folder	structure.	To
simplify	the	organization	of	the	clips	related	to	the	different	folder	structure	requirements,	Silverstack	offers	this
useful	feature	that	automatically	helps	you	to	structure	the	files.

To	determine	the	names	of	folders	you	can	add	a	various	set	of	metadata	placeholders	–	called	wildcards	–	that	will
be	replaced	by	the	actual	values	of	each	clip	during	copy.

This	means	that	Silverstack	is	able	to	automatically	save	your	clips	in	a	specific,	individually	determined	folder
structure.	So	for	example	your	files	can	be	stored	in	folders	according	to	their	submission	date	and	carry	the	project
name	and	submission	time	in	their	file	names.

Wildcards	can	be	added	in	the	destination	selection	step	(figure	1)	of	the	“ Offload”	and	“Backup”	wizard.	Therefore
you	first	need	to	choose	a	drive	and	a	folder	(figure	1	#1).

figure	1:	the	Backup	wizard.	Choosing	the	destination	path.

Document	Wildcard	Handling

You	are	able	to	decide	if	you	want	to	preserve	the	original	folder	structure	for	the	non-clip	files	or	create	your
custom	structure	inheriting	the	metadata	from	the	clips,	having	this	way	all	the	sidecar	documents	with	their	parent
clips.	By	default,	Silverstack	will	inherit	metadata	from	clips.	To	choose	between	this	two	options,	go	to	Preferences
>	Copy	and	choose	your	Document	Wildcard	Handling	as	“Inherit	metadata	from	clips”	or	“Always	preserve	folder
structure”:
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Document	wildcard	handling

It	is	important	to	have	in	mind	that	when	selecting	the	“Always	preserve	folder	structure”	option,	all	files	not
considered	as	clips	by	Silverstack	(such	as:	non	fully	supported	camera	formats,	image	file	sequences,	sidecar
documents,	PDFs…)	will	be	copied	in	the	same	path	of	the	clips.	All	documents	will	preserve	the	same	folder
structure	of	the	original	medium	–	that	means	all	clips	are	in	the	folders	you	have	created.

Now,	to	make	use	of	the	helpful	feature	of	wildcards,	click	on	“Path	wildcards”	(figure	1	#2)	and	the	wildcards
wizard	opens…

Important	–	Need	to	know

Make	sure	that	the	path	you	have	determined	by	choosing	a	drive	and	folder	(figure	1	#1-3)	is	not	changed	or
deleted	unintentionally	in	the	editable	path	field	of	the	wildcard	wizard	(figure	2	#1).	Just	add	wildcards	to	the
already	existing	path	components.

In	the	path	field	you	have	to	separate	the	single	wildcard	tokens	by	a	slash	(“/”)	if	they	are	supposed	to	mark	a
folder	structure.	Separate	them	with	a	dash	(“-”)	to	combine	different	wildcards	for	one	folder	level.

Filenames	should	contain	some	wildcards	in	order	to	make	them	unique.	Silverstack	checks	the	uniqueness	of
all	created	file	paths	and	warns	you	if	necessary.
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figure	2:	wildcard	wizard

Path	textfield	and	example	label

The	wildcard	wizard	(figure	2)	at	the	top	shows	the	full	destination	path	(figure	2	#1)	which	is	editable.	You	can
either	type	path	components	in	the	text	field	directly	or	drag	and	drop	wildcards	there	from	the	list	below.	Beneath
the	text	field	you	can	see	an	example	of	the	pathname	including	wildcards	using	one	of	the	clips	you	are	going	to
copy.

Wildcard	table

All	available	metadata	fields	are	shown	in	the	wildcard	list.	So	you	can	name	your	files	and	folders	according	to
information	as	submission	date	and	time,	project	name,	various	clip	information	and	others.

The	tokens	(figure	2	#2)	can	be	drag&dropped	into	the	path	field	(figure	2	#1).	The	next	column	(figure	2	#3)
contains	an	example	of	every	token	as	it	will	be	seen	in	the	final	path-	or	filename.	The	third	column	(figure	2	#4)
tells	you	how	many	of	the	previously	selected	files	contain	this	metadata	information.

Multi-optional	wildcards

Some	wildcards	like	the	submission	time	(figure	3)	offer	several	options.	You	can	choose	between	those	by	clicking
on	the	small	triangle.

For	submission	and	shooting	time	you	can	choose	between	the	formats:	HH_MM_SS	and	HH_MM
For	submission	and	shooting	date	you	can	choose	between	the	formats:	yyyy-mm-dd,	yy-mm-dd,	yymmdd,
yyyymmdd
For	the	path	components	wildcard	you	can	choose	the	amount	of	path	components	of	the	source	folder
structure	of	the	clip	–	this	information	will	be	include	in	the	path	of	the	newly	generated	folder	structure.	So	if
you	choose	“3”,	the	last	three	levels	of	the	folder	structure	of	the	original	clip	are	included	in	the	new	clip’s
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path.
For	reel	characters	it	is	possible	to	choose	parts	of	the	reel	name	as	wildcards.	You	either	can	select	the	first	or
if	applicable	the	last	characters	of	the	reel	name.

figure	3:	Wildcard	wizard:	wildcard	with	several	options

LTFS	backup

figure	1:	backup	to	an	LTO	tape

Silverstack	offers	a	feature	to	specifically	backup	to	LTO	tapes.	Due	to	the	nature	of	their	hardware,	LTO	tapes	need
a	different	copy	process	than	the	widely	used	HDDs	or	SSDs.	The	process	used	by	Silverstack	is	to	copy	all	the
selected	clips,	rewind	the	tape	and	then	perform	the	verification.	This	way	only	one	rewinding	step	is	needed	for
each	backup	job.

Additionally,	Silverstack	supports	any	kind	of	LTO	drive	that	creates	an	LTFS	file	system	on	MAC	OS	X.	If	it	can	be
accessed	in	Finder,	it	can	be	used	by	Silverstack.	However,	no	data	capacity	information	is	offered	for	LTO	tapes.
For	this	reason,	it	is	recommended	to	manually	check	that	the	backup	size	does	not	exceed	the	tape	capacity	to
prevent	failed	backup	jobs.

To	start	a	backup	job	to	an	LTO	tape,	select	the	«File»	menu	and	choose	«Backup	To	LTFS»:

figure	2:	File	menu

Then	select	the	clips	to	backup:
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figure	3:	clips	selection

Afterwards,	add	the	LTFS	drive	to	the	destinations	by	pressing	the	+	button:

figure	4:	LTFS	destination	selection

Finally	click	on	«Backup	Files»	to	start	the	copy	process.

In	order	to	keep	track	of	the	clips	copied	to	a	certain	tape,	it’s	possible	to	generate	a	Volumes	Report.	For	more
information	on	how	to	generate	these	reports	in	multiple	formats,	please	check	the	article	Creating	Reports.
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Backup	Data	to	SONY	Optical	Disk	Archive

Silverstack	offers	the	functionality	of	backing	up	data	to	SONY’s	Optical	Disk	Archive	technology.	You	can	use	the
backup	function	of	Silverstack	to	write	assets	to	the	SONY	ODA	(Optical	Disk	Archive).	Take	a	look	at	the	article
Backup	Clips	to	learn	more	about	the	backup	function.

It	is	also	possible	to	use	the	Silverstack	Offload	functionality	to	directly	copy	data	to	an	ODA.

Silverstack	will	automatically	detect	if	the	backup	will	be	made	to	a	SONY	ODA	and	will	therefore	adapt	its
settings	to	optimize	the	copy	process.

Important	Aspects	While	Backing	Up	to	SONY	ODA

You	have	to	avoid	certain	letters	in	file	and	folder	names	that	will	cause	problems	while	backing	up	to	the	ODA.	The
next	table	represents	the	list	of	invalid	characters:

Fig.2:	List	of	invalid	characters	for	backing	up	to	Sony	ODA.

Do	not	use	the	“Backup	to	LTFS”	function	to	backup	to	a	SONY	ODA.	There	are	certain	constraints	based	on	that
particular	backup	function	that	e.g.	will	make	it	impossible	to	read	clips	quickly	from	the	ODA	again	after	backing
them	up.	Stick	with	the	regular	Backup	functionality	in	Silverstack	when	working	with	ODAs.

Managing	jobs
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figure	1:	Jobs	panel	UI

The	Jobs	panel	shows	all	the	running	or	finished	jobs	in	Silverstack.	This	panel	is	divided	in	two	main	parts:
running	jobs	(figure	1	#1)	and	jobs	history	(figure	1	#4).	The	items	shown	in	the	jobs	history	can	be	filtered	using	the
buttons	and	search	field	shown	in	figure	1	#2.

Different	kinds	of	jobs	are	displayed	in	the	jobs	panel:

Offload	jobs
Backup	Jobs
Verification	jobs
Transcoding	jobs

When	a	job	is	selected,	its	details	are	displayed	in	the	right	panel.	Figure	1	#3	shows	general	information	about	the
job.	Figure	1	#6	shows	specific	information	about	the	kind	of	job	selected,	like	average	copy	speed	or	the	setting
used	in	an	offloading	job.

Restarting/Aborting

The	behavior	in	Silverstack	when	restarting	a	job	has	been	improved	since	v4.	When	a	job	is	marked	as	«failed»	or
«aborted»	by	the	user	(figure	1	#5),	it	can	be	restarted	and	Silverstack	will	only	resume	the	missing	files	from	the
job.

Special	cases

Cascading	Copy	jobs	are	split	into	two	different	items	in	the	jobs	panel.	The	first	of	the	jobs	shows	the	«1st	Run»
copy	and	the	second	one	the	«2nd	Run»	copy.

Backup	to	LTFS	jobs	are	also	split	into	two	jobs.	The	first	job	is	the	copy	job	and	the	second	one	is	the	verification
process.

Checksum	verification	methods
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figure	1:	checksum	verification

Silverstack	offers	multiple	verification	methods	to	compare	byte	by	byte	the	source	file	with	all	of	its	backup	copies.
The	verification	process	ensures	that	no	file	has	been	corrupted	during	the	copy	process.	If	the	verification	process
result	is	positive,	Silverstack	will	create	an	.mhl	file	in	the	main	folder	of	each	backup	destination.	This	.mhl	file	is
the	seal	of	file	integrity	of	all	copied	folders	that	should	go	always	together	with	its	files,	as	it	will	let	the	user	to
manually	verify	each	copy	of	the	files	to	ensure	their	completeness	and	consistency.

figure	2:	.mhl	file	placement

Hashing	algorithms	explained

Hashing	algorithms	are	functions	that	take	a	certain	amount	of	data	(i.e.	a	file)	and	calculate	a	unique,	reproducible,
fixed-length	“hash	value”,	typically	a	relatively	short	hexadecimal	(“hex”)	value	(consisting	of	digits	and	the
characters	from	A	to	F)	out	of	any	given	payload	data,	e.g.	file.	Already	the	smallest	changes	in	the	payload	data
result	in	a	totally	different	hash	value.	This	property	can	be	utilized	in	a	wide	range	of	applications	from
cryptography	to	file	verification.

In	media	workflows	hashing	algorithms	are	used	to	identify	changes	in	a	file	without	having	the	original	file	at	hand
by	creating	the	hash	value	of	the	copy	and	comparing	it	to	the	given	hash	value	of	the	source.	If	the	hash	value	of	the
copy	is	the	same	as	the	hash	value	of	the	source,	it	can	be	inferred,	that	the	content	of	the	copy	is	the	same	as	the
content	of	the	source.

There	exist	a	lot	of	different	algorithms	for	creating	hash	values	from	data.	These	are	the	properties	of	hashing
algorithms:

Computing	complexity:	More	complexity	in	the	hashing	algorithms	require	more	computer	power	to	be
calculated,	decreasing	performance.
Collision	probability:	It	defines	the	probability	that	different	files	have	same	hash	(high	probability	is	bad)
Detection	of	modifications:	modifications	in	a	file	lead	to	different	hash	(very	important)
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xxhash	compared	to	md5	and	sha-1

xxHash

Computing	complexity:	very	low
Collision	probability:	low
Detection	of	modifications:	very	good

MD5	and	SHA1
Computing	complexity:	high
Collision	probability:	very	low
Detection	of	modifications:	very	good

Real	world	numbers

MD5	is	widely	used.	It	comes	from	an	encryption	background,	but	it	can	also	be	used	to	detect	transfer	errors.
Limited	to	300MB/sec	on	recent	hardware.	MD5	is	so	complex	to	calculate,	that	more	than	300	MB/sec	is	not
possible	on	today’s	computers.	It	checks	the	entire	content	of	each	file	and	its	size.

SHA1	also	comes	from	an	encryption	background,	but	can	also	be	used	to	detect	transfer	errors.	Limited	to
300MB/sec	on	recent	hardware.	Checks	the	entire	content	of	each	file	and	its	size.

xxHash	is	not	a	cryptographic	algorithm.	For	detecting	transfer	errors	is	as	safe	as	MD5.	However,	it	is
incredibly	fast.	In	theory	it	can	generate	check	sums	at	several	GB/sec.	Checks	the	entire	content	of	each	file
and	its	size.	Specially	useful	with	high	speed	data	transfer	hardware.	Only	faster	than	MD5	or	SHA1	if	the
transfer	speed	of	all	the	sources	and	destinations	is	higher	than	350MB/s.	Caution!	Below	300	MB/sec	xxhash
can	be	a	bit	slower	than	MD5/SHA-1,	but	beyond	it’s	much	faster,	because	md5	can’t	get	faster	and	xxhash
goes	up	to	a	few	GB/sec.

xxHash64	BE	(Big	Endian):	generally	the	same	as	the	xxHash	algorithm.	However,	it	outputs	a	hash	string	in
hexadecimal	values,	which	makes	it	more	compatible	with	some	post	production	workflows.	It	is	potentially
faster	on	very	large	data	transfer	rate	setups.	This	hashing	algorithm	is	compatible	with	Google’s	xxhash
implementation.	Endianness	information:	https://en.wikipedia.org/wiki/Endianness

xxHash64	LE/legacy	(Little	Endian):	generally	the	same	as	the	algorithm	xxHash64	BE	(Big	Endian).
However,	it	outputs	a	hash	string	in	a	Little	Endian	format.	Used	in	legacy	workflows.	Endianness
information:	https://en.wikipedia.org/wiki/Endianness

Hashing	algorithms	in	Silverstack

The	different	verification	methods	(hashing	algorithms)	are	selectable	from	the	Offload	and	Backup	wizards:
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figure	3:	checksum	methods

Source	verification

As	shown	in	figure	3,	by	default	Silverstack	does	a	source	verification	with	each	copy,	meaning	that	the	files	are	read
from	the	source	again	after	being	copied.	This	is	the	most	secure	way	to	ensure	data	integrity	because	it’s	possible	to
detect	read	errors	too.	However	it	is	possible	to	speed	up	the	copy	and	verification	process	by	disabling	this	option.
In	that	case	the	files	are	only	read	form	the	source	once	when	making	the	actual	copy.	If	the	source	is	extremely	slow,
it	could	make	sense	to	disable	it,	as	it	can	slow	down	the	verification	process.	Only	then	it	should	be	skipped,	as	it
doesn’t	affect	the	process	if	the	source	is	as	fast	as	the	destination.

MD5	files	generation

There	is	the	option	to	create	MD5	files	in	addition	to	the	MHL	ones.	This	will	give	compatibility	for	any	post
production	process	asking	for	this	kind	of	files.	The	MD5	legacy	files	are	only	created	when	the	MD5
verification	method	is	used.

figure	4:	create	legacy	check	sum	files

Sources:

https://code.google.com/p/xxhash/

Analyzing	and	improving	data-transfer	performance

Data	transfer	performance	can	be	a	very	important	issue	in	time-pressing	environments	such	as	scenarios	of	on-
set	data	wrangling.

For	a	general	list	of	factors	that	influence	the	speed	of	data-transfers	such	as

storage	technology,
RAID	technology,	and
interfaces

please	refer	to	the	document	“Factors	for	data-transfer	performance”.

How	to	analyze	your	setup	for	bottle	necks
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Every	system	is	only	as	fast	as	the	slowest	component.	So	for	example	attaching	a	brand	new,	ultra-fast	SSD	to	a
computer	via	USB2	is	no	improvement	in	performance	over	a	5	year	old	HDD	–	the	USB2	interface	is	the	limiting
factor.	The	following	list	helps	you	to	find	the	bottleneck	and	to	tune	your	setup	for	higher	performance.	Sometimes
just	using	different	connections	(lots	of	devices	have	multiple,	different	connection	ports)	or	replacing	one
component	already	can	heavily	improve	the	performance	of	an	entire	data-transfer	system.

When	for	example	copying	data	from	e.g.	a	SxS	card	to	an	external	RAID	and	a	USB3	drive	with	Silverstack,	a	lot	of
components	are	involved	–	and	the	slowest	one	is	slowing	down	the	overall	performance	and	thus	all	the	other
components.

In	this	example	we	can	identify	three	data	storage	devices	that	are	each	consist	of	several	components:

SxS	card
the	SxS	card	itself
the	card	reader	for	the	SxS	card

RAID	system
the	interface	to	the	RAID	system
the	RAID	system	and	its	configuration
the	drives	in	the	RAID	system

External	drive
the	interface	to	the	external	drive
the	drive	itself

1.	Measure	the	maximum	performance	of	each	device

You	can	determine	the	speed	of	a	device	by	measuring	the	read	and	write	speed	to	that	device	individually	and
independently.	On	the	Mac	you	can	either	use	tools	like	Blackmagic	Disk	Speed	Test	or	use	command	line	tools	such
as	“dd”.

Note:

Please	note	that	the	operating	system	caches	disk	access	in	RAM.	So	if	you	write	a	small	file	to	disk	it	is	still	in	the
cache	and	a	directly	following	read	test	will	retrieve	that	file	directly	from	RAM,	so	that	the	disk	is	not	used	at	all
in	your	test!	So	make	sure	that	your	test	files	are	large	enough	(e.g.	larger	than	RAM).	As	a	good	measure	you	can
always	use	“Activity	Monitor”	that	comes	with	OSX	to	monitor	drive	usage	and	performance	(use	the	“Disk
Activity”	tab).	For	example	when	accidentally	retrieving	data	from	cache	during	a	test	you	will	detect	that	as	zero
activity	on	the	drives	in	Activity	Monitor.

Comparing	the	performance	values	of	the	different	devices,	you	now	know	the	slowest	device.	This	device	will	slow
down	the	entire	data	transfer,	so	maybe	you	can	improve	that	first.

2.	Observe	the	overall	performance	during	the	copy	process

Now	find	out	if	the	expected	performance	can	be	observed	during	a	real	life	test.	Start	a	copy	process	to	multiple
destinations	in	Silverstack	and	use	Activity	Monitor	as	your	instrument	for	measuring	performance.

In	Activity	Monitor	you	will	see	the	current	overall	performance.	So	if	you	let	Silverstack	copy	the	contents	of	a	SxS
card	to	two	drives	simultaneously,	you	should	see	a	write	performance	that	is	twice	as	high	as	the	read	performance
during	copy.	After	copying	a	verify-phase	follows	that	reads	the	files	from	the	two	destinations	and	the	source	again.
So	you	should	see	a	very	high,	combined	overall	read	performance.

In	our	example	take	the	read-	or	half	of	the	write-performance	value	during	copy	and	use	this	value	as	your	current
reference	copy	performance.	Compare	it	to	the	measured	performance	value	of	each	device.	It	should	be	around	the
speed	of	the	slowest	device.	If	the	reference	performance	value	is	much	lower	than	the	speed	of	your	slowest	device,
there	might	be	problems	with	daisy	chaining.

3.	Analyze	the	slowest	device

If	the	speed	of	your	slowest	device	(and	thus	the	observed	reference	copy	performance)	is	much	slower	than	the
speed	of	the	other	devices	it	might	be	worth	improving	that.

Determine	the	speed	of	the	drive	by	estimating	the	theoretical	performance	of	the	used		drives	by	technology
(HDD,	SSD,	RAID).
Determine	the	theoretical	speed	of	the	interface.

You	can	now	relate	these	values	to	your	measured	values	for	the	entire	device.	If	you	experience	completely	odd
values,	maybe	something	is	configured	wrong	(attaching	a	USB3	drive	to	a	USB2-only	port)	or	a	component	is
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faulty.

If	the	interface	is	the	limiting	factor,	maybe	you	can	change	that	by	switching	the	enclosure	with	a	better	interface.
Maybe	there	is	a	card	reader	with	a	faster	interface	available.	If	the	drive	is	the	limiting	factor,	find	out	if	the	drive	is
exchangeable	with	a	similar	or	newer	drive	with	better	performance.

Modifying	the	read	buffer	size	settings

The	read	buffer	size	settings	use	«2MB,	recommended»	as	default.	However,	increasing	the	read	buffer	size	might
help	when	copying	to	software	raids	on	OS	X.	Decreasing	below	the	2MB	recommended	value	is	usually	not	advised.
The	2MB	size	recommendation	is	only	illustrative.	The	optimal	size	depends	on	your	specific	setup	and	format
combination.

Preferences	Menu:	read	buffer	size

Adding	Clips	to	the	Library	(Ingest	without	Copy)

There	is	a	fast	solution	to	create	references	to	video	clips	in	the	Project	Library	in	Silverstack.	Instead	of	copying
clips	to	another	storage	device,	you	can	select	to	just	ingest	them.	This	process	allows	a	faster	way	to	have	the	clips
in	the	Project	Library	for	subsequent	tasks	such	as	backup,	LTFS	backup,	quality	check	or	metadata	editing.

In	order	to	add	the	clips,	simply	select	“File	>	Add	to	Library…”	or	use	the	keyboard	shortcut	⌥⌘O:

Fig.	1:	File	menu
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After	selecting	the	folder	containing	the	clips,	the	ingest	wizard	opens:

Fig	2:	Ingest	wizard

The	ingest	wizard	allows	you	to	check	which	clips	are	being	ingested	before	proceeding.	Once	you	click	on	«Add»,
Silverstack	starts	creating	the	references	for	the	clips	in	the	Project	Library	by	reading	the	metadata	and	creating	the
thumbnails.	After	the	thumbnail	creation	is	finished,	the	clips	will	be	available	in	the	library	to	start	working	with
them:

fig.	3:	Project	Library
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Drag	&	Drop	Clips

Alternatively,	you	can	also	ingest	clips	by	drag	and	dropping	the	containing	folder	into	the	Silverstack	dock	icon	or
the	Silverstack	Library	Folder.	When	using	this	functionality	for	the	first	time	an	alert	will	ask	you	what	you	want	to
do:

Fig.	5:	Ingest	warning	message

If	your	intention	is	to	only	register	the	clips,	please	select	the	option	«Open	Add	to	Library	Wizard».	The	process	is
the	same	as	previously	described.	Otherwise,	select	«Open	Offload	Wizard»	if	you	decide	to	copy	the	media	to
backup	drives	in	addition	to	registering	the	clips	in	the	Project	Library.

In	case	you	enable	the	checkbox	«Don’t	show	this	message	again»,	Silverstack	will	always	use	the	selected	option	in
the	future.

Use	Silverstack's	clip	library	for	EDL	conform

EDL	files	usually	represent	a	timeline	from	editing	systems	such	as	Avid	Media	Composer	and	thus	contain	an
ordered	list	of	clips	represented	by	timecode	data	and	optional	reel	and	clip	information.

You	can	use	an	EDL	in	the	CMX	3600	standard	to	consolidate	clips	from	Silverstack’s	Library	in	a	new	Bin.	From
there	you	can	for	example	copy	all	required	clips	from	the	EDL	to	a	separate	hard	drive.

Use	Case

As	an	example	we	assume	that	the	editor	used	five	clips	which	we	now	need	to	transfer	to	a	VFX	facility.	Instead	of
shipping	several	hard	drives	with	all	the	source	footage,	or	manually	searching	them	in	huge	folder	structures,	you
can	automatically	collect	them	by	using	the	EDL	import	feature	in	Silverstack.

Silverstack	matches	the	timecode	from	the	EDL	with	the	source	timecode	of	clips	in	the	Library	and	creates	a	new
Bin	with	the	matched	clips.	From	there	it	is	easy	to	backup	the	clips	to	a	single	destination	via	the	backup	function.

Step	By	Step

We	will	describe	briefly		a	typical	workflow	with	Avid	Media	Composer	6.5.

1.	 Choose	your	timeline	in	AVID	Media	Composer
2.	 Then	in	the	MainMenu	press	Output	>	EDL	.	The	Avid	EDL	Manager	will	open	as	seen	in	figure	1
3.	 Press	the	“Get	Sequence”	Button	to	load	the	timeline
4.	 Make	sure	that	the	EDL	settings	are	CMX3600	like	in	figure	2
5.	 Click	in	the	MainMenu	File	>	Save	As…	and	export	the	file	to	your	Desktop

Silverstack	Part

6.	 Open	up	Silverstack	and	choose	the	corresponding	project.
7.	 Press	the	“Import”	Button	in	the	Main	Bar	and	choose	the	“Edit	Decision	List”	option
8.	 Choose	the	EDL	file	from	the	Desktop
9.	 If	not	set	automatically,	make	sure	that	you	choose	the	same	frame	rate	like	in	the	metadata	of	your	clips	like

in	figure	3
10.	 Silverstack	will	match	the	clips	and	add	them	to	a	new	Bin.
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Figure	1:	Avid	EDL	Manager

Figure	2:	EDL	Setting	in	the	EDL	Manager
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Figure	3:	Import	wizard	for	EDLs	in	Silverstack

This	feature	is	available	in	Silverstack	3.1	and	newer.

Sealing	Drives	in	Silverstack

The	sealing	functionality	allows	Silverstack	to	make	a	full	inventory	list	of	a	drive.	This	is	important,	not	only	to
assure	that	the	content	of	a	drive	is	identical	to	the	source	material	but	also	to	make	sure	that	the	content	on	a	drive
is	complete	and	reflects	the	intention	of	the	sender.	By	sealing	drives	as	well	as	directories	the	whole	content
becomes	registered	to	notice	any	change	inside	the	folder	in	the	future.	The	sealing	process	enables	you	to	use	the
free	tool	Pomfort	SealVerify	to	verify	the	consistency	and	completeness	of	a	drive	at	any	generation	later	without
having	access	to	the	original	media.

Silverstack	allows	you	to	seal	volumes	as	well	as	folders.	For	simplicity	reasons	we	may	only	refer	to	“sealed
volumes”	or	“sealed	drives”	below	but	want	to	make	clear	that	the	same	procedure	will	work	for	sealed	folders.

What	Does	the	Sealing	Do	?

The	sealing	procedure	bases	upon	the	existing	and	widely	used	MHL	technology	and	extends	its
functionalities.	During	the	sealing	process	Silverstack	writes	a	.pfsl	file	on	the	drive	which	we	refer	to	as	the	“Seal”.
This	seal	keeps	all	content	information	together	and	ensures	that	every	change	to	the	seal	itself	or	any	referenced
information	can	be	detected	at	any	time.	The	free	application	Pomfort	SealVerify	can	be	used	to	easily	verify	the
integrity	of	a	sealed	drive.
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Fig.	1:	Finder	screenshot	showing	the	contents	of	a	sealed	drive

To	learn	more	about	the	Pomfort	Seal	please	visit	the	article	Understanding	the	Pomfort	Seal.

How	to	Seal	a	Drive	or	Folder

To	seal	a	drive	click	on	the	“Seal”	button	in	the	Silverstack	task	bar	and	choose	the	drive	you	want	to	seal:

Fig.	2:	The	Silverstack	header	bar	with	the	“Seal”	button

The	sealing	wizard	opens	up	and	will	guide	you	through	the	sealing	process

To	seal	a	folder	go	to	the	main	menu	and	choose	“File	>	Seal	>	Folder…”.

[fig.	3	Main	Menu	File	Seal	Folder]

After	choosing	the	intended	folder	the	sealing	wizard	will	guide	you	through	the	process.

The	list	shows	all	attached	volumes	that	have	been	used	as	a	destination	in	the	current	project.	The	button	may	be
disabled	if	no	such	volume	is	attached.

Providing	the	Seal	Info

In	the	first	step	of	the	sealing	wizard	you	can	enter	the	information	that	will	afterwards	be	present	in	the	Seal	Info:
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Fig.	3:	The	first	step	of	the	sealing	process.

With	the	two	checkboxes	you	can	choose	to:

Put	a	Sealed	Library	Archive	on	the	sealed	drive.	Learn	more	about	Sealed	Library	Archives	from	the	article
Importing	Sealed	Library	Archives	in	Silverstack	XT.
Put	a	“How	To	Verify	This	Drive”-PDF	on	the	drive.	It	contains	information	for	the	receiver	of	the	sealed
volume	and	explains	how	he	will	be	able	to	verify	the	drive.

Additionally	you	can	can	enter	information	that	will	be	transmitted	along	with	the	Seal	Info	and	will	e.g.	be	readable
by	Pomfort	SealVerify	or	when	Importing	a	Sealed	Library	Archive	in	Silverstack	XT.

The	Seal	Info	contains	the	following	information:

Name	of	the	person	who	sealed	the	drive	or	folder
Contact	info	like	e.g.	phone	number	or	email	address	etc.
Time
UUID
Comment
Silverstack	Version
Host
Username
Operation	System

Enter	the	information	accurately	to	make	sure	the	receiver	of	a	sealed	drive	will	be	able	to	receive
extensive	information	and	can	contact	you	in	case	of	a	problem.

The	Sealing	Procedure

The	sealing	procedure	consists	of	several	individual	tasks.	While	some	of	them	are	self-explanatory	others	need
detailed	attention:

Lost	and	Found	Items

Silverstack	scans	the	drive	for	files	that	have	not	been	copied	with	Silverstack	and	therefore	are	not	referenced	in
any	MHL	file.	Those	files	are	collected	and	ingested	into	an	automatically	generated	folder	called	“Lost	and	Found”
inside	the	Silverstack	library.	Like	this,	the	files	will	also	be	registered	within	an	MHL	file	that	will	be	placed	on	the
drive.

Please	note	that	the	“Lost	and	Found”	items	will	be	referenced	by	file	size	only.	It	is	recommended	to	copy	all
content	with	Silverstack	to	obtain	maximum	security	with	checksum	verification.

Library	Export

After	as	successful	sealing	process	the	Silverstack	library	will	contain	the	complete	content	of	the	sealed	drive	or
directory.	The	library	export	option	will	place	a	Silverstack	library	file	(.psla)	on	the	drive.	By	using	the	library
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import	option	in	Silverstack	XT,	an	identical	Silverstack	library	containing	the	complete	and	verified	content	of	a
drive	can	be	guaranteed.	The	verification	of	the	content	can	be	handled	by	the	free	application	Pomfort
SealVerify.

Verifying	a	Seal

Seals	can	be	verified	and	checked	for	integrity	with	the	free	application	Pomfort	SealVerify.	Please	visit	the
KnowledgeBase	section	about	Pomfort	SealVerify	for	more	information	or	download	here.

If	you	are	looking	for	a	way	to	import	sealed	drives	in	Silverstack	XT	please	refer	to	the	article	 Importing	Sealed
Library	Archives	in	Silverstack	XT.

The	Seal	Info	Panel	for	Sealed	Volumes

You	can	open	the	seal	info	for	a	sealed	volume	from	the	Volumes	panel.	In	the	left	bar	of	the	Silverstack	main
window	scroll	the	library	down	until	you	arrive	at	the	“Volumes”	entry.	In	the	right	bar	you	will	then	be	able	to
open	the	Seal	Info	by	clicking	on	the	button	“Seal	Info”	on	the	side	of	the	volume	showing	the	seal:

Fig.	4:	The	Silverstack	volumes	panel	with	the	Seal	Info.

From	there	several	actions	can	be	taken:

Verify	Seal:	When	you	have	Pomfort	Seal	Verify	installed	you	will	be	able	to	verify	the	integrity	of	the	seal.
Click	the	button	to	open	the	drive	in	Pomfort	SealVerify.
Remove	Seal:	You	can	delete	the	Pomfort	Seal	file	and	the	Seal	Library	Archive.
Re-Seal:	Delete	the	seal	and	recreate	a	new	one	with	your	own	seal	information.
Import	Library:	Import	the	associated	Sealed	Library	Archive	(.psla)	that	populates	a	Silverstack	Library
containing	the	complete	content	of	the	sealed	drive	or	folder.

Or	click	“Close”	to	leave	the	seal	information	again.

Importing	Sealed	Library	Archives	in	Silverstack	XT

The	import	of	sealed	Library	Archives	enables	you	to	populate	a	content	complete	Silverstack	Library	into	a	new
Silverstack	XT	project	that	includes	all	assets	of	the	sealed	drive	or	folder.	You	can	benefit	from	that	process	by
including	a	Library	Archive	export	when	sealing	a	drive	in	Silverstack.	Additionally	the	free	tool	Pomfort
SealVerify	enables	you	to	perform	a	completeness	and	consistency	check	of	the	present	content.	Learn	about	the
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process	of	sealing	drives	with	Silverstack	from	the	article	Sealing	Drives	in	Silverstack.

Importing	a	Sealed	Library	Archive

Open	Silverstack.	In	the	Main	Menu	go	to	“File	>	Import	>	Sealed	Library	Archive…”:

Fig.	1:	Choose	Import	>	Sealed	Library	Archive	to	import	a	Sealed	Library	Archive

In	the	open	dialog	that	appears	select	the	sealed	folder	that	contains	the	Sealed	Library	Archive	along	with	the
Pomfort	Seal	you	want	to	import	.

After	clicking	“Open”	the	Seal	Information	panel	opens	up:
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Fig.	2:	The	Seal	Info	for	the	opened	volume

The	seal	information	comes	from	the	person	who	sealed	the	drive	in	Silverstack.

Several	Actions	can	be	taken	from	here:

Verify	Seal:	When	you	have	Pomfort	SealVerify	installed	you	will	be	able	to	verify	the	integrity	of	the	seal.
Click	the	button	to	open	the	drive	in	Pomfort	SealVerify.
Remove	Seal:	You	can	delete	the	Pomfort	Seal	file	and	the	Sealed	Library	Archive.
Re-Seal:	Delete	the	seal	and	recreate	a	new	one	with	your	own	seal	information.
Import	Library:	Import	the	associated	Sealed	Library	Archive	(.psla)	that	populates	a	Silverstack	Library
containing	the	complete	content	of	the	sealed	drive	or	folder.

Click	the	button	“Import	Library”	to	start	importing	the	Sealed	Library	Archive.

The	standard	library	import	wizard	will	guide	you	through	the	process	of	importing	the	library:

Learn	more	about	this	process	from	the	article	Library	Metadata	Exchange.

Sealed	Library	Archive	vs.	Library	Archive

The	Sealed	Library	Archive	basically	is	a	Silverstack	Library	Archive	with	additional	benefits.	As	it	can	only	be
created	in	the	process	of	sealing	a	drive	or	folder	with	Silverstack	the	library	will	always	contain	the	complete
content	of	the	sealed	volume.	Additionally	Pomfort	SealVerify	can	verify	the	content	of	the	library	to	assure
consistency	with	the	original	data.

Understanding	the	Pomfort	Seal

This	article	will	help	you	understand	the	intention	and	background	of	the	Pomfort	Seal.

The	Pomfort	Seal
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The	Pomfort	Seal	complements	the	widely	used	and	production-proven	MHL	standard	for	checksums	and	can	only
be	produced	by	Silverstack.	During	the	sealing	process,	Silverstack	creates	a	seal	file	(.pfsl)	that	references	all	MHL
files	on	the	drive.	An	additional	MHL	file	will	be	created	for	all	data	that	was	detected	on	the	drive	but	was	not
copied	onto	it	with	Silverstack.	The	Pomfort	Seal	holds	all	this	information	together	and	is	even	secured	against
altering	the	seal	itself.	Any	kind	of	change	of	the	data	on	the	drive	will	break	the	seal	and	will	therefore	be	detected
by	Pomfort	SealVerify.

Please	note	that	the	term	of	“sealing”	has	nothing	to	do	with	encryption	of	the	data	on	a	drive.	The	Pomfort	Seal
does	not	limit	the	access	to	your	data.	The	sealing	process	aims	for	integrity,	consistency	and	completeness	of	data.
The	term	“sealing”	is	not	used	in	a	way	that	implies	a	“blocking”	or	“locking”	of	data.

Sealed	vs	Unsealed

The	following	table	will	show	you	the	advantages	of	a	drive	sealed	with	Silverstack:

	 consistency consistency	+	completeness

MHL	only
(misc.	copy	tools)

YES NO

MHL	+	Pomfort	Seal
(Pomfort	Silverstack)

YES YES

MHL	files	(or	other	hash	files	such	as	.md5	files)	basically	carry	hash	values	and	filenames.	With	this	information,
you	can	verify	the	consistency	of	files	without	access	to	the	original	source	files.	The	appropriate	tools	can	determine
if	the	contents	of	the	files	mentioned	in	the	MHL	file	still	have	the	same	content	as	at	the	time	when	the	hash	values
have	been	created.	The	MHL	files	are	usually	created	during	a	copy	process.

For	a	drive	with	multiple	folders	copied	with	multiple	copy	processes	(for	examples	on	a	film	set,	where	multiple
camera	cards	are	copied	to	the	same	travel	drive),	you	cannot	verify	if	one	entire	folder	together	with	its	MHL	file	is
missing.	This	means	with	MHL	files	alone	you	can	verify	consistency	of	single	files,	but	not	the	completeness	of	an
entire	drive.

To	solve	this	problem	,	the	Pomfort	Seal	contains	a	list	of	all	MHL	files	on	a	drive.	With	this	information,	a	missing
MHL	file	can	detected	very	easily.	This		means	that	the	Pomfort	Seal	together	with	the	MHL	files	allows	to	verify
consistency	as	well	as	completeness	of	a	travel	drive.

The	sealing	process	in	Pomfort	Silverstack	also	searches	for	files	on	the	drive	that	haven’t	been	listed	in	MHL	files
yet.	This	ensures,	that	the	Pomfort	Seal	together	with	the	MHL	files	cover	the	entire	content	of	the	sealed	drive.

Pomfort	SealVerify	is	the	free	one-button	process	to	verify	the	Pomfort	Seal	and	the	listed	MHL	files.	This	way	a
reliable	copy	chain	can	be	built	where	both,	consistency	and	completeness	of	media	data	can	be	verified	at	any	time.
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Quality	Check

HD-SDI	Output	in	Silverstack

Silverstack	XT	and	Silverstack	Lab	come	with	HD-SDI	output	to	play	out	ingested	clips	in	best	quality	for	QC	on	an
HD-SDI	broadcast	monitor.	The	current	clip	in	the	player	gets	mirrored	to	the	HD-SDI	output	showing	the	image	in
full-screen	and	10	bit	color	depth.

Supported	Devices

To	enable	the	HD-SDI	output	you	need	one	of	the	following	devices:

AJA	T-TAP
AJA	KONA	series
AJA	Io	series
Blackmagic	Design	Ultrastudio	Products
Blackmagic	Design	Mini	Monitor
Blackmagic	Design	Decklink	Cards

Attach	the	according	interface	to	your	Mac	(Thunderbolt	or	PCIe)	and	connect	the	HD-SDI	output	of	the	device	to
the	selected	destination.

Figure	1:	Schematic	presentation	of	a	Silverstack	XT	HD-SDI	setup

Drivers

In	order	to	use	the	supported	devices	you	have	to	install	all	drivers	and	necessary	software	provided	by	the	the
manufacturer.

For	Blackmagic	Design	devices	that	is	the	“Desktop	Video”	software	you	can	download	in	their	support	area.

For	AJA	Devices	that	are	the	“AJA	hardware	drivers”	included	in	the	latest	“AJA	software	installers”	also
available	in	their	support	area.

External	Video	Preferences

As	soon	as	the	HD-SDI	device	is	connected,	Silverstack	XT		requests	permission	to	use	it	for	playback.	In	case	you
decide	to	activate	the	SDI	playback	later,	you	can	enable	it	through	“Preferences>External	Video”.	You	can
disable	the	use	of	the	device	from	the	same	menu	in	case	another	application	demands	its	use	(i.e.	parallel	use	of	the
hardware	with	other	software).	If	you	have	multiple	output	devices	attached,	you	can	select	which	one	to	use	by
choosing	it	in	the	drop	down	menu:

122

Silverstack	6	Manual	
Quality	Check

https://www.blackmagicdesign.com/support
https://www.aja.com/en/support


Figure	2:	External	Video	settings

For	the	“Video	Format”	you	will	be	able	to	choose	from	two	settings:

Try	to	Match	Clip:	This	setting	will	try	to	match	the	output	format	of	the	SDI	to	the	settings	of	the	clips.
Silverstack	will	try	to	keep	the	frame	rate	and	fall	back	to	HD	if	the	resolution	is	not	supported.	If	the	frame
rate	is	not	supported	it	will	fall	back	to	1080p25.		In	detail	this	means:

Frame	rate	supported	/	resolution	not	supported:	Silverstack	will	keep	the	frame	rate.	The
resolution	will	fall	back	to	a	1920	x	1080	(HD).
Frame	rate	not	supported	/	resolution	supported:		Silverstack	will	fall	back	to	1080p25.

Fixed	:	This	setting	will	let	you	choose	the	output	format	manually.

Additionally	you	can	choose	to	release	the	device	when	Silverstack	XT	is	in	background	by	enabling	the	checkbox
“Release	device	when	Silverstack	is	in	background”.	By	default	it	will	be	kept	even	if	Silverstack	XT	is	in
background.

Please	be	aware	that	the	support	of	SDI	formats	depends	on	the	compatibility	of	the	attached	hardware	device	that
the	implementation	in	Silverstack	bases	on.

The	HD-SDI	Indicator

As	soon	as	you	enable	the	external	video	output	in	the	preferences	a	little	indicator	in	the	toolbar	of	the	Silverstack
XT	media	player	will	give	you	hints	on	the	status	of	the	HD-SDI	output:
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Figure	3:	The	HD-SDI	indicator	will	show	up	in	the	toolbar	of	the	media	player	and	the	Miniplayer.

There	are	3	statuses	possible:

1.	HD-SDI	output	enabled	and	working:

Figure	4:	HD-SDI	Indicator	showing	a	working	HD-SDI	output.

Click	on	the	indicator	to	reach	the	External	video	out	settings	with	the	settings	for	the	HD-SDI	output.

2.	HD-SDI	output	enabled	but	no	device	attached:
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Figure	5:	HD-SDI	indicator	showing	that	no	device	is	attached

Click	on	the	indicator	to	reach	the	External	video	preferences	to	set	up	your	attached	device.

3.	HD-SDI	output	has	problems

Figure	6:	HD-SDI	indicator	notifying	about	problems	with	the	attached	device

Click	on	the	indicator	to	see	details	about	the	problem.

A	usual	case	causing	this	status	of	the	indicator	would	be	another	application	that	tries	to	use	the	same	HD-SDI
device	as	Silverstack	XT.	Deactivate	the	background	use	in	the	preferences	of	the	application	trying	to	use	the	same
devices	as	Silverstack	XT	to	avoid	the	problem.

Playback	Modes

You	can	choose	between	two	playback	modes:

Absolute	Time	Playback:	Tries	to	play	back	footage	in	sync	with	audio.	Silverstack	XT	will	skip	frames	to
stay	in	sync	with	audio	when	video	processing	or	I/O	is	too	slow.
Every	Frame	Playback:	Aims	to	play	back	frame	exact	which	leads	to	loosing	audio.	Silverstack	XT	will
play	back	frame	exact	even	if	that	leads	to	non-realtime	playback.

To	select	the	desired	mode	go	to	 “Playback”	in	the	main	menu	of	LiveGrade	and	select	the	according	entry	right	at
the	top:

125

Silverstack	6	Manual	
Quality	Check



figure	7:	Select	playback	mode	from	the	main	menu

Image	processing

There	are	different	options	when	it	comes	to	display	the	clips	through	the	SDI	device.	You	can	modify	these	settings
on	the	External	Video	Out	window.

figure	8:	External	Video	Out	settings	window

These	are	the	available	settings:

Visual	Controls:	enable/disable	the	«Image	Analyses»	like	False	Color	and	Exposure	Range,	as	well	as
Framelines.	Learn	more	about	frame	lines	from	the	article	Frame	Lines	in	the	Playback	View.
Scaling	and	Position:

Scale	to	fit:	fills	the	output	display	with	the	image	to	compensate	for	a	difference	in	the	resolution.
1:1	Pixels:	displays	the	image	in	full	resolution,	which	can	crop	the	image	id	the	output	display	has	less
resolution	than	the	source.

Supported	Frame	Rates	and	Resolutions

Supported	frame	rates	and	resolutions	are:

720p50
720p59.98
1080p23.98
1080p24
1080p25
1080p29.97
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1080p30

Silverstack	XT	has	a	fallback	resolution	(1920	x	1080	HD)	and	frame	rate	(25p)	that	is	executed	when	the	desired
resolution	and	frame	rate	is	not	supported	by	your	hardware	device.	That	means	if	either	frame	rate	or	resolution	is
not	a	native	SDI	format	the	SDI	output	will	fall	back	to	1080p25.

Interlaced	formats	are	currently	not	supported.

HD-SDI	Features	and	Quality	Characteristics

Color	Reproduction HD	video	matrix	and	gamma	(ITU-R	BT.709;	ITU-R	BT.1886)

Timing
Sync	to	next	available	video	frame	rates	(see	Supported	Frame	Rates	and	Resolutions
and	Playback	Modes)

Code	Values 10-bit	legal	range	YCbCr	output	(internal	16-bit	RGB	processing)

Embedded	Audio Not	supported

Metadata	Output Not	supported

The	Miniplayer

Additionally,	you	can	enable	the	Miniplayer	from	the	same	menu,	which	enables	to	monitor	the	same	image	sent
through	the	SDI	output	on	the	computer	display,	at	the	same	time	as	you	navigate	across	the	Project	Library.

When	the	HD-SDI	Output	is	enabled	it	will	automatically	open	the	Miniplayer	to	keep	the	HD-SDI	output	though
you	switched	to	the	list	or	table	view	etc.	As	soon	as	you	close	the	Miniplayer	the	HD-SDI	output	will	be	disabled.

You	can	reopen	the	Miniplayer	manually	from	the	Main	Menu.	Go	to	 “Playback	>	Show	Miniplayer”	to	open	it
up	again.	You	can	also	open	it	from	the	Miniplayer	symbol	in	the	header	bar	on	the	right.

figure	9:	the	Miniplayer

Multichannel	Audio	in	Silverstack

Silverstack	offers	audio	playback	of	audio	data	embedded	in	video	clips	for	preview	and	quality	check.	Audio	can
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also	be	transcoded	in	dailies	and	for	the	editorial	department	including	a	stereo	mixdown	or	with	the	original	audio
tracks.	The	clips	with	embedded	audio	can	be	played	back	with	sound	and	can	be	transcoded	for	the	editorial
department	including	all	the	audio	tracks.

Silverstack	supports	audio	features	for	these	camera	formats:

Alexa	ProRes
Alexa	SXT	ARRIRAW	(.ari)
Amira	ProRes
Canon	C300
H264	from	DSLRs	(like	e.g.	Canon	EOS	5D	Mark	II)
Sony	F55	XAVC
Sony	X-OCN
Digital	Bolex	Cinema	DNG
Various	Red	Camera	models	(.r3d	movies)

The	audio	settings	per	clip	are	grouped	in	the	“Audio”	tab.	 There	you	can	modify	the	sound	settings	for	each	clip
while	in	Playback	mode:

Fig.	1:	Audio	panel	with	audio	tracks	from	ARRI	Alexa	SXT	ARRIRAW	(.ari)

The	audio	panel	offers	the	following	controls:

Master	Volume:	controls	the	output	signal	level	of	the	mix.
Audio	meters:	represent	the	audio	signal	level	during	playback.	There	is	a	stereo	Master	meter	and
additional	Channel	meters	—	one	for	each	audio	track.	The	scale	on	top	of	the	meters	indicates	the	audio	level
in	dB	(dBFS).	Peaking	is	represented	by	a	bar	in	the	according	color	of	the	peaking	level	that	remains	at	the
maximum	position.	You	can	reset	the	peak	bar	by	clicking	on	the	audio	meters.
Channel	mixers:	the	sliders	control	the	signal	level	for	each	track.	You	can	mute	specific	«Left»	and	«Right»
tracks	by	disabling	the	check	boxes	on	the	right	of	the	channel	mixers.
Mute	button:	Mutes	the	according	audio	channel
Solo	button:	Solos	the	according	audio	channel
Pan	control:	Sets	the	panorama	to	left,	middle	or	right

Basic	Color	Control	in	Silverstack

This	feature	allows	users	to	display	“Log”	clips	in	a	different	color	space	by	applying	preset	LUTs,	user	predefined

custom	3D	LUTs	or	color	metadata	(looks)	embedded	in	clips	(for	selected	formats1).	The	color	processing	enables
you	to	create	thumbnails,	playback	and	transcode	the	clips	with	a	look	applied.	Alternatively,	you	can	just	use	the
file	as	it	was	recorded	without	any	color	processing	(in	the	camera	acquisition	color	space).	By	default,	Silverstack
reads	the	clip	color	metadata	and	applies	a	Rec.709	LUT	if	needed.

Editing	the	Look	Source	in	the	General	Information	Tab

It’s	possible	to	modify	the	color	processing	of	a	certain	clip	or	group	of	clips	by	setting	a	different	Look	Source	in	the
General	Information	metadata	tab,	under	the	«Processing»	section.	In	order	to	edit	the	Look	Source	of	multiple
clips,	just	select	them	from	the	library,	click	on	the	«edit»	button	and	select	an	option	from	the	list.	Once	you	click
on	«Apply»	all	the	selected	clips	will	have	the	same	Look	Source.
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figure	1:	Look	Source	settings	on	the	General	Information	tab

You	can	choose	from	five	different	processings:

None:	Disables	the	color	processing	and	displays	the	clips	and	thumbnails	unmodified	(as	recorded).
File:	Reads	the	clip’s	metadata	and	applies	the	color	processing	described	in	the	embedded	looks.	In	case
there	is	no	look	embedded,	Silverstack	applies	the	default	Log	to	Rec.709	conversion	for	the	specific	format.
Preset:	with	this	option	you	can	choose	the	color	processing	used	from	a	list	of	preset	LUTs
User-defined	LUT:	Will	enable	you	to	manage	a	custom	LUT.
User-defined	Look:	Will	enable	you	to	create	a	custom	Look	with	the	Silverstack	grade	controls.	More	info
in	the	section	below.

Setting	a	User-Defined	Look	for	Multiple	Clips

From	the	Look	Source	selection	you	can	choose	the	processing	“User-defined	Look”	to	enable	a	custom	look	for	a
clip.	Select	multiple	clips	and	select	the	processing	to	enable	it	for	all	of	them.

In	the	Silverstack	player	view	you	will	then	see	the	grade	controls	being	opened	up.	You	can	learn	more	about	the
grading	controls	and	the	look	library	from	the	articles	Grading	Controls	in	Silverstack	and	The	Silverstack	Look
Library.

How	to	Apply	and	Manage	Custom	LUTs

One	of	the	features	related	with	the	look	control	in	Silverstack	is	the	ability	to	apply	custom	LUTs	to	the	clips.	Users
can	load	custom	3D	LUTs	generated	by	other	software	applications	–	such	as	LiveGrade	Pro.	When	a	custom	LUT	is
used,	Silverstack	displays	the	thumbnails	and	playback	with	that	look	applied.	Transcoding	of	the	clips	with	that
LUT	is	also	possible.

figure	2:	custom	LUTs	loading

The	supported	3D	LUT	formats	are:

.cube	(32x32x32,	33x33x33	and	65x65x65)

.3dl	(32x32x32)

In	order	to	load	them,	just	select	the	Look	Source	to	be	«User-defined	LUT…»	and	click	on	the	«Load	LUT	File…».
Then	navigate	through	Finder	to	the	LUT	file,	select	it	and	choose	«Open».	Finally,	click	on	«Apply»	in	the	Edit
Source	pop	up	to	apply	the	LUT	to	the	clip.

Setting	the	Look	Source	for	the	Ingest	of	Clips

The	color	processing	can	take	place	automatically	when	ingesting	the	clips	by	reading	their	metadata	or	using	a
preset	LUT.	In	addition,	the	look	applied	can	be	modified	or	disabled	for	each	clip	individually.

In	order	to	automatically	apply	a	look	to	the	clips	while	being	ingested,	you	have	to	go	to	the	«Format	Options»
section	on	the	«Preferences»	menu:
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figure	3:	Format	Options

Each	format	allows	you	to	define	a	different	color	processing.	You	can	choose	the	format	using	the	«Format
Selector».		Once	the	desired	format	is	selected	you	can	set	the	Look	Source	as:

None:	Disables	the	color	processing	and	displays	the	clips	and	thumbnails	unmodified	(as	recorded).
File:	Reads	the	clip’s	metadata	and	applies	the	color	processing	described	in	the	embedded	looks.	In	case
there	is	no	look	embedded,	Silverstack	applies	the	default	Log	to	Rec.709	conversion	for	the	specific	format.
Preset:	with	this	option	you	can	choose	the	color	processing	used	from	a	list	of	preset	LUTs:

figure	4:	Look	presets

Setting	the	Look	for	Transcoding

While	transcoding	clips	you	can	choose	the	look	the	clips	will	be	transcoded	with.	You	can	change	the	settings	for
the	Look	source	in	the	transcoding	tab	in	the	right	bar	(see	figure	5):

As	set	in	Library	(“As	in	Library”):	Applies	the	look	that	is	currently	selected	for	the	specific	clip	in	the
Library.	In	case	you	need	to	transcode	the	clips	with	a	custom	look	applied,	this	is	the	right	option.
No	Look	(“None”):	Transcodes	the	clips	with	no	look	applied	(as	they	were	recorded,	with	no	color
processing	in	the	camera	acquisition	color	space).
Look	from	File	(“From	File”):	Reads	the	clip’s	metadata	and	applies	the	color	processing	described	in	the
embedded	looks.	In	case	there	is	no	look	embedded,	Silverstack	applies	the	default	Log	to	Rec.709	conversion
for	the	specific	format.
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figure	5:	Choose	the	look	settings	for	transcoding

1	The	selected	formats	with	Look	Metadata	reading	are	Alexa	ProRes,	ARRIRAW,	Amira	ProRes,	RED	Raw	and
Panasonic	Varicam	35.	If	no	look	metadata	is	embedded	in	the	file,	a	default	log-to-video	conversion	is	chosen	for
the	specific	format	(e.g.	XAVC	with	S-Log).

Visual	Control	Functionalities	in	the	Playback	Mode

figure	1:	visual	controls	in	Silverstack

With	the	functionalities	provided	within	the	“Visual	Controls”	panel	you	can	check	the	colors	and	quality	of	your
video	clip:

1.	 Channels:	By	selecting	one	of	the	three	RGB-channels	Silverstack	shows	the	distribution	of	this	color	in	the
image	of	the	video	clip.

2.	 Focus	Assist:	The	focus	assist		helps	you	to	detect	if	your	image	is	in	focus	by	detecting	the	edges	of	the
image.	You	can	set	the	sensitivity.

3.	 Clipping:	With	the	clipping	functionality	you	can	check	which	areas	of	your	image	clip	are	either	in	the
whites	or	blacks.

4.	 Exposure	Range:	This	option	allows	you	to	detect	different	ranged	areas	of	luminance	in	your	image.
5.	 False	Color:	You	can	use	this	option	and	active	false	color.	The	represented	values	can	be	found	in	figure	2
6.	 Framelines:		add	frame	lines	to	visualize	the	clips	with	a	different	aspect	ratio.	More	information	in	the

article	Frame	Lines	in	the	Playback	View.
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Figure	2	“Values	for	clipping”

Note:	You	can	change	the	unit	for	clipping	and	range	in	the	 application	preferences.

Video	Preview	playback	control

The	Silverstack	playback	controls	allow	you	to	control	the	video	preview	with	standard	video	controls	(figure	3	#1)
and	the	possibility	to	set	IN-	and	OUT-points	(#2)	as	well	as	to	loop	the	video	and	zoom	into	it	(#3).	To	show	the
original	Log	gamma	instead	to	the	Rec.709	conversion,	select	the	#4	check	box.

figure	3:	standard	playback	controls

For	video	files	in	the	Red	format	and	ARRIRAW	sequences	you	have	additional	functionality	to	change	the	playback
resolution	(figure	4	#1):	You	can	select	various	resolutions,	choosing	between	full,	1/2,	1/4	and	1/8.

figure	4:	playback	controls	for	any	video	with	multiple	resolutions	available

100%	Zoom	for	Retina	Displays

Silverstack	is	optimized	to	work	with	the	“Default”	settings	for	Apple	retina	displays	which	you	can	find	under
“System	Preferences	>	Displays”.	Choosing	this	setting,	Silverstack	will	map	1	media	pixel	to	1	physical
pixel	of	the	display.

This	setting	is	best	suited	for	visual	image	analysis	such	as	focus	or	sharpness.

Professional	Video	Scopes	for	Silverstack	with	ScopeBox

You	can	use	ScopeBox	by	Divergent	Media	for	software-based	waveform	and	video	scopes	for	Silverstack’s	player.
ScopeBox	offers	a	variety	of	waveform	monitors	and	video	scopes	that	enable	image	analysis	and	color	control	of	the
clip	assets	of	your	Silverstack	library.

You	can	receive	information	about	how	to	download,	setup	and	license	ScopeBox	software	on	Divergent	Media’s
Website.	To	use	the	integration	of	Silverstack	in	ScopeBox	you	have	to	run	version	3.5	or	later	of	the	ScopeBox
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application.

Connecting	Silverstack	and	ScopeBox	via	ScopeLink

Silverstack	sends	the	current	image	of	the	player	directly	to	the	ScopeBox	application	by	DivergentMedia’s
ScopeLink	technology.	To	enable	ScopeLink	open	the	ScopeBox	application.

Click	in	the	upper	left	area	of	the	ScopeBox	main	window	to	set	a	new	source.	Choose	 “Add	ScopeLink	Source	>
Pomfort	Silverstack”	from	the	context	menu:

Figure	1:	Add	Pomfort’s	Silverstack	as	a	source.

After	that	the	source	should	show	a	pending	image:

Figure	2:	ScopeBox	waiting	for	the	Silverstack	connection.

Now	open	Silverstack.	Open	a	clip	in	the	media	player.

Make	sure	that	in	the	preferences	of	Silverstack	under	“External	Video”	the	checkbox	“Connect	to	ScopeBox”
is	enabled.	You	reach	the	preferences	from	the	Main	Menu	by	choosing	“Silverstack	>	Preferences…”:
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Figure	4:	ScopeBox	Preference	in	the	External	Video	tab

There	you	can	also	choose	if	you	want	to	update	the	frames	in	ScopeBox	during	playback	in	Silverstack.	Checking
this	box	may	increase	performance,	but	Silverstack	only	updates	Scopebox	when	being	paused.

When	you	switch	to	ScopeBox	you	should	then	see	the	default	view	including	an	image	preview	of	the	image

showing	in	Silverstack:

Figure	3:	The	ScopeBox	UI	with	a	preview	of	the	Silverstack	clip	and	scopes.

Because	of	Silverstack’s	internal	RGB	processing,	signals	from	of	YCbCr	based	clips	sent	to	ScopeBox	via	ScopeLink
don’t	contain	code	values	outside	the	legal	range	(even	if	they	might	be	present	in	the	source	files).

Learn	how	to	use	ScopeBox	with	this	tutorial	(from	Divergent	Media):

Find	more	tutorial	videos	from	Divergent	Media	about	ScopeBox	here.

Tags:	waveform,	vectorscope,	histogram,	rgb	parade
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Frame	Lines	in	the	Playback	View

It	is	usual	to	record	footage	with	an	aspect	ratio	different	to	the	one	used	in	the	final	product,	which	makes	the
quality	checking	of	the	clips	a	bit	more	challenging.	For	this	reason,	Silverstack	offers	the	possibility	to	overlay
frame	lines	over	the	clips	in	the	playback	window,	as	well	as	for	the	SDI	output.

The	frame	lines	can	be	activated	through	the	«Visual	Controls»	menu.	You	can	open	the	visual	controls	from	the
Main	Menu.	Choose	“Playback>Show	Visual	Controls”:

figure	1:	frame	lines	settings

Once	in	the	Visual	Controls	window	you	can	activate	the	frame	lines	with	the	checkbox.	You	can	then	select	the
aspect	ratio	and	appearance	of	the	frame	lines:

figure	2:	aspect	ration	an	appearance	settings

Frames	lines	are	available	for	normal	playback	and	SDI	output.	For	more	information	about	how	to	setup	the	SDI
output	in	Silverstack,	please	refer	to	the	article	HD-SDI	output	in	Silverstack.

Image	transformation

The	ability	to	de-squeeze	footage	recorded	with	anamorphic	lenses	and	image	flipping	is	available	in	Silverstack.
This	features	are	helpful	to	check	the	quality	of	the	clips	without	distortions.	Image	transformations	will	be	also
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applied	if	you	decide	to	transcode	the	clips.

Anamorphic	de-squeezing

figure	1:	Anamorphic	transformation

The	de-squeezing	option	can	be	applied	to	a	single	or	multiple	clips	in	the	Clip	Info	tab	(⌘1)	from	the	right	panel.
Scroll	down	to	Processing	info	and	an	Anamorphic	option	will	be	shown.	Click	on	the	edit	button	and	a	panel	will
pop	up	as	in	figure	2.	The	available	settings	are	1.3x	and	2.0x	distortion,	select	the	one	that	suites	your	needs	and
click	on	apply.	The	image	will	appear	without	distortions	now.

figure	2:	de-squeeze	settings

Image	flipping

Some	production	workflows	demand	the	use	of	mirrors,	such	as	3D	productions.	When	the	moment	of	quality	check
arrives,	Silverstack	offers	the	ability	to	flip	the	image	vertically,	horizontally	or	both	at	the	same	time	as	shown	in
figure	3.	This	feature	can	also	be	applied	to	multiple	clips	at	a	time.

figure	3:	image	flipping	settings

Tags:	desqueeze,	anamorph,	anamorphic

Still	image	export

Silverstack	lets	you	export	still	images	from	single	frames	of	clips.	Simply	move	the	playhead	to	the	desired	frame
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and	select	“Clip	>	Create	Still	Image”	from	the	main	menu	as	shown	in	figure	1:

figure	1:	still	image	export

There	are	different	settings	and	formats	available	for	this	feature	in	the	Preferences	menu:
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figure	2:	still	frame	preferences

The	following	options	and	actions	are	available:

Directory	to	Store	Stills:	Choose	the	directory	to	store	your	still	grabs	on	your	system	by	clicking	the
“Choose…”	button.

Naming	Scheme:	With	the	naming	scheme	you	can	define	the	naming	for	the	exported	still	images.

There	are	multiple	preset	options	available:	
In	addition	the	“Custom:”	option	allows	to	build	a	file	name	based	on	the	metadata	of	the	clip	the	still	is
exported	from.	By	clicking	“Customize…”	you	can	open	the	metadata	wildcards	panel	and	choose	from
the	available	wildcards	to	build	a	custom	file	name	scheme:		
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Image	Format:	The	available	image	formats	for	exporting	frames	are:
JPEG	–	8-Bit,	90%	Quality
TIFF	–	8-Bit,	Uncompressed
TIFF	–	16-Bit,	Uncompressed

Color	Mode:	The	different	color	modes	are:
As	currently	shown	in	player
Original	color
Both:	Exports	two	images	with	both	of	the	above	settings	–	one	as	shown	in	player	and	the	other	with	the
original	color.

Exporting	Multiple	Still	Images	and	Contextual	Still	Frame	Selection

Silverstack	can	export	multiple	still	images	at	once	when	either	selecting	multiple	clips	in	the	table	or	collection	view
or	in	the	timeline	of	the	player.	The	still	frame	position	that	is	used	for	the	export	depends	on	the	context	in	the
software.

Following	a	“what	you	see	is	what	you	get”	approach	the	selected	frame	for	the	still	image	export	follows	the	context
in	the	software:

Player	and	Timeline:	Current	frame	of	each	selected	clip	(indicated	by	the	timeline	ruler).
Table	&	Collection	View:	Thumbnail	image	that	is	displayed	in	the	table	and	collection	view

You	can	set	the	position	for	the	thumbnail	image	creation	in	the	preferences	and	can	recreate	still	images	based	on
the	same	position.	Learn	more	about	this	in	the	article	Choosing	Custom	Thumbnail	Images.

Volume	playback	priority

High	data	rate	video	playback	is	very	hardware	demanding.	As	Silverstack	offers	a	multiple	destination	backup
option,	your	valuable	clips	will	be	stored	in	different	volumes.	Different	types	of	volumes	may	have	variant	interface
connections.	To	increase	playback	performance	in	Silverstack	it	is	possible	to	select	the	playback	priority.

To	accomplish	that	you	will	have	to	go	to	the	Volumes	tab,	select	the	volume	you	want	to	set	its	playback	priority
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and	adjust	it	on	the	right	panel	(figure	1	#1).

figure	1:	playback	priority

If	your	main	playback	volume	is	offline,	Silverstack	will	automatically	select	another	volume	in	the	order	of	your
playback	priority	.	If	no	priority	is	selected,	Silverstack	will	randomly	select	the	playback	source
volume.

Quick	Look	Features

In	Silverstack	you	are	able	to	preview	all	of	your	Assets	that	are	natively	supported	by	the	Quick	Look	feature	of
MacOSX	and	offloaded/registered	to	your	library.	This	is	especially	useful	if	you	would	like	to	review	those	Assets
which	don’t	have	advanced	camera	support.	Assets	like	any	PDF	document	or	image	(i.e.	a	screenplay,	storyboard,
etc.)

There	are	also	some	situations	where	it	can	be	handy	to	preview	advanced	camera	support	Assets.	We	will	briefly
review	some	different	scenarios	that	might	be	useful	on	the	film	set.

General

Quick	Look	lets	you	browse	files	—	photos,	Pages	documents,	Keynote	presentations,	QuickTime	movies,	Microsoft
Word	and	Excel	files	—	without	having	to	launch	an	application	or	leave	Silverstack.

Assets	that	are	fully	supported	in	Silverstack	are	playable	via	the	regular	playback	function	in	the	Playback	view,	in
addition	to	the	Quick	Look	feature.

You	can	access	the	Quick	Look	feature	from	by	going	to	the	Main	Menu:	“Playback	>	Preview	in	QuickLook”.
To	improve	your	workflow	you	can	also	use	the	keyboard	shortcut	command	“Alt	+	Cmd	+	L”.

Case	1:	Review	supported	Assets

The	Quick	Look	feature	helps	you	to	review	an	Asset	without	changing	into	the	Playback	view.	This	could	be
especially	useful	when	you	are	reviewing	shots	in	a	camera	roll	with	the	director	but	still	want	to	give	him	a	glimpse
overview	(via	thumbnails	in	the	collection	view)	of	the	camera	roll	of	the	entire	shooting	today.

Or	if	you	would	like	to	review	the	take	with	recorded	scratch	sound	from	the	camera.		If	the	recorded	scene	includes
audio	it	will	automatically	playback	with	the	Quick	Look	feature.
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Figure	3:	“Collection	View	with	Quick	Look”

Case	2:	Review	Assets	without	extended	camera	support

With	the	use	of	3rd	party	software	it	is	possible	to	preview	footage	and	Assets	that	are	not	natively	supported	by
Silverstack	neither	with	MacOSX.	These	can	be	for	example	formats	like	XDCAM	HD	with	help	of	tool	mxf4Mac
Import	plugin	and	Final	Cut	Pro.

Also	some	other	3rd	plugins	are	out	there.	Please	review	this	article	to	have	a	list	of	possible	3rd	plugins.

Case	3:	Review	Storyboards,	Images,	Sounds	and	PDFs

You	can	also	give	the	director	or	the	camera	man	the	ability	to	review	storyboards	(like	in	figure	4.)	or	listen	to	some
audio	files	that	you	offloaded	from	the	sound	department.

Figure	3	:	“Quick	Look	Storyboard”

Case	4:	Review	multiple	Assets	(non	consecutive)
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With	the	Quick	Look	option	you	can	also	quickly	watch	a	selection	of	takes	from	your	camera	roll.	This	is	useful
when	you	have	many	takes	in	one	roll.	You	are	still	able	to	stay	within	your	current	view	like	in	figure	3	but	you	are
able	to	watch	multiple	clips	and	discuss	those	with	the	script	continuity,	the	director	or	camera	man	and	simple
change	clips	with	back	and	forward	arrow	within	the	Quick	Look	window.

To	make	a	non	consecutively	selection	in	the	Collection-View	(like	in	figure	3)you	simple	need	to	press	the	command
key.	If	you	like	to	make	consecutive	selection	you	simple	press	the	Shift	key.	These	simple	command	also	applies	for
the	Table-View.

Player	Grid	View	for	Multi	Clip	Selection

Silverstack	XT	and	Silverstack	Lab	come	with	a	Grid	View	mode	of	the	playback	view	to	 show	multiple	clips
side-by-side	in	the	Silverstack	Player	and	on	the	HD-SDI	output:

Fig.	1:	The	Grid	View	of	the	player	in	Silverstack	Lab

You	can	access	the	Grid	View	from	the	single	view	and	grid	view	controls	in	the	header	bar	of	the	player:

Fig.	2:	Accessing	the	Grid	View

Alternatively	you	can	access	it	from	the	“Playback”	menu	of	the	Main	Menu	bar:

Fig.	3:	Multi	clip	selection	entry	in	the	“Playback”	menu

After	accessing	the	Grid	View	you	have	to	select	multiple	clips	in	the	timeline	to	show	them	in	the	grid.	This	can	be
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done	with	the	usual	macOS	modifier	keys	for	multiple	and	continuous	selection.	Hold	shift	while	clicking	to	select	a
range	of	clips	and	cmd	to	select	and	deselect	single	clips.

Fig.	4:	The	timeline	with	three	selected	clips

The	timeline	in	fig.	4	shows	a	selection	of	three	clips.	The	first	clip	(A006C009_160208_R2VJ)	in	bold	white	font	is
the	primary	current	clip.	Editing	metadata	and	adjusting	the	grade	will	affect	the	current	clip	only.	It	is	also	marked
in	the	image	with	a	little	white	dot	in	the	lower	left	corner.

The	current	clip	inside	of	a	selection	can	be	changed	by	 clicking	on	another	clip	of	the	selection	or	by
clicking	on	the	image	in	the	player.	To	deselect	clips	from	the	selection	hold	the	cmd	key	while	clicking.	Click	a
non	selected	clip	to	dissolve	the	selection.

Lightweight	Copy	of	Looks

The	Grid	View	can	be	useful	to	reference	and	compare	grades.	Therefore	it	can	be	handy	to	easily	copy	grades.	By
using		the	Look	library	in	the	right	bar	looks	can	be	easily	created	and	applied	to	one	or	multiple	clips.	All	necessary
functionality	can	be	found	in	the	“Look”	menu	of	the	Silverstack	Main	Menu:

Fig.	5:	The	“Look”	menu	with	functionality	to	create	and	apply	looks

Learn	more	about	the	Silverstack	Look	Library	in	the	article	The	Silverstack	Look	Library.

Grid	View	on

Grid	View	Functionality		per	Silverstack	Product	Version

The	Grid	View	functionality	differs	for	different	Silverstack	versions:

Silverstack:	No	Grid	View	available.
Silverstack	XT:	Grid	View	limited	to	2	clips.
Silverstack	Lab:	Grid	View	limited	to	12	clips	(due	to	performance	reasons).
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Creating	Reports

Creating	Reports

A	crucial	Silverstack	feature	is	the	 “Report”	functionality.	It	offers	you	the	opportunity	to	create	a	summary	of	all
the	clips	contained	by	the	selected	project	item.

Therefore	choose	a	project,	folder	or	bin	and	click	on	the	“Report”	wizard	in	the	Silverstack	toolbar	(figure	1).

figure	1:	The	toolbar

Different	Report	Types

Silverstack	offers	you	the	possibility	to	export	different	types	of	reports.	Each	one	of	them	is	designed	for	the
different	professionals	involved	in	the	production	process.	Additionally	you	can	customize	the	kind	of	information
shown	in	the	reports	(more	information	in	the	article	Customizing	Clip	Reports).

The	different	types	of	reports	are:

Shooting	Day	Report
Clips	Report
Thumbnail	Report
Contact	Print	Report
Volume	report.

Shooting	Day	Report

The	Shooting	Day	Report	(figure	2)	gives	you	production	information	about	the	clips	you	have	offloaded.	You	can
select	between	the	statistics,	labels,	backups,	ratings	formats	and	reels	to	show	up	in	the	report	(figure	3).		Enter
production	information	like	Director,	Cinematographer	and	DIT	in	the	production	field	in	the	tab	project
overview,	and	show	it	by	checking	the	according	checkbox	“Show	Production	Info”		at	the	bottom	of	the	reports
dialog.

fig.	2:	Shooting	day	report	options
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figure	3:	Example	of	a	Shooting	Day	Report	–	click	to	get	a	closer	look

Clips	Report

Clips	Report	(figure	6)	is	the	most	customizable	type	of	report.	It	exports	the	clip’s	metadata	you	choose	from	the
column	layouts.	You	can	also	use	a	preset	column	layout	with	important	information	for	different	professionals
involved	in	the	production	process	as	shown	in	figure	4	(see	dropdown	“Clip	Layout	Information”).	Column
layouts	can	be	managed	and	saved	from	the	toolbar	of	the	table	view	(see	fig.	5).	Please	see	the	article	Customizing
Clip	Report	for	more	information.

fig.	4:	Clips	Report	customization

figure	5:	Clips	Report	customization
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Figure	6:	example	of	a	Clips	Report	–	click	to	get	a	closer	look

Thumbnails	Report

Generates	a	report	similar	to	the	Clips	Report	but	with	bigger	thumbnails	to	help	with	the	identification	of	the	clips.
The	information	displayed	in	the	report	behaves	in	the	same	way	as	in	the	Clips	Report.

figure	7:	Thumbnail	Report	customization

Three	Thumbnails	per	Clip

Silverstack	by	default	creates	one	thumbnail	for	each	ingested	clip	that	is	saved	in	the	library.	This	thumbnail	is	be
used	for	referencing	clips	in	the	Clips,	Thumbnails	and	Contact	Print	Reports.

Since	Silverstack	6.3	Clips	and	Thumbnails	Reports	can	now	be	created	including	three	thumbnails	per
clip.	This	enables	an	advanced	reference	for	clips	in	reporting.

How	To

When	selecting	the	Clips	or	Thumbnails	Report	in	the	report	wizard	you	can	choose	“3	(requires	online	media)”
as	“Number	of	Thumbnails:”:

Fig.	8:	Select	the	number	of	thumbnails	to	include	in	the	report

During	the	export	process	Silverstack	creates	two	thumbnails	for	the	first	and	the	last	frame	of	the	clip	in	addition
to	the	custom	thumbnail.	In	contrast	to	a	single	thumbnail	report	that	accesses	the	custom	thumbnail,	the	three
thumbnails	report	requires	online	media	for	the	ad	hoc	creation	of	the	additional	thumbnails.

Position	of	Thumbnails

The	position	for	the	creation	of	the	additional	thumbnails	can	be	influenced	by	setting	in	and	out	points	for	a	clip.
The	position	of	the	custom	thumbnail	can	be	set	in	the	preferences.	Also,	thumbnail	creation	on	ingest	can	also	be
deactivated	in	the	preferences.

Additional	Thumbnails	Failed	to	Create
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If	the	thumbnail	creation	process	fails	it	can	have	different	reasons.	One	common,	simple	reason	is	offline	media.	If
the	report	fails	the	following	alert	will	be	shown:

Fig.	9:	The	alert	when	something	went	wrong	with	the	creation	of	additional	thumbnails.

Please	be	aware	that	if	no	custom	thumbnails	have	been	created	the	custom	thumbnail	will	show	a	placeholder	icon
in	the	reports.	Always	take	a	look	at	your	report	to	ensure	its	content.

Report	Examples	with	Three	Thumbnails

Fig.	10:	Example	of	a	Clips	report	with	three	thumbnails
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Fig.	11:	Example	of	a	Thumbnails	report	with	three	thumbnails

Contact	Print	Report

This	option	creates	a	report	displaying	only	the	thumbnails	of	the	library	element	selected.

figure	12:	Contact	Prints	Report	customization

Volume	Report

Volume	Report	(figure	14)	summarizes	the	information	regarding	the	source	and	current	location	of	the	different
copies	of	the	clips	registered	in	Silverstack.	In	order	to	make	this	option	available,	the	«Volumes»	folder	must	be
selected	from	the	Library	tab.	This	kind	of	report	can	also	contain	XX	Hash,	MD5	hash	and	SHA1	hash	information
to	confirm	data	integrity.

148

Silverstack	6	Manual	
Creating	Reports

https://kb.pomfort.com/wp-content/uploads/2018/01/Screen-Shot-2018-01-18-at-10.12.59.png
https://kb.pomfort.com/wp-content/uploads/2018/01/Screen-Shot-2018-01-17-at-17.50.08.png


figure	13	:	Volumes	Report	customization

Figure	14:	example	Volume	Report

Report	Naming	Scheme

When	saving	reports	the	naming	scheme	options	help	to	select	a	meaningful	naming	based	on	your	project	context.

Fig.15:	Saving	a	report
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There	are	preset	options	available	for	the	naming	of	the	reports:

fig.	16:	Report	naming	scheme	preset	options

In	addition	to	the	presets	the	“Custom:”	option	allows	to	build	a	file	name	based	on	available	metadata.	By	clicking
“Customize…”	you	can	open	the	metadata	wildcards	panel	and	choose	from	the	available	wildcards	to	build	a	custom
file	naming	scheme:

Fig.	17:	Available	wildcards	for	naming	the	report

Report	Formats

Silverstack	can	save	this	information	either	in	a	PDF-,	CSV-,	XML-	or	HTML-file.	With	the	formats	CSV	and	XML
you	can	create	files	that	you	can	import	in	spreadsheet	applications	like	Excel	or	Numbers.	Additionally	you	can
write	your	own	scripts	to	process	the	data.

“Print	Report”	Functionality

Additionally	to	the	“Report”	functionality,	Silverstack	offers	you	the	opportunity	to	directly	print	reports	for	each
level	of	your	project	tree.

To	print	a	report	of	all	clips	contained	by	one	folder,	select	this	folder,	right-click	on	it	and	select	“ Print	Report…”
from	the	drop-down	menu.
The	described	steps	work	for:

Projects
Folders
Bins
Smart	folders
“Volumes”	items

Customising	Clip	Reports

Silverstack	includes	a	comprehensive	reporting	center.	We	created	it	to	give	you	more	flexibility	and	possibilities	in
your	daily	workflow.

Overview
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Create	customized	reports	with	the	new	Silverstack	–	documenting	your	entire	offload	and	backup	tasks.	Silverstack
consolidates	it’s	flexible	reporting	capabilities	in	a	powerful	reporting	center(see	figure	1),	providing	customized
reports	for	production	and	post-production.	Silverstack	provides	shooting	day	reports	with	thumbnails	and
metadata	as	well	as	comprehensive,	statistical	summaries	in	well-arranged	and	beautiful	PDF	document.	Reports
include	all	the	necessary	metadata	to	document	camera	media	traveling	to	workflow	steps	down	the	road.

Silverstack	can	customize	clip	reports	by	right	clicking	on	the	table	view	columns	like	in	figure	2.	The	same
customized	table	view	will	show	up	in	your	clip	reports.	Simply	select	your	required	data	and	proceed	to	the	report
center	to	create	a	Clip	Report.	You	can	also	customize	your	thumbnails	to	get	a	better	preview	in	your	reports.	For
more	info	refer	to	the	article	Choosing	custom	thumbnails	images.

figure	1:	“Reporting	Center”

figure	2:	“Customizing	the	table	view	for	a	Clip	Report”

Additionally	you	can	save	your	customized	table	view	preset	and	manage	it.	We	also	offer	presets	created	in
collaboration	with	experienced	DITs	from	all	over	the	world.	We	are	always	pleased	to	hear	your	feedback	and
request	for	improved	reporting.	Please	contact	therefore	support@pomfort.com
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figure	3:	“Saving	a	customized	table	view”
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Metadata	Handling

Metadata	Handling:	View,	Organize,	Add,	and	Filter	Clips

The	clip	library	is	the	core	of	Silverstack.	It	easily	enables	you	to	inspect	all	the	metadata	of	your	clips	and	let	you
organize	all	your	clips	by	these	metadata.	During	offload	and	backup	all	clips	and	files	plus	their	file	copies	are
registered	in	the	Silverstack’s	clip	library.	Over	time	using	Silverstack	in	your	production	you	always	have	access	to
these	clip	metadata	which	refer	to	your	project	based	media	files.	During	all	organizing	and	editing	tasks	Silverstack
never	modifies	the	data	of	the	original	and	their	backups	but	saves	all	changes	separately.

We	will	give	you	a	short	overview	about	how	to	modify	and	add	metadata	in	the	clip	library:

Enter	Metadata

Metadata	(metacontent)	is	defined	as	data	providing	information	about	one	or	more	aspects	of	your	clips,	for
example	such	as:

Timecode
Resolution
Sensor
Frame	Rate
Take,	Shot,	Scene
Reel	name

A	lot	of	clip	metadata	like	resolution,	reelname,	or	exposure	is	already	added	to	your	clips	by	the	camera	and	is
therefore	not	editable.	Non-technical	metadata	like	scene/shot/take	information	however	can	be	edited	but	is	not
stored	within	the	original	video	files.	Instead	Silverstack	saves	this	editable	information	and	links	it	to	the
corresponding	clip	file.	You	can	add	a	lot	of	this	supplementary	metadata	very	easily	in	Silverstack.

You	can	edit	metadata	in	the	Silverstack	Information	panel,	in	the	“General”	(figure	1	#1)	and	“User”	tab	(figure	1
#2).	Information	edited	in	the	“General”	tab	can	be	applied	to	several	selected	clips.	For	doing	so,	click	on	the	small
pen	symbol	(figure	1	#3)	right	to	the	metadata	field.	Make	your	desired	changes	and	enter	the	information	by
clicking	“Apply”.

figure	1:	Information	panel

Metadata	like	comments,	ratings,	flaggings	etc.	can	be	edited	in	the	“User”	partition	(figure	2)	and	affect	exclusively
the	currently	active	clip.

Flag:	By	flagging	a	clip	(figure	2	#1)	you	brand	it	with	a	flag	symbol	which	can	be	interpreted	individually.
Rating:	You	can	rate	each	clip	(figure	2	#2)	by	assigning	a	range	of	zero	to	five	stars	to	it.
Comment:	Save	important	information	regarding	a	clip	by	commenting	(figure	2	#3)	it.
Label:	Each	clip	can	be	labelled	(figure	2	#4)	and	thus	be	categorized.	Each	label	in	the	drop-down	menu	can
be	edited	in	the	application	preferences.	You	get	there	pretty	fast	by	clicking	on	“Edit..”	in	the	drop-down
menu	as	you	can	see	in	figure	2	#5.

153

Silverstack	6	Manual	
Metadata	Handling



figure	2:	Information	panel	–	“User”	section

Cue	Points:	The	cue	points	table	(figure	3)	shows	all	set	markers	for	this	clip	(#1).	For	a	better	overview
of	your	markers,	within	a	clip	you	can	assign	each	marker	to	one	of	a	set	of	predefined	categories	(#2)
and	also	search	for	them	(#4).	You	can	add	new	markers,	delete	existing	and	jump	to	the	next	by	the
buttons	in	the	lower	left	corner	(#3).

figure	3:	Information	panel	–	“User”	section:	Cue	points

Using	the	Clip	Information	View

To	inspect,	edit,	and	add	metadata	you	can	use	the	information	view.	To	activate	it	switch	the	view	on	the	left	from
“Library”	to	“Information”.

The	Information	view	provides	several	subviews:

General	Info	–		Overview	of	the	clip’s	metadata
User	Info	–	Additional	metadata	like	ratings,comments,	and	cue-points
File	Info	–	List	of	file	resources,	showing	the	different	disk	the	clip	was	copied	to
Header	Info	–	Detailed	information	of	all	metadata	extracted	from	the	clip

Using	the	table	view

Silverstack’s	clip	table	view	is	a	great	way	to	get	an	overview	of	the	various	metadata	of	a	set	of	clips.	Some	of	the
fields	are	editable	and	you	can	jump	from	field	to	field	by	pressing	the	TAB	key.

Secondary	click	on	the	table	header	to	show	or	hide	metadata	fields.	You	can	also	rearrange	table	columns	by
dragging	the	columns	headers.

Using	the	Quick	Entry	panels
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In	the	playback	view	the	“Quick	Entry”	panels	allow	you	to	easily	set	metadata	for	the	current	clip	via	keyboard
shortcuts	in	a	very	fast	way.	Here	is	an	overview	of	the	available	commands:

1.	 Rating	⇧+⌘+A
2.	 Comment	⇧+⌘+S
3.	 Label	⇧+⌘+D
4.	 Scene/Shot/Take	⇧+⌘+T	(figure	4)

You	can	also	trigger	the	panels	from	the	Silverstack	menu:	Edit	>	Clip	>	Quick	Entry

figure	4:	Quick	Entry	panel	for	Scene/Shot/Take	information

Filter	By	Metadata

The	more	metadata	you	have	added	to	your	library	the	better	you	can	use	it	to	organize	your	clips	using	some
metadata	attributes.

Search

You	can	query	all	metadata	fields	by	using	the	search	field	in	the	upper	right	of	Silverstack	.	To	search	for	cue	points
use	the	search	field	at	the	bottom	of	the	“User”	tab	within	the	information	panel	(figure	3	#4).

Smart	folders

Smart	folders	are	folders	that	show	all	clips	that	match	some	criteria.	Silverstack	creates	some	smart	folders	by
default	like	“Registered	today”	a	folder	that	contains	all	clips	that	were	added	to	the	library	today.

To	create	your	own	smart	folders,	just	click	on	the	“+”	button	in	the	lower	left	and	choose	“Add	Smart	Folder”.

Adding	a	smart	folder	showing	the	flagged	clips	of	the	last	week

You	can	now	specify	the	criteria	a	clip	has	to	fulfill	in	order	to	be	added	to	the	smart	folder.	If	you	are	adding	more
than	one	filter	option,	you	have	to	choose	if	the	clip	has	to	fulfill	only	one	or	all	of	it.	The	example	above	show	a
simple	smart	folder	showing	all	the	clips	that	are	flagged	and	that	were	registered	during	the	last	week.

Export	Metadata

To	really	leverage	your	metadata	you	might	want	to	export	the	information	for	usage	in	other	tools	of	your	digital
cinema	workflow,	Silverstack	provides	the	following	export	options:

Reports	–	Create	a	report	that	contains	an	overview	on	all	clips	and	save	it	as	pdf/html.
CSV,	XML	–	Create	files	that	you	can	import	in	spreadsheet	applications	like	Excel	or	Numbers.	Or	write	your
own	scripts	to	process	the	data.
Transfer	to	Final	Cut	Pro	–	Get	your	clips	and	the	metadata	into	Final	Cut	Pro	7	and	X.
Transfer	to	AVID	Media	Composer	–	Get	clips	and	metadata	into	AVID	using	ALE	files.

For	further	information	about	the	Silverstack	“Transfer”	function	go	to	the	respective	article	Transfer.

Note:	Not	every	transfer	format	can	carry	the	same	amount	of	information.	That	is	why	metadata	workflows	differ
from	format	to	format	and	thus	from	tool	to	tool.

Tips	&	Tricks:	Quick	metadata	editing

The	clip	library	is	the	core	of	Silverstack.	With	this	guide	we	would	like	to	give	you	some	tips	to	speed	up	the
metadata	editing	process.	During	offload	and	backup	all	clips	and	files	are	registered	in	the	library	and	metadata	can
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be	added	while	still	copying	the	files.

Here	are	some	features	that	might	improve	your	metadata	workflow	in	Silverstack:

1.	Batch	metadata	editing

Silverstack	offers	the	possibility	to	add	metadata	to	multiple	clips	at	a	time.	Simply	select	the	different	clips	in	the
table	and	list	view	and	click	the	edit	button	from	the	metadata	field	on	the	right	panel	(figure	1	#1).	Make	sure	to
check	the	«Apply	to	selection»	check	box	(figure	1	#2)	to	modify	all	the	selected	clips.

figure	1:	Batch	metadata	entry	and	sequential	suffix

2.	Sequential	suffix

Silverstack	lets	you	add	a	sequential	suffix	to	certain	clip	metadata	fields:

Clip	name
Scene
Shot
Take
Reel	name
Lens
Look	name
Filter

To	use	this	feature,	simply	write	the	fixed	element	of	the	name	in	the	«New	value»	and	the	starting	value	of	the
sequence	(integer	number,	letter)	in	the	«Sequential	suffix»	box	(figure	1	#3).	For	example	enter:	New	Value:	“Reel”
and	Sequential	Suffix:	“1”	and	the	result	is	“Reel1”,	“Reel2”,	“Reel3”,	etc.

3.	Quick	Entry

In	the	Playback	View	the	«Quick	Entry»	panels	allow	you	to	easily	set	metadata	for	the	current	clip	via	keyboard
shortcuts	in	a	very	fast	way.	Here	is	an	overview	of	the	available	commands:

Rating	⇧+⌘+A
Comment	⇧+⌘+S
Label	⇧+⌘+D
Scene/Shot/Take	⇧+⌘+T
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figure	2:	Quick	Entry	panels	for	Scene/Shot/Take	information

You	can	also	trigger	the	panels	from	the	Silverstack	menu:	Edit	>	Clip	>	Quick	Entry

4.	Keyboard	shortcuts

Silverstack’s	metadata	related	keyboard	shortcuts:

⇧⌘	=					Increase	rating
⌘	–					Decrease	rating
⌃	0					Clear
⌃	1					Set	rating	to	1
⌃	2					Set	rating	to	2
⌃	3					Set	rating	to	3
⌃	4					Set	rating	to	4
⌃	5					Set	rating	to	5
⌃A				Increase	scene
⌃Z				Decrease	scene
⌃S					Increase	shot
⌃X				Decrease	shot
⌃D				Increase	take
⌃C				Decrease	take
⌥⌘	+					Increase	label
⌥⌘	–					Decrease	label
⌥⌘	0					No	Label
⌥⌘	1					Best	Take
⌥⌘	2					Average	Take
⌥⌘	3					Moderate	Take
⌥⌘	4					B	Roll
⌥⌘	5					Alternate	Shots
⌥⌘	6					Interviews
⌥⌘	7					Pomfortionös

Transfer	metadata	to	FCP	7,	FCP	X,	AVID	Media	Composer,	and	Speedgrade

To	process	your	clips	in	other	Tools	like	Avid	Media	Composer,	FinalCut	or	Speedgrade	you	can	use	transfer
wizards.

Navigate	to	the	level	in	your	project	tree	that	contains	the	clips	you	want	to	transfer	and	click	“Export ”	in	the	actions
bar.	Now	choose	the	desired	program	to	transfer	your	clips,	the	clip	metadata	and	other	useful	information.
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figure	2:	Final	Cut	Pro	7	(XML)

figure	3:	Final	Cut	Pro	X	(XML)

figure	4:	Avid	Media	Composer	(ALE)
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figure	5:	Speedgrade/FrameCycler	(IRCP)

After	you	have	selected	the	proper	program	a	corresponding	“Export ”	wizard	(figure	6)	opens	up.	Choose	the	clips
and	then	specify	the	export	options	as	you	can	see	them	in	figures	2	–	5.

figure	6:	Silverstack	“Transfer”-wizard	for	Final	Cut	Pro	7

In	the	transfer	process	Silverstack	transfers	the	edited	information	relating	to	the	particular	clip	along	with	a	link	to
its	original	clip’s	storage	location.	It	never	overwrites	the	original	clip’s	metadata.

If	you	want	to	transfer	your	clips	to	Final	Cut	Pro	X,	you	find	a	short	explanation	of	the	menu	items	affecting	the
metadata	in	the	“Export”	dialog	in	the	article	Transfer	metadata	to	FCP	X.	There	is	another	article	for	transferring
metadata	into	Avid	Media	Composer.

If	you	want	to	export	only	metadata	of	one	or	several	clips	as	a	pdf/	cvs/	xml/	html,	Silverstack	provides	you	the
“Creating	Reports”	function	for	that	case.

Transferring	Metadata	to	Final	Cut	Pro	X

For	the	transfer	of	metadata	via	Final	Cut	Pro	XML	files	(.fcpxml)	the	clip	metadata	is	mapped	accordingly	and
depending	on	the	user-defined	options	as	you	can	see	in	figure	1.
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figure	1:	“Transfer”-wizard	for	Final	Cut	Pro	X

Content	(figure	1	#1)

Scene,	shot	and	take	name	can	be	added	to	the	name	of	the	clip	in	Final	Cut	Pro	X
Various	color	information	can	also	be	transmitted.	Properties	as	camera	index,	whitepoint,	colorspace,
lookname,	ASA	and	label	from	Silverstack	are	mapped	to	keywords	in	Final	Cut	Pro	X
Single-frame	cue	points	from	Silverstack	are	mapped	to	markers	in	Final	Cut	Pro	X
Multi-frame	cue	points	from	Silverstack	are	mapped	to	a	clip	range	marked	with	a	keyword	in	Final	Cut	Pro	X
Clips	marked	as	flagged	in	Silverstack	are	marked	entirely	as	favorite	in	Final	Cut	Pro	X.
Clips	with	rating	“★”	(one	star)	in	Silverstack	are	marked	as	rejected	in	Final	Cut	Pro	X.

Color	Processing	(figure	1	#2-4)

By	transferring	your	clips	to	Final	Cut	Pro	X	you	can	apply	different	color	plugins	in	this	step:

for	Cinestyle	clips:	DSLR	Log2Video	Plugin	(#2)
for	SLog	clips:	SLog2Video	Plugin	(#3)
for	clips	in	LogC:	apply	Alexa	log	or	looks	(#4)

Import	options	(figure	1	#5)

You	can	either	immediately	open	the	selected	clips	in	Final	Cut	Pro	X	or	save	them	first	as	Final	Cut	Pro	XML	files.

figure	2:	From	Silverstack	transferred	video	clip	in	Final	Cut	Pro	X

Mapping	of	metadata	from	Silverstack	to	Final	Cut	Pro	X

For	the	transfer	of	metadata	via	Final	Cut	Pro	XML	files	(.fcpxml)	metadata	is	mapped	accordingly	(depending	on
the	user-defined	options):

The	range	between	in-	and	out-points	in	Silverstack	is	marked	with	Keyword	“In-Out”	in	Final	Cut	Pro	X.
Properties	camera	index,	whitepoint,	colorspace,	lookname,	ASA	and	label	from	Silverstack	are	mapped	to
Keywords	in	Final	Cut	Pro	X.
Single-frame	cue	points	from	Silverstack	are	mapped	to	markers	in	Final	Cut	Pro	X.
Multi-frame	cue	points	from	Silverstack	are	mapped	to	a	clip	range	marked	with	a	keyword	in	Final	Cut	Pro	X.
Clips	marked	as	flagged	in	Silverstack	are	marked	entirely	as	favorite	in	Final	Cut	Pro	X.
Clips	with	rating	“★”	(one	star)	in	Silverstack	are	marked	as	rejected	in	Final	Cut	Pro	X.

Transfer	Clips	to	DaVinci	Resolve	Including	Clip	and	Color	Metadata

Silverstack	offers	a	solution	to	export	clips	to	DaVinci	Resolve	including	clip	metadata	as	well	as	ASC-CDL	color
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metadata.	Additionally	it	is	possible	to	set	up	Resolve	with	the	according	LUTs	to	reflect	the	exact	node	based	color
processing	done	in	Silverstack.

How	to	Transfer	Clips	from	Silverstack	to	a	DaVinci	Resolve	Timeline

The	steps	to	perform	to	transfer	a	bin	from	Silverstack	to	a	Resolve	timeline	including	clip	and	color	metadata	are	in
detail:

1.	 Export	FCPXML	as	well	as	additional	clip	and	color	metadata	from	Silverstack
2.	 Import	FCPXML	into	DaVinci	Resolve
3.	 Use	the	CSV	import	function	in	DaVinci	Resolve	to	add	clip	metadata
4.	 Use	the	Colortrace	function	in	Resolve	to	add	ASC-CDL	color	data

Export	FCPXML	and	Additional	Clip	and	Color	Metadata	from	Silverstack

To	export	to	Resolve	select	the	desired	bin	from	the	Silverstack	Library.	Either	perform	a	secondary	(right)	click	on
the	bin	and	select	“Export	to	>	Davinci	Resolve	Export”	or	from	the	“Export”	button	in	the	title	bar	of
Silverstack	choose	“DaVinci	Resolve	Export”.

You	will	be	presented	with	a	window	where	you	can	select	or	deselect	clips	from	the	bin	that	should	be	exported:

Figure	1:	Choose	clips	and	media	files	for	Davinci	Resolve	export

After	making	your	selection	click	“Continue”.

A	further	dialog	window	opens	up:
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Figure	2:	Davinci	Resolve	export	options

It	lets	you	choose	from	three	export	options	:

Timeline	(.fcpxml):	This	export	item	is	responsible	for	creating	the	timeline	and	populating	the	clips	in
Resolve.
Color	metadata/Looks	(.edl	and	.ccc):	These	export	items	are	responsible	for	adding	the	color	metadata
(ASC-CDL	settings)	to	the	clips	in	Resolve	(via	Colortrace	functionality).
Clip	metadata	(.csv):		This	export	item	is	responsible	for	adding	the	clip	metadata	to	the	clips	in	Resolve.

To	result	with	a	timeline,	clip	and	color	metadata	activate	all	three	checkboxes	and	click	“Export…”.	Select
the	desired	destination	for	the	files.	The	FCPXML,	EDL,	CCC	and	CSV	file	will	be	put	in	the	same	directory
automatically.

Import	FCPXML	into	DaVinci	Resolve

Open	up	DaVinci	Resolve	and	create	a	new	project.

From	the	Main	Menu	choose	“File	>	Import	AAF,	EDL,	XML”.	Navigate	to	the	path	where	you	saved	the
FCPXML	from	Silverstack	select	it	and	click	open.

You	will	be	presented	with	an	option	window	for	loading	XMLs:
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Figure	3:	Preferences	for	loading	an	XML	in	DaVince	Resolve

Check	to	have	the	checkbox	“Automatically	set	project	settings”	enabled	which	should	be	the	case	by	default.
That	makes	sure	all	settings	will	be	adapted	to	match	the	clips	from	the	FCPXML.

Click	“Ok”.
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Figure	4:	The	main	window	of	Resolve	with	the	imported	timeline

You	should	be	presented	with	the	“Edit”	tab	in	Resolve	that	shows	the	Media	Pool	on	the	left	and	a	timeline
containing	all	the	clips	from	the	Silverstack	bin	you	formerly	exported.

How	to	Add	Clip	Metadata	to	the	Clips	in	the	Timeline

This	process	will	only	work	in	Resolve	12.5	or	later.

Go	to	the	“Edit”	tab	in	Resolve.	From	the	Main	Menu	choose	“File	>	Import	metadata	to…	>	Media	Pool”:

Figure	5:	Import	metadata	from	the	csv

In	the	following	opening	dialog	choose	the	.csv	file	that	you	exported	from	Silverstack	and	click	open.

A	metadata	import	window	will	follow:
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Figure	6:	Metadata	import	options

Choose	a	meaningful	combination	of	Import	Options	and	Merge	Options	for	your	use	case.	Hit	“Ok”.

All	matching	clips	in	the	bin	should	now	have	received	the	new	metadata.	Select	a	clip	and	check	the	metadata
section	on	the	right	side	of	the	Resolve	window	for	the	results.

The	FCPXML	will	already	transfer	a	basic	set	of	metadata.	The	additional	metadata	that	can	be	transferred	from
Silverstack	via	the	.csv	file	is	in	detail	:

Scene	[Scene]
Shot	[Shot]
Take	[Take]
Episode	[Episode	Name]
Label	[Clip	Color]
Flagged	[Good	Take]
Comment	[Comments]
Camera	ID	[Camera	#]
LUT	Nodes	[LUT	1]
CDL	SOP	[CDL	SOP]
CDL	SAT	[CDL	SAT]
Director	[Director]
Cinematographer	[DOP]
Production	[Production	Name]
Producer	[Producer]
Camera	Assistant	[Camera	Assistant]
Data	Manager	[Digital	Technician]
DIT	[Dailies	Colourist]
Location	[Location]
Lens	[Lens	Type]
Color	Space	[Color	Space	Notes]

The	labels	in	the	brackets	reflect	the	naming	of	the	Resolve	metadata	fields	the	Silverstack	metadata	is	mapped	to.

Setting	the	Reel	Name

To	attain	a	proper	match	of	the	CDL	values	per	clip	you	have	to	make	sure	that	the	Reel	Names	of	the	clips	and	the
Reel	Names	in	the	Silverstack	EDL	match.
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In	the	Project	Settings		go	to	“Master	Project	Settings”	and	inside	of	that	to	“Conform	Options”.	Make	sure	to
check	“Assist	using	reel	names	from	the:”	checkbox:

Figure	7:	Set	the	Project	Settings	Conform	Options	for	the	right	reel	name	handling	for	Color	Trace	matching

Based	on	your	clip	types	as	well	as	path	structure	and	clip	file	names	the	settings	that	match	your	workflow	could
differ.

Selecting	“Embedding	in	Source	clip	file”	as	an	option	should	work	for	QT	ProRes	and	ARRIRAW	workflows.

Search	the	DaVinci	Resolve	manual	for	“extraction	pattern	operators”	to	learn	how	to	use	extraction	patterns
to	pull	reel	names	from	your	media	paths.

Please	be	aware	that	the	ColorTrace	matching	wizard	will	also	give	you	the	opportunity	to	 “Ignore	Reel	Names”
(see	also	Fig.	9)	.

How	to	Add	Color	Metadata	to	the	Clips	in	the	Timeline

Use	the	Colortrace	Function	to	add	ASC-CDL	color	metadata.

After	creating	the	timeline	you	will	be	able	to	add	the	color	information.

Select	the	timeline	from	the	media	pool.	It	should	be	marked	with	a	little	XML	indicator	on	its	lefthand	side.
Perform	a	secondary	(right)	click	on	it	and	choose	“Timelines	>	ColorTrace	>	ColorTrace	from	CDL”	from
the	context	menu:
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Figure	8:	Select	ColorTrace	from	CDL

You	will	be	presented	with	an	open	dialog	where	you	will	first	have	to	choose	the	exported	EDL	file.	Right	after	that
you	will	have	to	choose	the	exported	CCC	file.

After	opening	both	of	them	you	will	be	presented	with	the	ColorTrace	option	window:

Figure	9:	The	ColorTrace	option	window

If	all	the	clips	have	green	borders	everything	matches	fine.	Click	“Copy	Grade	and	Exit”	to	copy	the	according
grades	to	the	clips.

Switching	to	the	Color	tab	presents	you	with	the	clips	that	now	have	the	ASC-CDL	color	metadata	from	Silverstack
added:
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Figure	10:	Switch	to	the	color	tab	to	see	the	clips	with	added	color	metadata

Transfer	Color	Metadata	to	Assimilate	Scratch

You	can	export	an	.ale	from	Silverstack	to	transfer	ASC-CDL	color	metadata	to	Assimilate	Scratch.	Assimilate
Scratch	matches	the	according	CDL	values	to	the	loaded	clips	and	translates	them	into	looks.

Exporting	an	ALE	from	Silverstack	Including	ASC-CDL	Color	Information

To	export	an	.ale	file	from	Silverstack	go	to	the	header	bar	and	choose	 “Export”	:

Fig.1:	Choose	Assimilate	Scratch	from	the	Export	options.

Choose	“Assimilate	Scratch	(ALE)”	and	a	wizard	window	will	open:
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Fig.	2:	Choose	the	clip	you	want	to	export	in	the	ale.

Select	the	clips	you	want	to	export	and	click	 “Continue”.

In	the	next	window	choose	your	configuration:

Fig.	3:	Choose	the	ALE	export	options

Make	sure	the	“CDL	Values	in	ASC-SOP	&	ASC-SAT	column”	checkbox	is	checked	to	transfer	color	data	to
Assimilate	Scratch.

Click	“Save	ALE…”	to	save	the	.ale	file	to	the	intended	destination.
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Importing	an	ALE	in	Assimilate	Scratch	and	Matching	Color	Metadata

To	import	.ale	files	that	contain	color	information	in	Scratch	you	have	to	follow	4	consecutive	steps:

1.	 Import	the	clips	into	Scratch	that	you	want	to	apply	color	information	to.
2.	 Import	the	.ale	file.
3.	 Check	settings	for	matching	and	import.
4.	 Go	to	the	clip	view	and	find	the	ASC-CDL	values	affect	the	clips	accordingly.

Let’s	break	the	steps	down	into	detail:

Importing	the	Clips

Click	the	“Load	Clips”	button	from	the	lower	left	side	of	the	interface:

Fig.4:	Click	the	Load	Clips	button	to	add	clips	to	Scratch.

Choose	the	clips	you	exported	the	ALE	for	to	add	them	to	the	Scratch	project:

Fig.	5:	Clips	have	been	added	to	the	project

Importing	the	ALE	File	

Go	to	the	“Conform”	section	which	you	will	find	slightly	below	the	“Load	Clips”	button	you	just	used.	Click	the
“Import”	button	to	open	the	ALE:
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Fig.	6	:	Choose	“Import”	from	the	conform	options

Navigate	to	the	exported	ALE	and	click	“Open”.

Check	Settings	for	Matching	and	Import

You	will	see	the	matching	user	interface	where	now	the	ALE	data	will	be	matched	to	the	clips:

Fig.	7:	The	ale	matching	user	interface.

At	the	top	of	the	the	columns	from	the	.ale	you	can	select	the	action	that	should	be	performed	for	each	column.	Make
sure	you	have	the	“ASC-SOP”	and	“ASC-SAT”	columns	set	to	“Import”.	Matching	on	TC	or	File	Name	will	be
easiest	so	make	sure	to	that	at	least	one	of	those	columns,	or	any	other	you	want	to	match	based	on,	is	set	to
“Match	on…”.	You	can	make	that	selection	from	the	drop	down	on	top	of	every	column.

Click	“Start	Matching”	to	match	the	metadata	(including	the	ASC-CDL	data)	to	the	clips	according	to	your
settings.

While	then	selecting	the	different	rows	in	the	ALE		you	will	see	the	clips	the	data	will	be	matched	to	in	the	right	bar
of	the	wizard.
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Fig.	8:	The	metadata	has	been	connected	to	the	clips.

Click	“Execute”	when	you	are	happy	with	the	match	and	want	the	metadata	to	be	taken	over	to	the	clips.

Go	to	the	Clip	View	and	Find	the	ASC-CDL	Values	Affect	the	Clips	Accordingly

Double	click	a	clip	to	reach	the	clip	detail	view:

Fig.	9:	The	detailed	view	of	the	clip	in	Scratch
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Select	“Matrix”	from	the	display	options	on	the	right	side	and	“Numeric”	from	the	panel	on	the	left	side.	You	will
then	see	how	the	color	settings	have	been	affected	by	the	imported	ASC-CDL	data.

	If	working	in	Assimilate	Scratch	on	a	PC	monitor	you	have	to	set	the	right	gamma	to	match	the	look	of	the	clips	to
the	perception	inside	Silverstack.	Go	to	the	Assimilate	Scratch	global	settings	to	change	the	gamma	if	needed.	Please
be	aware	of	the	ColorSync	settings	in	Silverstack	as	well	(read	about	the	setting	in	the	article	Using	Silverstack’s	Full
Screen	Mode).

Maintaining	Grades	and	Clip	Metadata	Throughout	Production

The	use	of	Pomfort’s	LiveGrade	and	Silverstack	in	combination	with	Assimilate	Scratch	allows	for	an	integrated
workflow	that	involves	the	preservation	of	clip	and	grade	metadata	throughout	the	process.

Looks	generated	with	LiveGrade	can	easily	be	matched	to	the	clips	inside	Silverstack.	This	workflow	is	also
described	in	the	article	Look	Matching.

Silverstack	can	then	export	an	ALE	that	contains	information	about	the	LUT	in	the	grade	for	each	clip.	By	using	the
LUT	files	along	with	the	ASC-CDL	data	and	the	automatic	matching	process	inside	Assimilate	Scratch,	unique
grades	can	easily	be	transferred	for	each	individual	clip.

This	tutorial	made	by	Assimilate	Scratch	will	give	you	detailed	insights	on	the	workflow:

Transferring	Metadata	to	Avid	Media	Composer

To	transfer	clips	and	their	corresponding	metadata	information	from	Silverstack	to	Avid	Media	Composer	the
following	two	steps	have	to	be	performed:

Create	an	Avid	Log	Exchange	(ALE)	file	containing	the	metadata	of	the	relevant	clips	in	Silverstack
The	information	from	the	ALE	file	has	to	be	merged	with	available	master	clips	in	the	Avid	Media	Composer.

Creation	of	an	ALE	file	in	Silverstack

1.	Generating	an	ALE	file	is	part	of	the	Transfer	process	in	Silverstack.	So	select	the	bin	which	contains	the
relevant	clips,	click	on	the	“Transfer”	button	in	the	TabBar	of	the	Silverstack	window	and	choose	“ to	Avid
Media	Composer	(ALE)”.

2.	Thereon	select	the	clips	you	want	to	transfer	in	the	wizard	that	opens	up.

3.	In	the	following	you	have	to	select	the	 information	to	be	transferred	(figure	1	#1).

Besides	the	required	general	information	you	can	additionally	select	master	information	(as	scene,	shot,	take
etc.),	exposure	information	(as	ASA,	whitepoint,	shutter	etc.),	format	information	(as	resoluion,	FPS,	codec
etc.),	user	information	(as	flaging,	rating	etc.)	and	a	file	information	summary.

4.	The	metadata	is	transferred	to	the	Avid	Media	Composer	via	the	ALE	file	and	is	only	there	matched	with	the
clips	(figure	1	#2)	.		The	matching	can	be	performed	according	to	following	metadata	information:	source	file,
the	reel	name	in	the	tape	column	or	the	source	file	in	the	tape	column.

5.	Click	on	“Save	ALE…”.
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figure	1:	Transfer	dialog	for	Avid	Media	Composer	–	transfer	options

Merging	information	from	the	ALE	file	with	master	clips

1.	 After	having	created	the	ALE	file	go	to	the	Avid	Media	Composer	and	import	the	clips	if	not	done	so	far.	They
should	thereon	be	available	as	master	clips.

2.	 Select	the	bin	in	the	Avid	Media	Composer	which	contains	the	relevant	clips.
3.	 Select	those	clips	and	choose	“Input	>	Import	Media…”	from	the	context	menu	in	the	bin.
4.	 Open	the	“Options”,	then	click	on	“Options…”	navigate	to	the	Shot	Log	tab	and	select	“Merge	events	with
known	master	clips”.

5.	 Navigate	to	the	ALE	file	you	created	before	and	click	“Open”.

Avid	Media	Composer	now	matches	master	clips	and	metadata	information	from	the	ALE	file	according	to	their
timecode	and	the	criteria	you	selected	during	the	transfer	process	within	Silverstack	.

The	information	from	the	ALE	file	is	attached	within	additional	columns	in	the	bin	table	as	in	figure	2.	Some	of	the
columns	are	already	known	by	the	Avid	Media	Composer,	all	unknown	information	will	be	added	as	custom
columns.

figure	2:	Avid	Media	Composer:	Extended	metadata	after	the	ALE	import

If	you	cannot	see	any	custom	columns,	perform	the	following	steps:

1.	 Close	and	re-open	the	bin
2.	 Right-click	in	the	free	space	of	the	bin	window	and	click	on	“Choose	columns…”	in	the	context	menu.
3.	 Then	select	and	unselect	columns,	the	custom	columns	from	the	imported	ALE	file	you	will	find	at	the	end	of

the	list.

Transfer	Color	Metadata	to	AVID	Media	Composer

To	learn	about	the	basic	process	of	transferring	metadata	to	AVID	please	refer	to	the	article	 Transferring	Metadata
to	Avid	Media	Composer.	The	article	will	help	you	through	the	process	of	matching	metadata	from	an	ALE	file
generated	from	Silverstack	to	master	clips	in	Avid.

	Adding	Color	Metadata	to	the	ALE	Export

When	exporting	your	ALE	file	from	Silverstack	make	sure	you	have	the	checkbox	“CDL	Values	in	ASC-SOP	&
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ASC-SAT	column”	checked:

Figure	1:	Include	the	CDL	Values	in	the	according	columns	of	the	ale	file.

After	the	values	are	included	in	the	ALE	file	perform	the	same	steps	as	pointed	out	in	the	article	 Transferring
Metadata	to	Avid	Media	Composer.	The	result	will	be	clips	that	have	the	CDL	values	from	Silverstack	in	the
ASC_SAT	and	ASC_SOP	metadata	columns	in	AVID	Media	Composer.

Transforming	the	Color	Metadata	Information	into	Looks	in	AVID

We	will	now	use	the	color	metadata	information	from	the	ASC_SAT	and	ASC_SOP	column	to	apply	them	to	the
clips.

Select	all	clips	in	the	bin	you	merged	the	metadata	with.	Perform	a	right	click	on	the	film	reel	icon	on	the	left	of	an
arbitrary	clip:

Figure	2:	The	bin	with	selected	clips	and	the	reel	icons	marked.

From	the	context	menu	choose	“Source	Settings”.	You	will	see	the	following	window:
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Figure	3:	The	Source	Settings	with	the	Color	Encosing	tab	selected.

Make	sure	to	have	the	tab	“Color	Encoding”	selected	at	the	top	left	of	the	window.	Click	the	dropdown	indicator
in	the	menu	where	it	says	“Levels	scaling	(full	range	to	video	levels)”		below	the	“Color	transformations”
list.

You	will	see	a	list	of	transformations	to	choose	from:

Figure	4:	Choose	the	CDL	ASC_SOP	and	ASC_SAT	values	from	the	bottom	of	the	dropdown	list.

Scroll	down	to	the	bottom	of	the	list	and	select	the		 “CDL	ASC_SOP	ASC_SAT”	entry.	Click	“Add”	right	below
and	it	will	appear	in	the	“Color	transformations”	list:
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Figure	5	:	The	Source	Settings	with	CDL	values	in	the	Color	transformation	list.

Now	click	“Apply	to	All”	on	the	bottom	of	the	window	to	apply	the	according	CDL	values	to	every	clip.	Click	 “OK”
to	leave	the	wizard.	Every	clip	will	now	receive	the	look	that	is	generated	from	its	associated	values	in	the	ASC_SAT
and	ASC_SOP	columns.

Adding	a	3D	LUT	to	the	Color	Processing

To	add	a	3D	LUT	again	select	all	the	clips	you	want	to	apply	a	LUT	to.	Perform	a	right	click	on	the	film	reel	icon	on
the	left	of	an	arbitrary	clip	and	from	the	context	menu	choose	“Source	Settings”.

Instead	of	choosing	“CDL	ASC_SOP	ASC_SAT”	from	the	dropdown	select	the	desired	LUT	and	click	“Add”	to	put
it	into	the	“Color	transformations”	list	above:

Figure	6:	The	source	settings	with	CDL	and	LUT	in	the	right	order	in	the	Color	transformations	list
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Make	sure	that	the	CDL	entry	is	on	top	of	the	LUT	entry	in	the	list.	They	will	be	applied	in	order	from	top	to	bottom
as	in	the	nodes	in	Silverstack.

Now	click	“Apply	to	All”	to	add	the	LUT	to	all	the	selected	clips.	Then	click	“OK”	to	leave	the	wizard.	The	clips
will	now	all	have	and	additional	LUT	added	to	the	CDL	processing.

Exporting	Looks	from	Silverstack

It	is	possible	to	export	CDLs	and	3D	LUTs	from	the	Silverstack	Look	Library.	To	learn	more	about	the	Silverstack
Look	Library	please	refer	to	the	article	The	Silverstack	Look	Library.

To	export	the	desired	information	go	to	the	Look	Library	in	Silverstack	and	choose	one	or	more	looks	to
export.	Perform	a	secondary	click	(right-click)	on	one	of	the	selected	looks	and	from	the	context	menu	choose
“Export	selected	Looks”:

Figure	1:	Select	one	or	multiple	looks	for	export	and	with	a	secondary	click	open	the	context	menu.

You	will	then	be	pointed	to	a	save	dialog	where	you	will	be	able	to	choose	from	different	formats	for	the	export:
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Figure	2:	The	export	window	with	the	different	export	options.

You	can	choose	between	three	categories	to	export	your	look:

Looks
LUTs	for	Software
LUTs	for	Devices

Looks	include:

ASC-CDL	(.cdl,	for	all	grading	modes	where	possible)
Pomfort	Look	Exchange	Format	(.pfl,	for	Look	Exchange	with	LiveGrade	Pro)
Alexa	Look	(.xml,	for	ARRI	Alexa	compatible	look	export)
Amira	Look	(.aml,	for	ARRI	Amira	compatible	look	export)

LUTs	for	Software	include:

Pomfort	LiveGrade	(33x33x33,	RGB	order,	.cube	file)
Pomfort	Silverstack	(33x33x33,	RGB	order,	.cube	file)
Adobe	Speedgrade	(32x32x32	3D	LUT,	.cube	file)
Assimilate	Scratch	(32x32x32	.3dl	file)
Autodesk	Lustre	(33x33x33	.lut	file)
Colorfront	OSD	(17x17x17	.3dmesh	file)
Convergent	Design	Odyssey	(17x17x17	.cdlut	file)
DaVinci	Resolve	(33x33x33	3D	LUT,	.dat	file)
DigitalVision	Nucoda	(17x17x17	.cms	file)
Filmlight	Baselight	(32x32x32	.cube	file)
REDCINE	X	PRO	(33x33x33,	rgb	order	.cube	file)

LUTs	for	Devices	include:
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BlackmagicDesign	HDLink	Legal	to	Legal	(17x17x17	.cube	file)
BlackmagicDesign	HDLink	Extended	to	Extended	(17x17x17	.cube	file)
AJA	Lut	box	(17x17x17	.cube	file)
Panasonic	Varicam	(17x17x17,	rgb	order	.vlt	file)

Choose	the	desired	look	format	and	the	intended	directory	and	hit	“Save”.	You	will	then	be	able	to	use	the
exported	look	in	the	intended	destination	software	or	device.

Exporting	Look	Archives	from	Silverstack

You	can	export	complete	folders	with	looks	directly	from	the	Silverstack	Look	Library	into	a	Look	Archive	(.pfla).
To	do	that	select	one	or	multiple	folders	from	the	Silverstack	Look	Library.	Perform	a	secondary	click	(right	click)
and	select	“Export	selected	Folders	as	Look	Archive”		from	the	context	menu:

Figure	2:	Exporting	a	Look	Archive	from	a	folder	in	the	Silverstack	Look	Library.

In	the	following	wizard	select	the	directory	you	want	to	save	to	and	click	 “Save”.	The	.pfla	file	will	then	be	available
for	further	use	from	that	directory.

To	learn	how	to	import	a	Look	Archive	please	refer	to	the	article	Transferring	Looks	from	LiveGrade	to	Silverstack.

Transferring	Looks	from	LiveGrade	Pro	to	Silverstack

Silverstack’s	Look	Library	and	grading	controls	enable	you	to	receive	looks	from	LiveGrade.	You	can	choose	to
export	a	single	look	or	multiple	looks.	A	single	look	will	be	handled	as	a	Pomfort	Look	(.pfl)	file,	while
multiple	looks	will	be	put	together	into	a	Pomfort	Look	Archive	(.pfla)	file.	To	transfer	looks	from	LiveGrade
including	all	grading	nodes	and	their	settings	perform	the	following	steps.

Exporting	a	Look	from	LiveGrade

Select	the	desired	look(s)	in	the	library	of	LiveGrade.	In	the	main	menu	go	to	“File>Save	selected	Looks	As…”:
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Figure	1:	Save	selected	Looks	as

After	that	a	save	dialog	appears.	As	“Look	Format”	select	“Pomfort	Look	(.pfl)”	then	choose	the	name	and	the
destination	to	save	to:

Figure	2:	Save	dialog	for	“Pomfort	Looks”

More	information	about	creating	and	managing	looks	in	LiveGrade	can	be	found	in	the	articles	Grading	Modes	in
LiveGrade	and	Create	Clips,	Stills	and	Looks.

Importing	a	Look	into	Silverstack

Open	Silverstack.	Go	to	the	Main	Menu	and	select	“File>Import>Pomfort	Looks	(pfl)…”.

Figure	3:	Import	the	.pfl	file	into	Silverstack.

An	open	dialog	shows	up.	Navigate	to	the	previously	saved	.pfl	file	from	LiveGrade:
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Figure	4:	Open	dialog	for	Pomfort	Looks

Make	sure	that	Silverstack’s	Look	Library	in	the	right	info	bar	is	shown	(for	example	toggle	the	right	bar	from	the
toolbar).	Learn	how	to	use	the	Look	Library	in	Silverstack	from	the	article	The	Silverstack	Look	Library.	Go	to	the
Look	tab:

Figure	5:	The	Looks	section	with	the	imported	“Blueish”

The	look	from	LiveGrade	will	appear	in	the	“Looks”	section	containing:

Thumbnail
Look	name
Metadata

The	settings	of	the	grading	nodes	reflect	those	of	the	look	in	LiveGrade.	After	applying	the	look	to	the	desired	clip
you	will	be	able	to	modify	it	in	Silverstack	from	the	point	where	you	left	off	in	LiveGrade.

To	learn	more	about	the	grade	controls	in	Silverstack	please	refer	to	the	article	 Grading	Controls	in	Silverstack	5.

Exporting	a	Look	Archive	from	LiveGrade

A	Look	Archive	can	contain	one	or	multiple	looks	along	with	all	the	further	metadata	acquired	in	LiveGrade	Pro.
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To	export	a	Look	Archive	put	all	the	desired	looks	into	one	folder	in	the	LiveGrade	Look	Library.	Perform	a	right
click	on	that	folder	and	choose	“Export	Look	Archive”	from	the	context	menu:

Figure	6:	Exporting	a	Look	Archive	from	LiveGrade	Pro

Save	the	resulting	.pfla	(Pomfort	Look	Archive)	file	to	the	desired	destination.

Importing	a	Look	Archive	into	Silverstack

Go	to	the	looks	tab	in	the	Right	Bar	of	Silverstack.		In	the	Look	Library	perform	a	secondary	click	(right	click)

Figure	7:	Importing	a	Look	Archive	as	a	folder.

Select	the	desired	.pfla	(Pomfort	Look	Archive)	file	and	click.	The	Looks	from	the	Archive	will	then	be	available	in
the	newly	created	folders	in	the	Silverstack	Look	Library.

Import	metadata	via	MovieSlate

Introduction

When	importing	metadata	via	MovieSlate	XML	you	can	use	various	methods	to	match	the	clips	coming	from
MovieSlate	with	your	offloaded	Assets:

Timecode
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File	Name
Creation	Date

Timecode	Mode

This	mode	is	pretty	straight	forward,	it	will	compare	the	timecode	of	your	assets	and	look	for	the	corresponding
values	in	the	imported	MovieSlate	file.	If	the	timecode	of	MovieSlate	is	synced	with	the	camera	each	asset
automatically	matches	with	a	clip	from	the	MovieSlate	XML.	Matching	by	timecode	also	offers	the	possibility	to
automatically	set	the	in-point	to	the	slate	frame.

File	Name	Mode

The	File	Name	mode	works	literally	and	compares	the	exact	filenames	of	your	offloaded	assets	with	the	clips	from
the	imported	MovieSlate	XML.	Even	the	smallest	disparity	will	force	Silverstack	not	to	match	the	Assets	with	the
MovieSlate	metadata.

Creation	Date

This	mode	matches	the	creation	date	of	your	assets	with	the	creation	date	of	your	MovieSlate	clip	metadata.	This
mode	is	working	with	approximation.	You	have	a	“Tolerance”	slider	which	can	help	you	to	adjust	the	time	difference
between	the	camera	and	MovieSlate	clock.	You	have	a	range	from	1sec	up	to	two	minutes.	This	method	is	fuzzy	and
a	high	tolerance	can	lead	to	misinterpretations.

Further	articles:

	Step-by-Step	Tutorial:	How	to	import	via	Filename	Mode	

	Step-by-Step	Tutorial:	How	to	import	via	Timecode	&	Creation	Date	Mode	

Figure	1:	“Movie	Slate	Import	Wizard,	showing	5	matched	clips”

Transferring	Clips	and	Metadata	to	Adobe	Premiere	Pro

Silverstack	can	create	an	.xml	file	compatible	with	Adobe	Premiere	Pro	to	transfer	clips	and	clip	metadata	to	the
editing	tool.

Exporting	an	Adobe	Premiere	Pro	XML	from	Silverstack

The	export	option	can	be	accessed	from	the	“Export”	button	in	the	toolbar:
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Fig.	1:	The	export	menu

After	the	source	selection	step	you	can	define	content	and	format	options	for	the	exported	XML:

Fig.	2:	Content	and	format	option	for	the	XML	export

Content:	
General	Clip	Info:	Contains	the	basic	information	needed	to	transfer	clips	(file	paths,	etc.)
Master	Info:	Contains	Scene	Shot	Take	info	as	well	as	the	Reel	Name.

Scene	in	Silverstack	maps	to	“Scene”	column	in	Premiere	Pro
Shot	and	Take	in	Silverstack	map	to	the	“Shot”	column	in	Premiere	Pro	in	the	format	“Shot	–	Take”

User/QC	Info:	Contains	flag/circled	info	as	well	as	Comments	(maps	to	“Description”	column	in
Premiere	Pro)
General	clip	settings	as	Master	Comment	1:		Maps	general	clip	settings	(e.g.
InformationSensorFps,	ShutterAngle,	WhiteBalance,	ExposureIndexAsa,	ColorGamma)	to	the	Master
Comment	1	column	in	Premiere	Pro
Tags	as	Master	Comment	2:	Maps	the	tags	in	Silverstack	to	the	master	comments	2	in	Premiere	Pro.
Custom	1,	2	as	Master	Comment		3,4	:		Maps	the	custom	comment	fields	1	and	2	in	Silverstack	to
the	master	comments	3	and	4	in	Premiere	Pro
Labels	as	Clip	Colors:	Maps	the	labels	in	Silverstack	to	clip	colors	in	Premiere	Pro
Audio	Info:	Takes	over	the	Source	Audio	Clip	Names	column	and	the	#	of	Source	Audio	Tracks	Info	to
Clip	Comment	A	and	Clip	Comment	B	in	Premiere.
Cue	Points	as	Markers:	Maps	the	cue	points	in	Silverstack	to	the	markers	in	Adobe	Premiere	Pro.

Format:
Sets	the	Reel	Name	to

Reel	Name:	Sets	the	Reel	Name	of	the	XML	as	specified	in	the	Silverstack	“Reel	Name”	metadata
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field
Source	File	Name:	Sets	the	Reel	Name	of	the	XML	to	the	source	file	name	of	the	clip	in
Silverstack	(e.g.	A003C012_160205_R2VJ.mov)
Source	File	Name	Without	Extension:	Sets	the	Reel	Name	of	the	XML	to	the	source	file	name
without	extension	(e.g.	A003C012_160205_R2VJ)

In	Premiere	Pro	the	Reel	Name	of	the	XML	will	be	taken	over	to	the	Tape	Name	column.

After	defining	the	settings	click	“Save	XML…”	to	export	the	Adobe	Premiere	Pro	XML.

Creating	Synced	Sequences	in	Premiere	with	Audio	Sync	Information	from	Silverstack	XT	or
Silverstack	Lab

Overview	and	Use	Cases

Silverstack	can	provide	information	about	external	audio	clips	that	have	been	synced	to	Adobe	Premiere	to	create
synced	sequences	with	correctly	aligned	video	and	audio	tracks.

This	feature	helps	e.g.	to	implement	workflows	where	audio	clips	are	not	available	before	transcoding	and	are
synced	to	the	transcoded	clips	at	the	end	of	the	day.	Right	after	automatic	audio	sync	the	xml	with	audio	sync
information	can	be	exported	and	provides	synced	sequences	without	transcoding	again.

Another	use	case	could	be	bringing	camera	native	ProRes	files	into	edit	with	synced	audio	from	Silverstack.

How	To

After	syncing	external	audio	clips	with	the	video	clips	open	the	Premiere	Export:

Fig.	3:	The	Audio	option	in	the	Adobe	Premiere	XML	Export

Make	sure	to	mark	the	checkbox	“Include	audio	synced	sequences	and	referenced	audio	clips”.	This	will
equip	the	XML	with	the	necessary	information.

After	opening	the	XML	in	Premiere	Pro	you	will	obtain	the	following	folders:
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One	folder	that	contains	all	the	video	clips	(e.g.	A007R2VJ	(Editorial),	see	fig.	4)
One	folder	that	contains	all	the	audio	clips	synced	with	the	video	clips	(“Audio	Clips”	in	fig.	4)
One	folder	that	contains	the	“Synced	Clips	Sequences”

The	“Synced	Clips	Sequences”	are	Adobe	Premiere	Pro	editing	sequences	that	have	the	audio	in	sync	position	to
the	clips:

They	can	now	be	used	for	editing.

To	learn	more	about	audio	sync	with	external	audio	clips	in	Silverstack	Lab	and	Silverstack	XT	please	take	a	look	at
the	articles	How	To	Automatically	Sync	Audio	Based	on	Timecode	in	Silverstack	Lab	and	How	to	Manually	Sync
Audio	in	Silverstack	XT	and	Silverstack	Lab.

Mention	the	“special	setting”	for	editing	?

How	to	Open	an	XML	in	Premiere	Pro

After	saving	the	XML	from	Silverstack	you	can	go	ahead	and	open	the	XML	file	in	Premiere	Pro.

Open	Premiere	Pro.	Go	to	the	“File”	menu	and	choose	“Open	Project…“.	Choose	the	previously	exported	XML
file	and	click	“Open”.
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The	XML	will	import	as	a	bin	with	all	exported	clips	in	Premiere:

Fig.	4:	The	imported	XML	folder	in	Premiere	Pro

ZEISS	CP.3	XD	Lens	Correction:	Workflow	Overview

The	CP.3	eXtended	data	(CP.3	XD)	lenses	by	ZEISS	provide	extended	metadata	for	digitally	correcting	images
concerning	optical	shading	and	distortion	deviations.	Pomfort’s	applications	LiveGrade	Pro	and	Silverstack	provide
functionality	to	leverage	this	extended	metadata	for	on-set	preview	(LiveGrade	Pro)	and	data	management
(Silverstack).

Use	of	eXtended	Data	in	LiveGrade	Pro	and	Silverstack	XT	/	Silverstack	Lab

The	ZEISS	eXtended	data	can	be	used	for:

On-set	preview	with	LiveGrade	Pro
Extraction	of	recorded	lens	data	and	consolidation	with	clips	in	Silverstack	XT	and	Silverstack	Lab

The	schematic	overviews	give	you	an	idea	of	the	on-set	preview	and	lens	data	extraction	use	cases:

On-Set	Preview	of	Lens	Correction	with	LiveGrade	Pro

LiveGrade	Pro	is	able	to	receive	realtime	lens	correction	information	from	a	ZEISS	CP.3	XD	lens	that	is	connected	to
an	Ambient	MasterLockit	Plus.

Functionality

The	live	signal	of	the	camera	is	connected	to	a	hardware	capture	device	that	is	connected	via	Thunderbolt	to	the	Mac
running	LiveGrade	Pro	in	order	to	receive	a	live	image	in	the	application.	Read	the	articles	HD-SDI	Setup	for
LiveGrade	as	well	as	SDI	Recording	and	Frame	Grabs	for	more	information	about	live	image	capturing	in
LiveGrade.

LiveGrade	Pro	connects	via	Wifi	or	a	tethered	network	connection	to	the	MasterLockit	Plus	that	receives	live	lens
correction	data	from	the	ZEISS	CP.3	XD	lens.	The	live	lens	correction	data	can	be	applied	to	the	captured	live	signal
from	the	camera.

Learn	more	about	the	process	in	LiveGrade	Pro	in	the	article	ZEISS	CP.3	XD	Lens	Correction	in	LiveGrade	Pro	that
offers	a	detailed	description	of	the	features.

Extraction	and	Display	of	Recorded	Lens	Data	in	Silverstack
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Silverstack	XT	and	Silverstack	Lab	allow	to	import,	display	and	export	lens	correction	data	from	ZEISS	CP.3	XD
lenses.

Functionality

The	lens	correction	data	is	recorded	in	the	MasterLockit	Plus.	Clips	offloaded	in	Silverstack	hold	timecode
information	that	matches	the	recorded	lens	data	from	the	CP.3	XD	lens.	Silverstack	can	connect	to	the	MasterLockit
Plus	via	Wifi	or	a	tethered	network	connection	to	receive	the	recorded	lens	data	and	to	consolidate	it	with	the	clips
in	the	Silverstack	database.	After	that	step,	the	lens	correction	can	be	reviewed	in	the	Silverstack	player.

Furthermore	the	correction	data	can	be	exported	into	ZLCFs	(ZEISS	Lens	Correction	Files)	for	consecutive
production	steps	as	e.g.	the	use	in	the		“ZEISS	Lens	Correction”	plugin	ZEISS	provides	for	Blackmagic	Design’s
DaVinci	Resolve.

Learn	more	about	the	process	in	Silverstack	in	the	article	ZEISS	CP.3	XD	Lens	Correction	in	Silverstack	that	offers	a
detailed	description	of	the	functionalities.

Hardware	Overview

ZEISS	eXtended	data	can	be	recorded	via	an	external	LEMO	compatible	plug	onto	an	Ambient	MasterLockit	Plus:
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Exemplary	Setup	Using	an	ARRI	Alexa	Mini
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1.	 Connect	the	ZEISS	CP.3	XD	lens	via	the	metadata	cable	to	the	grey	ACN	port	of	the	MasterLockit	Plus
2.	 Connect	the	timecode	cable	from	the	TC	port	of	the	MasterLockit	Plus	to	the	TC	port	of	the	camera

Hardware	Components	for	LiveGrade	Pro	Workflow

The	following	hardware	components	are	involved:

ZEISS	CP.3	XD	lens
Camera
Ambient	MasterLockit	Plus
Cables

Lens	data	cable
Power	cables
Metadata	cables
Timecode	cables

Apple	Mac	/	Macbook	(Pro)
Blackmagic	Design	UltraStudio	Mini	Recorder	or	similar	recording	device

Thunderbolt	cable
HDMI	or	SDI	cable

Software
Pomfort	LiveGrade	Pro

Hardware	Components	for	Silverstack	Workflow

The	following	hardware	components	are	involved:

ZEISS	CP.3	XD	lens
Camera
Ambient	MasterLockit	Plus
Cables

Lens	data	cable
Power	cables
Metadata	cables
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Timecode	cables
Apple	Mac	/	Macbook	(Pro)
Software

Pomfort	Silverstack	XT	or	Silverstack	Lab

Additional	Information

What	is	eXtended	Data?

ZEISS	eXtended	Data	is	a	newly	developed	lens	data	technology.	It	is	based	on	the	Cooke	/i	technology	and	extends
the	functionality	with	additional	information	about	the	lens	characteristics	such	as	distortion	and	shading.	The
characteristics	are	calculated	in	real	time	for	every	focal	point	and	effective	T-stop.	The	lens	data	are	transferred
either	directly	to	camera	through	4-pin	Cooke	/i	interface	(PL	mount)	and	/	or	to	any	supported	equipment	via
external	cable.

ZEISS	CP.3	XD	Lens	Correction	in	Silverstack

Silverstack	XT	and	Silverstack	Lab	allow	to	import,	display	and	export	dynamic	lens	correction	data	from	ZEISS
CP.3	XD	lenses.	In	particular	this	involves	shading	and	distortion	correction	of	the	recorded	image.

Overview

The	following	steps	can	be	executed	in	Silverstack:

Import	lens	correction	data	directly	from	Ambient	Master	Lockit	Plus	to	consolidate	it	with	the	according
clips	in	the	library.
Display	and	review	shading	and	distortion	correction	via	the	ZEISS	lens	correction	panel	in
Silverstack.
Export	.ZLCF	lens	correction	files	to	transport	lens	correction	data	to	consecutive	applications	such	as
DaVinci	Resolve.

To	learn	more	about	the	general	workflow	please	visit	the	article	ZEISS	CP.3	XD	Lens	Correction:	Workflow
Overview.

Prior	to	importing	lens	correction	data,	clips	have	been	recorded	in	the	camera	with	the	MasterLockit	Plus	attached
to	camera	and	lens.

Import	Lens	Correction	Data	from	Ambient	Master	Lockit	Plus

The	lens	correction	data	saved	in	the	MasterLockit	Plus	holds	a	timecode	relation	to	the	clips	recorded	in	the
camera.	The	lens	correction	data	be	pulled	via	a	network	connection	from	the	MasterLockit	Plus	and	then	be
consolidated	with	the	clips	via	timecode

1.	 Offload	the	clips	that	have	been	recorded	with	lens	correction	data	into	the	Silverstack	Library
2.	 Open	the	Import	wizard	through	the	“Import”	button	in	the	toolbar:

Fig.	1:	Choose	MasterLockit	Plus	(CP.3XD	Lens	Data)	from	the	Import	menu

3.	 The	lens	data	import	wizard	opens.	Enter	the	MasterLockit	Plus	IP	Address	to	the	 “Master	Lockit
Address”	address	field	to	connect	to	the	Master	Lockit	Plus.	After	a	successful	connection	the	lens	data
events	have	been	connected	to	the	clips:
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Fig.2:	The	lens	data	import	wizard

Be	aware	that	only	clips	that	do	not	hold	lens	correction	data	will	be	displayed	in	the	import	wizard.	Learn	how
to	remove	lens	correction	data	in	the	sections	below.

4.	 Options:
Lens	data	queried	by	shooting	date:	The	lens	correction	data	saved	in	the	MasterLockit	Plus	will	be
queried	for	a	certain	time	range	around	the	shooting	date	of	the	clips.	You	can	set	a	wider	time	frame	for
the	query	with	this	dropdown.	By	setting	the	time	and	date	of	the	camera	correctly	you	can	initially	make
sure	that	the	shooting	date	and	time	of	the	clips	matches	the	timestamp	of	the	lens	correction	data.
Import	Options

Overwrite	“Lens”	information	of	clip:	The	lens	info	coming	from	the	MasterLockit	Plus	can
be	taken	over	to	the	“Lens”	metadata	field	in	Silverstack.
Sensor	width:	The	sensor	width	is	required	to	be	able	to	display	the	lens	corrections.	Silverstack
can	determine	(look	up)	the	sensor	width	based	on	the	following	metadata	of	the	clips	(displayed	as
columns	in	the	clips	table):

Camera	manufacturer
Camera	model
Sensor	model
Format	description	(only	in	cases	where	the	above	does	not	provide	a	unique	sensor	width)
Resolution

There	are	cases	when	an	automatic	detection	is	not	possible 	(most	probable	caused
by	the	lack	of	metadata	of	the	clips).	In	this	case	you	have	to	specify	the	sensor	width
manually	to	be	applied	to	all	clips	where	an	automatic	determination	was	not	possible.
You	can	change	the	sensor	width	later	in	the	General	Info	(right	sidebar)	under	“ZEISS	Lens
Correction”	(see	details	below).

5.	 To	take	over	the	lens	correction	data	to	the	clips	click	the	 “Apply	Lens	Data”	button.

Display	and	Review	Shading	and	Distortion	Correction

The	clips	now	hold	lens	correction	data.	The	“ZEISS	Lens	Correction”	entry	in	the	General	Info	shows	the
enabled	correction	data:
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Fig.	3:	ZEISS	Lens	Correction	entry	in	the	General	Info

Click	the	pen	icon	to	open	the	ZEISS	lens	correction	popover:

Fig.4:	The	ZEISS	Lens	Correction	Popover	in	the	General	Info

The	ZEISS	Lens	Correction	Popover	in	the	General	info	allows	for
two	different	“Actions”:

removal	of	lens	data	(for	single	and	multiple	clips)
import	of	ZLCF	file	(only	if	no	lens	correction	data	is	available	for	the	clip)

multi	edit	of	shading	and	distortion	correction	activation
multi	edit	of	sensor	width

The	ZEISS	lens	correction	panel	can	be	opened	from	the	“Look”	section	of	the	main	menu:

Fig.5:	Open	the	ZEISS	lens	correction	panel
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Fig.	6:	The	ZEISS	lens	correction	panel

The	ZEISS	Lens	Correction	panel	allows	for
separate	activation	and	deactivation	of	shading	and	distortion	correction	for	display	in	player
entry	of	distortion	zoom	factor
dynamic	lens	data	review	per	clip

The	lens	correction	data	will	be	displayed	in	the	Silverstack	player:

To	export	the	status	of	the	lens	correction	data	into	a	clips	report	please	activate	the 	“ZEISS	Lens	Correction”
column	in	the	table	view:

Fig.	8:	The	ZEISS	lens	correction	column	in	the	clips	table	view

Export	ZEISS	Lens	Correction	Files
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The	acquired	lens	correction	data	can	now	be	exported	per	clip	for	consecutive	productions	steps.	To	open	the
export	wizard	go	to	the	“Export”	button	menu	in	the	toolbar	and	select	the	“ZEISS	Lens	Correction	Files
(ZLCF)”	entry	from	the	list:

Fig.	9:	Open	the	ZLCF	export	wizard

This	opens	the	ZLCF	export	wizard:

Fig.	10:	The	ZLCF	export	wizard

Please	be	aware	that	the	wizard	only	shows	clips	that	hold	lens	correction	data.	All	others	will	not	be	shown	and	are
reflected	in	the	status	line	at	the	bottom.

Per	clip	one	.zlcf	(ZEISS	lens	correction	file)	will	be	exported.	After	clicking 	“Export…”	the	wizard	points	you	to
select	a	folder	for	the	zlcf	files	to	be	placed.
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Camera	Formats

Generic	file	formats

Offloading	all	kinds	of	assets	is	possible	with	Silverstack’s	proven	copy	features,	which	offer	secured	backups	with
checksum	verification.	The	Offload	wizard	scans	the	source	folder	and	automatically	selects	the	«Generic	Copy»
mode	when	non-supported	files	are	detected.	Not	all	media	files	are	recognized	as	playable	Clips	by	Silverstack,
besides	the	supported	advanced	media	formats	that	can	be	found	in	the	article	Assets	in	Silverstack.

Offloading	wizard

You	will	get	a	yellow	notification	reading	«Ingesting	NO	clips»	in	the	offload	wizard	in	case	Silverstack	didn’t
recognize	the	scanned	files	as	a	supported	advanced	camera	format.	However,	you	can	go	ahead	and	proceed	to
offload	and	check	sum	the	files.	Once	the	process	is	finished,	the	files	will	be	registered	in	the	Library,	where	you	can
continue	to	work	with	them.	Just	make	sure	to	enable	«Show	Clips	and	Documents»	in	the	View	menu:
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View	menu

ARRI	ALEXA	and	AMIRA	Looks	in	Silverstack

Silverstack	can	playback	and	transcode	ProRes	clips	recorded	with	ARRI	ALEXA	and	AMIRA	cameras	with	the
looks	applied	on	set.	This	feature	lets	DITs	check	the	Log-C	footage	in	real	time	with	the	final	look	and	feel	without
the	need	of	transcoding.

figure	1:	AMIRA	look	application	on	and	off

In	order	to	use	this	functionality,	ALEXA	Looks	and	AMIRA	Looks	have	to	be	applied	in	the	camera	before
recording.	Then	the	camera	will	write	color	metadata	into	the	QuickTime	ProRes	clips.	Once	the	clips	have	been
added	to	the	library,	Silverstack	will	read	this	metadata	from	the	file	and	apply	the	color	changes	along	with	the
standard	Rec.709	conversion	by	default.	After	the	clips	have	been	checked	for	quality,	Silverstack	will	let	you
transcode	them	to	a	lighter	codec	with	the	same	look	applied.

This	feature	is	active	by	default,	but	it	can	be	disabled	through	Silverstack’s	Preferences	menu,	by	setting	the	«Look
Sorce»	to	None:
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figure	2:	visual	controls	preferences	menu

Even	if	the	look	application	is	disabled,	the	footage	can	be	displayed	with	the	standard	Log-C	to	Rec.709	conversion
if	you	select	«Preset»	and	choose	one	of	the	Alexa	or	Amira	LUTs.
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Troubleshooting

Application	Preferences

Many	general	settings	for	Silverstack	can	be	changed	within	the	Application	preferences	and	by	doing	so,	working
with	Silverstack	may	become	even	easier	to	fit	your	workflow.

You	get	to	the	preferences	menu	by	selecting	“Preferences…”	in	the	“Silverstack	”	menu.	The	window	that	opens	up
contains	following	sections	which	will	be	described	detailed	in	this	article:

General
Thumbnails
Copy
Playback
Format	Options
Ingest
Backups
External	Video
Grading

figure	1:	Silvertack’s	preferences

General

figure	2:	General	preferences

You	can	also	customize	the	color	label	naming.
You	can	make	decisions	about	appearance	topics
You	can	choose	how	often	Silverstack	should	check	for	software	updates.

Thumbnails

In	the	“Thumbnails”	section	you	can	choose	the	position	in	the	clip	from	which	the	thumbnails	are	taken.	In
addition,	you	can	disable	the	thumbnail	creation	on	Offload	jobs	to	speed	up	the	process	and	create	them
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afterwards	from	the	«Edit»	menu.	Still	frame	export	options	are	also	available	from	this	panel.

figure	3:	Thumbnail	preferences

It’s	also	possible	to	export	still	frames	from	clips	either	with	the	Original	Color,	as	shown	in	player	or	the	two	images
at	once.	The	process	is	described	in	the	article	Still	image	export.

Copy

Here	you	can	define	all	the	settings	related	to	the	copy	process.

figure	4:	Copy	preferences

Playback

Here	you	can	edit	some	settings	for	playback	Besides	setting	the	color	in	which	black-	and	white-clipping	regions	of
a	video	image	are	indicated,	you	can	also	set	the	range	color	and	clipping	and	range	unit.

In	addition,	it’s	possible	to	disable	the	automatic	application	of	ALEXA	and	AMIRA	Looks	used	while	recording.
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This	way	the	footage	will	be	displayed	with	the	default	Log-C	to	Rec.709	instead	of	the	look.

In	the	“Playback”	tab	you	can	also	select	on	which	display	the	Playback	Mode	will	be	shown	if	you	have	more	than
one	screen	connected	to	your	computer.

figure	5:	Playback	preferences

Format	Options

Within	this	section	you	can	change	settings	regarding	different	cameras	you	may	use	for	importing	video	clips.	You
can	set	those	attributes	for	following	cameras/recorders:	AJA	KiPro	and	Atomos,	ARRI	Alexa,	Sony	F5/F55/F65
XAVC,	Canon	C300,	GoPro	Hero	and	Nikon,	R3D	and	Canon	DSLR.

The	options	that	are	available	for	defining	the	timecode	are	mostly	the	same	for	the	different	cameras.	They	are
useful	if	you	need	a	different	timecode	source	than	the	one	you	got	from	your	camera.	So	instead	of	the	camera’s
timecode	track	you	can	use	the	Quicktime	header	create	date	or	file	create	date.	Most	times	this	option	is	only
necessary	for	the	Canon	DSLR	and	GoPRO	Hero,	not	so	much	for	the	ARRI	Alexa	and	AJA	KiPro.

AJA	KiPro	and	Atomos

You	can	set	the	Look	source	which	will	be	preselected	for	the	ingested	material.	Learn	more	about	this	feature
in	the	article	Basic	Color	Control	in	Silverstack.
Furthermore	you	can	let	Silverstack	extract	informations	about	scene	and	take	from	the	filenames	by	selecting
the	according	checkbox.
For	the	AJA	KiPro	Silverstack	provides	the	opportunity	to	use	the	Alpha	Append	character	of	a	clips	name	to
assign	the	clip	accordingly	to	a	camera.

figure	6:	format	options	for	AJA	KiPro

ARRI	Alexa

202

Silverstack	6	Manual	
Troubleshooting

http://kb.pomfort.com/silverstack/qualitycheck/basic-color-control-in-silverstack/


You	can	set	the	Look	source	which	will	be	preselected	for	the	ingested	material.	Learn	more	about	this	feature
in	the	article	Basic	Color	Control	in	Silverstack.
Silverstack	provides	the	option	to	generate	the	timecode	with	different	modes.

figure	7:	format	options	for	ARRI	Alexa

Canon	c300

You	can	set	the	Look	source	which	will	be	preselected	for	the	ingested	material.	Learn	more	about	this	feature
in	the	article	Basic	Color	Control	in	Silverstack.

figure	8:	format	options	for	Canon	C300

Canon	DSLR

You	can	set	the	Look	source	which	will	be	preselected	for	the	ingested	material.	Learn	more	about	this	feature
in	the	article	Basic	Color	Control	in	Silverstack.
The	source	timecode	can	be	defined	by	the	Thumbnail	Image	file,	the	Quicktime	header	create	date	and	the	file
create	date.
By	selecting	the	according	checkbox	Silverstack	will	also	copy	any	THM	sidecar	files	from	your	Canon	camera.

figure	9:	format	options	for	Canon	DSLR

GoPro	Hero	and	Nikon

For	any	GoPro	Hero	and	Nikon	camera	you	can	set	only	the	option	which	defines	the	source	timecode
either	to	Quicktime	header	create	date	or	file	create	date.
You	can	set	the	Look	source	which	will	be	preselected	for	the	ingested	material.	Learn	more	about	this
feature	in	the	article	Basic	Color	Control	in	Silverstack.
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figure	10:	format	options	for	GoPro	Hero

R3D

You	can	set	the	Look	source	which	will	be	preselected	for	the	ingested	material.	Learn	more	about	this	feature
in	the	article	Basic	Color	Control	in	Silverstack.
The	source	timecode	can	be	defined	as	absolute	timecode,	edge	timecode,	file	create	date	or	by	user
preference.
Reel	name	generation	mode.
Use	a	Red	Rocket	card	if	available.

figure	11:	format	preferences	for	R3D	clips

RED	Reel	Name	options

F5/F55/F65	XAVC	

You	can	set	the	Look	source	which	will	be	preselected	for	the	ingested	material.	Learn	more	about	this	feature
in	the	article	Basic	Color	Control	in	Silverstack.

figure	12:	format	preferences	for	Sony	F5/F55/F65	XAVC	clips

Generic	File	Sequence

Silverstack	allows	to	import	JPEG,	TIFF	and	DPX	image	sequences	as	clips.	You	can	Set	the	default	playback
speed	in	the	Import	Options	menu:
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figure	12.1:	Generic	File	Sequence	preferences

Ingest

Silverstack	scans	the	volumes	from	which	you	want	to	offload.	In	this	tab	you	can	select	what	kind	of	files	or
patterns	should	be	ignored	in	the	ingest	process.	You	can	add	or	delete	different	file	types	and	patterns.

figure	13:	ingest	preferences

Backups

Here	you	can	create	and	restore	database	backups	of	your	current	and	past	Silverstack	states.
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figure	14:	library	backups	preferences

External	Video

Here	you	can	choose	the	settings	for	the	external	video	output.

figure	15:	external	video	out	preferences

Silverstack	comes	with	the	option	to	output	an	HD-SDI	signal	via	compliant	hardware.	Learn	more	about	it	in	the
article	HD-SDI	output	in	Silverstack.

You	can	use	ScopeBox	by	Divergent	Media	for	software-based	waveform	and	 video	scopes	for	Silverstack’s	player.

Grading

These	are	the	settings	for	the	grading	functionalities	in	Silverstack.
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figure	16:	grading	preferences

Silverstack	comes	with	grading	functionalities	and	an	integrated	look	library.	Learn	more	about	it	from	the	articles
Grading	Controls	in	Silverstack	and		The	Silverstack	Look	Library.

ACES

These	are	the	settings	for	the	ACES	grading	mode	functionalities	in	Silverstack:

figure	17:	ACES	grading	mode	preferences

Operating	Systems	and	Requirements

Our	software	Silverstack	requires	an	Apple	Mac	machine	with	macOS	10.12	or	higher	operating	system.	Since	we	are
using	the	latest	of	macOS	technologies,	we	are	not	planning	to	support	earlier	versions	of	macOS,	neither	will	we
port	Silverstack	to	another	operating	system	in	the	near	future.

So	to	run	Silverstack	you	need	an	Intel	Mac	with	macOS	10.12	or	higher	(such	as	any	current	Mac	available	in	the
MacStore).

macOS	10.12	or	higher

You	can	find	a	list	of	supported	formats	in	the	article	 Assets	in	Silverstack.	All	formats	with	no	specific	detection
will	be	handled	as	generic	files.	Please	see	the	article	Generic	File	Formats	for	more	information.
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For	a	realtime	playback	of	your	offloaded	video	files	the	usage	of	a	fast	hard	drive	as	a	SSD	card	is	recommended.

If	you	have	further	question	about	supported	hardware	please	let	us	know.	If	you	would	like	to	know	more	about
data	performance	click	here.	You	might	be	interested	in	this	article	for	improving	your	performance.

Reset	Silverstack's	Library	and	Preferences

In	the	unusual	event	of	Silverstack	not	being	able	to	launch,	you	will	have	to	reset	the	preferences	and	delete
Silverstack’s	library.

Warning:	This	can’t	be	undone,	deleting	the	library	will	delete	all	custom	metadata,	clip	references
and	thumbnails.	The	actual	clips	won’t	be	deleted.

Deleting	Silverstack’s	library

To	do	so,	close	Silverstack	and	delete	the	folder	matching	your	Silverstack	version	in	your	home	directory:

Quit	Silverstack
Rename	the	according	folder	in	your	home	directory:

For	Silverstack	6: ~/Library/Application Support/Pomfort/Silverstack6
For	Silverstack	Lab	6: ~/Library/Application Support/Pomfort/SilverstackLab6
For	Silverstack	5: ~/Library/Application Support/Pomfort/Silverstack5
For	Silverstack	4: ~/Library/Application Support/Pomfort/Silverstack4

The	Library	folder	is	hidden	by	default.	You	can	open	the	Library	folder	in	Finder	when	opening	the	“Go”	menu
and	holding	the	“alt”	key.	You	will	see	an	extra	entry	“Library”	in	the	“Go”	menu.	Choose	this	entry	and	a	Finder
window	will	open	with	the	Library	folder.

Start	Silverstack	again,	it	will	automatically	create	a	new	library.

Deleting	Silverstack’s	preferences

Quit	Silverstack
Create	a	copy/backup	of	the	following	file	matching	your	Silverstack	version	(optional):

For	Silverstack	6: ~/Library/Preferences/com.pomfort.Silverstack6.plist

For	Silverstack	Lab	6: ~/Library/Preferences/com.pomfort.SilverstackLab6.plist

For	Silverstack	5: ~/Library/Preferences/com.pomfort.Silverstack5.plist

For	Silverstack	4: ~/Library/Preferences/com.pomfort.Silverstack4.plist

Open	up	the	Terminal	application	(type	terminal	in	your	spotlight	or	navigate	within	the	Utilities	folder	of	your
application	folder)

Type	the	following	command	in	your	terminal	window	matching	your	Silverstack	version:

For	Silverstack	6: defaults delete com.pomfort.Silverstack6

For	Silverstack	Lab	6: defaults delete com.pomfort.SilverstackLab6

For	Silverstack	5: defaults delete com.pomfort.Silverstack5

For	Silverstack	4: defaults delete com.pomfort.Silverstack4

Start	Silverstack

Now	Silverstack	should	start	as	usual	with	a	fresh	library.	If	you	still	experience	issues,	please	contact	our	 support
team.

The	previous	instructions	are	for	Silverstack	6,	Silverstack	Lab	6,	5	and	4.	If	you	are	using	Silverstack	3,	please
read	the	article	Silverstack	3:	Reset	Library	and	Preferences.

How	do	I	migrate	a	license	from	one	computer	to	another?
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You	can	move	a	license	of	a	Pomfort	product	from	one	computer	to	another.	This	may	be	useful	if	you	move	from	an
older	Mac	to	a	new	model.

There	are	two	activities	involved:

Unregistering	the	license	from	the	old	computer	and
registering	the	license	on	the	new	computer.

Please	note,	that	you	need	an	internet	connection	for	the	following	steps.

1.	Unregistering	the	license	from	the	old	computer

You	now	have	to	perform	the	following	steps:

Open	the	License	Panel	by	choosing	“Licenses…”	from	the	application	menu.
Click	on	”Deactivate	License”.

The	Pomfort	application	will	stop	working	on	this	machine	and	the	license	is	free	to	use	on	another	machine.

By	logging	into	your	Pomfort	Account	you	can	make	sure	that	the	deactivation	of	your	license	was	successful.	The
license	should	now	be	shown	as	“Inactive”.

2.	Registering	the	license	on	the	new	computer

Let’s	assume	you	already	have	the	application	installed	on	your	new	computer.

You	now	have	to	perform	the	following	steps:

Open	the	program,	the	License	Panel	will	appear.	If	not,	choose	“Licenses…”	from	the	application	menu.
Click	on	“Add	License…”	and	insert	the	license	key	you	received	after	purchase.

In	your	Pomfort	Account	your	license	will	now	be	shown	as	“Activated”	with	the	name	of	the	computer	that	your
license	is	activated	on.

Migrate	a	Silverstack	project	from	one	computer	to	another

Sometimes	it’s	necessary	to	migrate	an	entire	project	from	one	computer	to	another	–	maybe	even	during	a
project.	It’s	not	that	difficult	–	this	article	shows	how	this	can	be	accomplished.

There	are	two	activities	involved:

Migrating	the	license
Migrating	the	Library

Migrating	the	License

Migrating	the	license	is	straight	forward,	it	can	be	done	in	Silverstack	.	You	need	an	internet	connection	and	follow
the	steps	described	in	the	Tips	&	Tricks	document	“Migrate	a	Silverstack	license“.

Migrating	the	Library

Migrating	the	project	with	all	it’s	information	is	basically	moving	the	Library’s	database,	the	thumbnails	and	the
application’s	preferences	to	the	new	computer.

If	you	want	to	migrate	your	Silverstack	5	projects	to	Silverstack	6	please	learn	how	to	do	that	from	the	article	“How
to	Manually	Migrate	Silverstack	5	Projects	to	Silverstack	6	or	Silverstack	Lab	6”

If	you	want	to	migrate	your	Silverstack	4	projects	to	Silverstack	5	please	learn	how	to	do	that	from	the	article	“How
to	Manually	Migrate	Silverstack	4	Projects	to	Silverstack	5”

In	order	to	transfer	files	from	one	computer	to	another	please	have	an	external	hard	drive	or	a	large	USB	stick	at
hand	or	establish	a	network	connection	with	file	sharing	between	the	two	computers.

Silverstack	6

If	you	are	using	Silverstack	6,	you	have	to	perform	the	following	steps	to	migrate	all	thumbnails	and	the
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Library	database:

In	Finder	on	your	old	computer	navigate	to	~/Library/Application Support/Pomfort	in	your	home	directory.
Copy	the	folder	Silverstack6	and	all	of	its	contents	to	the	same	destination	on	the	new	computer.

You	have	to	perform	the	following	steps	to	migrate	the	application’s	preferences	files:

In	Finder	on	your	old	computer	navigate	to	~/Library/Preferences	in	your	home	directory.
Copy	the	file	com.pomfort.Silverstack6.plist	to	the	same	destination	on	the	new	computer.

If	you	are	using	Silverstack	Lab	6,	you	have	to	perform	the	following	steps	to	migrate	all	thumbnails	and	the
Library	database:

In	Finder	on	your	old	computer	navigate	to	~/Library/Application Support/Pomfort	in	your	home	directory.
Copy	the	folder	SilverstackLab6	and	all	of	its	contents	to	the	same	destination	on	the	new	computer.

You	have	to	perform	the	following	steps	to	migrate	the	application’s	preferences	files:

In	Finder	on	your	old	computer	navigate	to	~/Library/Preferences	in	your	home	directory.
Copy	the	file	com.pomfort.SilverstackLab6.plist	to	the	same	destination	on	the	new	computer.

NOTE:	Since	OS	X	Lion	the	Library	folder	in	your	home	directory	is	hidden.	In	Finder	use	Command-Shift-G
(⌘⇧G)	and	enter	~/Library	to	open	the	folder.

You	can	also	use	the	Library	Metadata	Exchange	feature	present	in	Silverstack	6	XT.

Silverstack	5

If	you	are	using	Silverstack	5,	you	have	to	perform	the	following	steps	to	migrate	all	thumbnails	and	the	Library
database:

In	Finder	on	your	old	computer	navigate	to	~/Library/Application Support/Pomfort	in	your	home	directory.
Copy	the	folder	Silverstack5	and	all	of	its	contents	to	the	same	destination	on	the	new	computer.

You	have	to	perform	the	following	steps	to	migrate	the	application’s	preferences	files:

In	Finder	on	your	old	computer	navigate	to	~/Library/Preferences	in	your	home	directory.
Copy	the	file	com.pomfort.Silverstack5.plist	to	the	same	destination	on	the	new	computer.

NOTE:	Since	OS	X	Lion	the	Library	folder	in	your	home	directory	is	hidden.	In	Finder	use	Command-Shift-G
(⌘⇧G)	and	enter	~/Library	to	open	the	folder.

You	can	also	use	the	Library	Metadata	Exchange	feature	present	in	Silverstack	5	XT.

Silverstack	4

If	you	are	using	Silverstack	4,	you	have	to	perform	the	following	steps	to	migrate	all	thumbnails	and	the
Library	database:

In	Finder	on	your	old	computer	navigate	to	~/Library/Application Support/Pomfort	in	your	home	directory.
Copy	the	folder	Silverstack4	and	all	of	its	contents	to	the	same	destination	on	the	new	computer.

You	have	to	perform	the	following	steps	to	migrate	the	application’s	preferences	files:

In	Finder	on	your	old	computer	navigate	to	~/Library/Preferences	in	your	home	directory.
Copy	the	file	com.pomfort.Silverstack4.plist	to	the	same	destination	on	the	new	computer.

NOTE:	Since	OS	X	Lion	the	Library	folder	in	your	home	directory	is	hidden.	In	Finder	use	Command-Shift-G
(⌘⇧G)	and	enter	~/Library	to	open	the	folder.

You	can	also	use	the	Library	Metadata	Exchange	feature	present	in	Silverstack	4	XT.

Silverstack	3

If	you	are	using	Silverstack	3,	you	have	to	perform	the	following	steps	to	migrate	all	thumbnails	and	the	Library
database:

In	Finder	on	your	old	computer	navigate	to	~/Library/Application Support/Pomfort	in	your	home	directory.
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Copy	the	folder	Silverstack3	and	all	of	its	contents	to	the	same	destination	on	the	new	computer.

You	have	to	perform	the	following	steps	to	migrate	the	application’s	preferences	files:

In	Finder	on	your	old	computer	navigate	to	~/Library/Preferences	in	your	home	directory.
Copy	the	file	com.pomfort.Silverstack3.plist	to	the	same	destination	on	the	new	computer.

NOTE:	Since	OS	X	Lion	the	Library	folder	in	your	home	directory	is	hidden.	In	Finder	use	Command-Shift-G
(⌘⇧G)	and	enter	~/Library	to	open	the	folder.

Silverstack	2

If	you	are	using	Silverstack	2.2,	you	have	to	perform	the	following	steps	to	migrate	all	thumbnails	and	the
Library	database:

In	Finder	on	your	old	computer	navigate	to	~/Library/Application Support/Pomfort	in	your	home	directory.
Copy	the	folder	SilverstackMaster	and	all	of	its	contents	to	the	same	destination	on	the	new	computer.

You	have	to	perform	the	following	steps	to	migrate	the	application’s	preferences	files:

In	Finder	on	your	old	computer	navigate	to	~/Library/Preferences	in	your	home	directory.
Copy	the	file	com.pomfort.SilverstackMaster.plist	to	the	same	destination	on	the	new	computer.

NOTE:	Since	OS	X	Lion	the	Library	folder	in	your	home	directory	is	hidden.	In	Finder	use	Command-Shift-G
(⌘⇧G)	and	enter	~/Library	to	open	the	folder.

How	to	Manually	Migrate	Silverstack	5	Projects	to	Silverstack	6	or	Silverstack

Lab	6

If	you	are	a	user	of	Silverstack	5	you	might	want	to	migrate	your	projects	to	Silverstack	6	or	Silverstack	Lab	6.	There
is	an	easy	process	to	perform	this	migration.

Locating	the	Library	Folders

Silverstack	6,	Silverstack	Lab	6	and	Silverstack	5,	have	different	library	folders	that	contain	the	projects.	You	will
find	them	at	the	following	paths	on	your	Mac:

	~/Library/Application	Support/Pomfort/Silverstack6
~/Library/Application	Support/Pomfort/SilverstackLab6
~/Library/Application	Support/Pomfort/Silverstack5

You	can	also	navigate	to	the	folders	from	the	Main	Menu	of	Silverstack	5	or	6	or	Lab	6.	Select	 “Silverstack>Show
Library	in	Finder”	in	the	main	menu	bar	at	the	top	of	the	screen.	This	will	open	the	project	folder	an	bring	you	to
the	Silverstack.psdb	file	of	your	currently	opened	project.	From	there	you	can	go	two	directories	backwards	to	find
yourself	at	the	directory	of	the	Silverstack	library	folders.

Migrating	the	Library

1.	 Close	Silverstack	6	/	Silverstack	Lab	6
2.	 Rename	the	“Silverstack6”	or	“SilverstackLab6”	folder	in	the	directory
	/Users/[yourUser]/Library/Application	Support/Pomfort/	to
“Silverstack6_old”/“SilverstackLab6_old”	(you	will	need	that	folder	to	keep	new	projects)

3.	 Open	Silverstack	6	/	Silverstack	Lab	6
4.	 Just	like	when	you	startedSilverstack	6	/	Silverstack	Lab	6	from	scratch	the	first	time	you	will	be	asked	if	you

want	to	migrate	your	libraries	from	version	5	or	want	to	start	clean:
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5.	Choose	“Copy	Existing	Projects”	to	migrate	your	Silverstack	5	libraries.

6.	The	library	migration	assistant	will	keep	you	updated	on	the	process	and	tell	you	when	the	migration	has
finished:

Figure	2:	The	library	migration	assistant

7.	You	can	now	use	Silverstack	6	/	Silverstack	Lab	6	with	your	projects	from	Silverstack	5.

Please	note	that	for	large	libraries	the	process	can	take	several	minutes.	During	that	time	Silverstack	will	become
unresponsive.	Leave	the	system	running	and	the	migration	process	will	come	to	a	solid	finish.

Keeping	Projects	from	Before	the	Migration

If	you	want	to	keep	projects	you	created	in	Silverstack	5	before	the	migration	process	you	can	do	that	by	copying	the
project	folders:

1.	 Close	Silverstack.
2.	 Go	to	the	previously	renamed	“Silverstack6_old”/“SilverstackLab6_old”	folder.
3.	 Select	the	projects	you	want	to	take	over	to	your	migrated	Silverstack	6	/	Silverstack	Lab	6	library	(projects

folder	usually	are	named	like	“Project-1F342864AF90”)
4.	 Copy	them	to	the	Silverstack6	/	SilverstackLab6	folder	that	was	automatically	created	during	the	migration.
5.	 Start	Silverstack	6	/	Silverstack	Lab	6

You	will	then	have	all	your	migrated	and	the	previously	created	projects	in	Silverstack	5	together	at	one	place.

If	you	want	you	can	then	delete	the“Silverstack6_old”/“SilverstackLab6_old”	folder	because	now	your
current	Silverstack	6	/	Silverstack	Lab	6	library	contains	all	your	projects	from	Silverstack	5	and	6	respectively
Silverstack	Lab	6.

Incompatible	Silverstack	or	Silverstack	Lab	Library	Version

The	Silverstack	and	Silverstack	Lab	library	versions	advance	over	time	across	software	releases.	This	is	a	natural
process	when	a	software	application	advances	but	inevitably	leads	to	incompatible	library	version	when	opening
projects	with	outdated	versions	of	Silverstack/Silverstack	Lab.
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We	always	recommend	to	use	the	latest	version	of	Silverstack/Silverstack	Lab	which	can	be	downloaded	on	the
Pomfort	Downloads	page.	Like	this	you	avoid	the	situation	this	article	takes	care	of.

Migration	and	Library	Version	States

The	term	“Library	Version”	basically	refers	to	the	state	of	the	Silverstack	database	and	which	information	it	can
currently	store.

When	updating	Silverstack	to	a	newer	version	the	existing	library	is	migrated	to	the	latest	version.	That	process
establishes	compatibility	of	the	existing	library	with	the	new	library	version.
You	can	learn	more	about	the	migration	of	libraries	in	the	article	“How	to	manually	migrate	Silverstack	5	projects	to
Silverstack	6	or	Silverstack	Lab	6”

After	the	migration	your	library	is	in	a	later/newer	state	and	therefore	not	compatible	anymore	with	older	versions
of	Silverstack.	If	you	are	forced	by	any	circumstance	to	move	back	to	an	outdated	library	version	of	Silverstack,	you
can	restore	a	backup	that	has	automatically	been	created	during	the	migration	process.

Restoring	a	Library	Backup

Fig.	1:	The	“Incompatibly	Silverstack	Lab	Library	Version”	Alert,	applies	also	to	Silverstack

When	you	open	a	project	that	has	been	created	with	a	later	version	of	Silverstack	in	an	older	version	the	alert	from
Fig.	1	shows.

At	this	point	you	have	three	options	that	you	can	choose	from	with	the	buttons:

Restore	Backup:	Silverstack	automatically	offers	the	possibility	to	restore	the	last	state	for	which	a	backup
was	created	that	is	compatible	with	the	opened	version	of	Silverstack.	Backups	are	automatically	created
during	migration.	Automatic	backups	can	be	enabled	in	the	Silverstack	preferences’	“Backups”	tab	as	well	as
manually	triggered.
Open	with	New	Project:	To	be	able	to	access	Silverstack	even	though	the	particular	project	can’t	be	opened,
you	can	create	a	new	project	to	start	with.	You	can	again	change	to	other	projects	from	within	the	application
then.
Quit:	You	can	quit	the	application	to	open	the	project	again	with	a	later	version	of	Silverstack	that	is
compatible	with	the	library	version.

In	the	very	rare	case	that	no	backup	is	available	you	see	the	following	alert	that	indicates	that	there	is	no	compatible
backup	and	therefore	gives	less	options:
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Fig.2:	The	alert	in	case	there	is	no	available	backup	that	can	be	restored

Why	does	Silverstack	tell	me	my	license	is	already	activated?

Each	Silverstack	license	key	can	be	activated	on	one	computer	at	a	time.	If	an	error	message	appears	when	you	try	to
activate	your	license	on	a	new	computer	please	check	if	the	license	has	been	properly	deactivated	from	the	original
computer.

You	can	do	this	check	by	logging	into	your	Pomfort	Account.	The	license	status	needs	to	be	shown	as	“Inactive”	for
you	to	activate	the	license	on	another	computer.	If	this	is	not	the	case,	please	deactivate	your	license	from	the
computer	that	it’s	shown	as	“in	use	on”.

Find	more	information	about	the	Pomfort	Account	here.

How	do	I	install	a	license	for	all	users	of	a	Mac?

You	can	register	Silverstack	and	LiveGrade	Pro	once	on	one	machine	and	afterwards	make	the	license	available	to
all	users.

After	the	activation	just	move	the	files	in	“~/Library/Application	Support/Pomfort/Licenses”	to
“/Library/Application	Support/Pomfort/Licenses”	(You	will	have	to	create	the	folders	Pomfort/Licenses).

Please	Note:	Since	OS	X	Lion	the	Library	folder	in	your	home	directory	is	hidden.	In	Finder	use	Command-Shift-
G	(⌘⇧G)	and	enter	~/Library	to	open	the	folder.

When	restarting	the	application	it	will	load	the	licenses	from	the	system	disk	and	every	user	should	be	able	to	use	it.
With	that	solution	multiple	users	of	this	machine	can	use	the	Pomfort	product	license.
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